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ABSTRACT 

SOURCES AND PATHWAYS FOR MERCURY TO MICHIGAN’S INLAND LAKES 

By 

Matthew James Parsons 

Mercury has a unique geochemical cycle due to its ability to exist as a gas at Earth 

surface conditions.  As a result Hg can be transported across a region (e.g., the Midwest) or 

across the globe.  The importance of local watershed scale versus regional/global sources is still 

debated.  The over-arching hypothesis driving this research is that local scale sources and 

watershed scale processes have more impacts on the rate of Hg accumulation in the aquatic 

environment than regional to global scale sources.  To evaluate this hypothesis, 
210

Pb dated 

mercury sediment chronologies were compared among inland lakes within the State of Michigan 

and  investigated using the following approaches: 1) examine the spatial and temporal trends of 

Hg loading to the environment to discriminate regional and local scale processes, 2) use modern 

rates of recovery to identify those watershed attributes that influence the transport of Hg through 

the watershed and 3) use diagnostic ratios of polycyclic aromatic hydrocarbons (PAHs) to infer 

sources of Hg contamination. 

Results of temporal and spatial analysis show that 1) mercury accumulation rates for 

many lakes are still increasing; 2) focusing corrected anthropogenic Hg inventories are similar to 

those determined from Great Lakes sediments suggesting a regional source and 3) anthropogenic 

accumulation rate profiles are similar by sub-region and share episodic accumulation events 

indicative of local scale sources.  



 

 

Contemporary recovery rates were calculated for mercury based on concentration and 

accumulation rate profiles.  These recovery rates were then compared to watershed attributes.  

Agricultural, forested and wetland attributes were all found to be significantly correlated.  

However, those cover types found along highly dynamic watershed flowpaths were found to be 

most significant.   

Mercury and PAHs can share common sources and pathways resulting in similar 

environmental fates.  Diagnostic ratios of PAHs are often used to differentiate source of these 

contaminants to the environment and may be useful to identify sources for Hg.  Ratios of PAHs 

indicate that a variety of sources exist including biomass (e.g., grass or coal) and petroleum (e.g., 

vehicle or natural gas) combustion.  Sources are unique on regional to sub-regional scales with 

biomass combustion a dominant source for lakes in the southeastern portion of the Lower 

Peninsula. 

Deer Lake, an US EPA Area of Concern, in Michigan’s Upper Peninsula was 

contaminated with Hg as a result of a mining related laboratory activities.  Sediment cores 

collected from the lake revealed that the natural recovery remediation strategy employed was 

resulting in deposition of “clean” sediments and Hg concentrations should reflect those of nearby 

lakes in ca. 10y.  Most recently a terrestrial pathway for Hg was identified using Al:Hg ratios 

which could hamper the process of delisting Deer Lake as an Area of Concern. 

The results of this research support the hypothesis that local scale processes are more 

significant than regional to global sources for Hg to Michigan’s lakes.  This has important 

implications for the development of new environmental legislation limiting Hg output from coal-

fired power plants and other energy generating facilities.
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CHAPTER 1 

INTRODUCTION 

 

 

Mercury contamination and its subsequent methylation and bioaccumulation in aquatic 

food-webs has resulted in elevated levels of mercury in fish and resulted in statewide fish 

consumption advisories for the Great Lakes region, including inland lakes throughout the state of 

Michigan (Keeler et al., 1994, Watras et al., 1994).  Fish consumption has been shown to be a 

primary pathway of mercury, and its more toxic form methylmercury, exposure to humans 

(Hightower and Moore, 2003).  Toxicity issues related to methylmercury contaminated fish 

consumption was highlighted in the 1950’s and 1960’s with deaths in Minamata Bay and 

Niigata, Japan (Tsubaki and Irukayama, 1977).  Although reported emissions of mercury have 

declined in the past decade (Engstrom and Swain, 1997, USEPA, 2008), the amount of river 

miles and lake acreage under fish consumption advisories have continued to increase (US EPA, 

2004).  The cause of which is two-fold:1) due to its geochemical cycle mercury can be 

transported long distances creating a contaminated water body in an otherwise pristine setting 

(Tseng et al., 2004), and 2) waterbodies that were previously untested are being confirmed to 

contain fish that have Hg levels above regulatory limits (US EPA, 2004).     

Mercury is ubiquitous in the environment, and is characterized by an atmospheric 

residence time of one year (Fitzgerald, 1989).  As a result, Arctic region lakes (Hermanson, 

1998) and Antarctic ice cores (Vandal et al., 1993) are contaminated with mercury though they 

are far from anthropogenic sources.  Anthropogenic sources of mercury to the environment 

include coal fired utilities, smelting activities, medical and municipal waste incineration, 

agricultural and paint fungicides, gold and silver mining activities, chlor-alkali facilities, and 

municipal waste streams (Jasinski, 1994).  Many industrial applications for mercury have been 
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disallowed (e.g., agricultural fungicides) in the United States and substitutes are encouraged to 

be used (e.g., alcohol in thermometers) consequently consumption has decreased over the last 

three decades (Brooks, 2003); but mercury manometers, electronic switches and lamps, batteries, 

and dental amalgams continue to add to U.S. consumption.  Even with consumption declines 

realized, all environmental records do not reflect a concomitant decline in mercury accumulation 

(Engstrom and Swain, 1997, Engstrom et al., 1994, Lorey and Driscoll, 1999, Swain et al., 

1992b).   

It is known that atmospheric deposition is the principle pathway for mercury 

contamination of inland lakes (Fitzgerald, 1989, Fitzgerald et al., 1998, Mason et al., 1994a, 

Watras et al., 2000).  However, the impact of global (e.g., China) versus regional (e.g., Midwest 

power plants) versus more local scale processes (e.g., increased runoff from agricultural fields) is 

still debated (Evers et al., 2011).  Determining the source for Hg to inland lakes has important 

implications for future environmental legislation (US EPA, 2011)which would seek to cap Hg 

emissions from power generating facilities in an attempt to further reduce Hg exposure.  The 

environmental legacy of historic Hg emissions also plays an important role in any future 

legislative action since it is that Hg that now resides in soils that will continue to pose an 

exposure threat even when Hg emissions from all anthropogenic sources are reduced to zero 

(Mason et al., 1994b).  It will be important then to more fully understand the processes that result 

in Hg transport at the watershed scale. 

A variety of approaches have been used to determine current and historical rates of 

contaminant loading to the environment including: atmospheric deposition studies, ombotrophic 

bogs, and lake sediment cores.  Atmospheric deposition pathways have been studied to 

determine rates of mercury deposition (Glass and Sorensen, 1999, Landis and Keeler, 2002, 
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Landis et al., 2002).  Several Midwest states have been included in the National Atmospheric 

Deposition Program (NADP) providing a continuously updated data set for calibration of 

atmospheric cycling and deposition models (Illinois State Water Survey, 2008).  The 

International Association of Deposition Networks (IADN) (Hillery et al., 1998) has been 

collecting similar data for the last decade throughout the Great Lakes Region.  Ombotrophic 

bogs throughout the world have also been used to determine current and historical rates of 

contaminant deposition (Benoit et al., 1998, Bindler, 2003).   

Lake sediment cores have been used to measure contaminant-loadings of atmospheric 

and terrestrial inputs (Callender and Rice, 2000, Engstrom and Swain, 1997, Swain et al., 1992b, 

Yohn et al., 2002b).  Studies of lake sediment cores from the Midwest and Adirondacks have 

shown decreasing mercury accumulation rates attributed to a reduction in atmospheric deposition 

(Engstrom and Swain, 1997, Lorey and Driscoll, 1999, Swain et al., 1992a).  The Great Lakes 

region has been of particular interest in contaminant studies due to several industrialized areas 

within the basin and the revenue dollars it provides to Great Lakes states through recreation, 

tourism, and sport fishing.  Sediment cores collected from Lake Superior had maximum 

concentrations of mercury in the surficial sediments for the majority of the samples collected 

(Rossmann, 1999).  Approximately 70% of the mercury inventory was attributed to 

anthropogenic activity (Rossmann, 1999).   Surficial sediment concentrations from Lake 

Michigan show a decline from historical data sets and estimate contributions from local sources 

to be approximately 50% of total mercury loadings (Rossmann, 2002). 

Most regulatory actions have been intended to reduce loadings of mercury from 

atmospheric sources, such as the burning of fossil fuels and waste incineration facilities that 

create a regional signal which would be expected to consist of a uniform deposition or 
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accumulation rate across a broad spatial scale (Engstrom and Swain, 1997).  However, local 

sources and processes acting on the watershed scale will not display uniform loading over large 

spatial scales.  These sources and processes may become more important over time, as emissions 

from industrial activities are reduced, and therefore it is becoming increasingly important to 

understand local scale influences on mercury loadings to aquatic ecosystems.   

Investigation of sediment cores of inland lakes can aid in determining regional and local 

signals of contaminant loadings.  Previous work investigated the anthropogenic accumulation of 

lead and cadmium using multivariate statistics and metal ratios to determine current and legacy 

land use effects on anthropogenic accumulation rates of metals to inland lakes (Yohn et al., 

2003).  Results showed that regional and local signals can be determined from temporal and 

spatial trends of anthropogenic metals.  And the efficacy of environmental legislation, such as 

the Clean Air Act, on reducing regional signals of anthropogenic accumulation of lead can be 

tested (Yohn, 2003).  For example, it has been demonstrated that the anthropogenic accumulation 

of lead and copper have not declined to background levels, as one would expect if a regional 

source was eliminated (Yohn et al., 2002a).  Therefore a different, possibly local, source may be 

contributing to the continued accumulation of anthropogenic chemicals. 

Various sources can contribute to sediment deposition within lakes including terrestrial, 

atmospheric, and in-lake processes which mix with anthropogenic inputs (Yohn et al., 2001) 

creating difficulty in elucidating source for a metal of interest.  Heyvaert (2000) used titanium 

ratios to normalize mercury concentrations to correct for terrestrial inputs, a watershed correction 

factor.  However, it may be more appropriate to look at background correction for mercury due 

its geochemical cycle (Strunk, 1991).  Using background correction assumes that the majority of 

anthropogenic mercury deposited to the landscape occurs during atmospheric deposition and is 
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retained by soils and does not readily mobilize after deposition except during processes such as 

fire, clear cutting, urbanization, landscape disturbance (i.e., agricultural practices), and flooding. 

Hypothesis and Approach 

This study attempts to elucidate sources and pathways for Hg to inland lakes, and 

importance of local and regional scale sources.  The over-arching hypothesis is that: local and 

watershed scale processes have more impact on the rate of Hg accumulation in the aquatic 

environment than regional to global scale sources.   

 Three approaches will be used to test this hypothesis, and they are: 

1. examine the temporal changes of Hg accumulation over spatial scales.  Local scale 

sources and watershed scale processes would be reflected in the sediment record as 

discontinuities in anthropogenic accumulation rates at multiple time periods and 

spatial scales and inventories across spatial scales, 

2. use modern recovery rates of recovery to identify those watershed attributes that 

influence the movement of Hg through the watershed.  Differences in processes 

amongst watersheds (e.g., agriculture v. forest) impact the rates of modern recovery 

from mercury contamination, and 

3. use diagnostic ratios of polycyclic aromatic hydrocarbons (PAHs) as tracers of Hg 

contamination.  Sources of PAHs can be differentiated using diagnostic ratios and Hg 

and PAHs share common sources and pathways thus PAH ratios can be used to infer 

sources of Hg. 
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Sediment was collected from inland lakes throughout the State of Michigan, dated with 
210

Pb 

and analyzed for metals and organic contaminants to investigate this hypothesis.  Results of 

analysis from individual lakes can be found in several year-end reports (Parsons et al., 2004, 

Parsons et al., 2006, Yohn et al., 2001, Yohn et al., 2002c, Yohn et al., 2003) prepared for the 

Michigan Department of Environmental Quality as part of the Trends Monitoring Program: 

Sediments (Michigan, 2011).  This dissertation is composed of five chapters beyond the 

introduction.  Chapter 2 explores the use of anthropogenic accumulation rates and inventories 

examined at temporal and spatial scales, respectively, focusing on the identification of source 

regions.  Chapter 3 investigates the use of geographic information system derived watershed 

attributes on the rate of recovery of inland lakes from Hg contamination.  The fourth chapter uses 

diagnostic ratios of PAHs to infer sources of Hg; while the fifth, investigates the historic and 

modern sources of Hg to Deer Lake near Ishpeming, MI, a U.S. EPA Area of Concern (USEPA, 

2007)using Hg:metal ratios and changes in metal profiles that are consistent with the known 

history of the lake.  The final chapter offers a summary and suggestions for future work. 
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CHAPTER 2 

SPATIAL AND TEMPORAL TRENDS OF MERCURY LOADINGS TO MICHIGAN 

INLAND LAKES 

 

Abstract 

Several studies of chronologies of mercury (Hg) in inland lake sediments have 

demonstrated that Hg accumulation had decreased in recent decades.  However, episodic 

mercury accumulation events were recorded in some of these lakes, but not investigated 

in detail.  Recent decreases had been attributed to the reduction of regional Hg 

consumption and secondary removal during process waste treatment.  In addition to 

regional sources, local sources, including watershed disturbance, might significantly 

contribute to Hg loading.  Here, mercury chronologies of Hg loadings based on dated 

sediment cores are presented for 26 inland, Michigan lakes.  Although spatial trends of 

anthropogenic inventories suggest a regional pattern dominated by human activities, sub-

regional to local scale sources are also found to be significant.  Temporal trends show 

episodic Hg accumulation events superimposed on a more general, long-term trend.  

Episodic increases common to lakes suggest a common source or processes common to 

lakes.  Episodic increases unique to a lake indicate a more local scale source.  Similar Hg 

profiles from lakes that are geographically proximal provide evidence for sub-regional to 

regional scale sources.  Local sources and pathways for mercury to inland lakes need to 

be more fully understood to effectively reduce Hg loading to the environment. 

Introduction 

Mercury (Hg) concentrations greater than historical levels, as recorded in 

sediment cores, have been observed in the high northern latitudes (Bindler et al., 2001, 

Gobeil et al., 1999, Hermanson, 1998), New England (Kamman and Engstrom, 2002, 
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Lorey and Driscoll, 1999), the Midwestern United States (Engstrom and Swain, 1997, 

Swain et al., 1992), Western United States (Gray et al., 2005, Menounou and Presley, 

2003), and Europe (Wihlborg and Danielsson, 2006, Yang and Rose, 2003).  Although 

regulatory controls have attempted to limit mercury emissions (1997), the number of 

river miles and fresh water lakes in which Hg concentrations exceed regulatory 

guidelines continue to increase.  The reasons for this increase have been attributed to 

monitoring efforts extending to water bodies that were previously untested (2004), or 

increased releases from human activities and subsequent deposition in remote areas 

(Fitzgerald et al., 1998).  Consumption of contaminated fish has been shown to be a 

principle exposure route of methylmercury to humans (Hightower and Moore, 2003, 

1997).  As a result of elevated health risks, several Midwestern states have advised 

consumers to reduce consumption of fish from all of the Great Lakes and all Michigan 

inland lakes due to potential Hg exposure (2004). 

 

Freshwater sediments retain mercury transported to the lake system (Engstrom et 

al., 1994) and when coupled with dating techniques, sediments can record the history of 

mercury loadings over time.  Dated sediment cores have been used to investigate the 

historic accumulation of Hg in sediments of the North American Great Lakes (Long et 

al., 1995) and inland lakes (Engstrom and Swain, 1997, Kamman and Engstrom, 2002, 

Lorey and Driscoll, 1999, Swain et al., 1992).  While analysis of Great Lakes sediment 

provides significant information about deposition of Hg on larger spatial scales, it is 

difficult to determine local watershed scale contribution to Hg loadings.  Investigating 

inland lakes across a region allows examination of both regional- and, local, including 
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watershed scale, contribution to Hg accumulation.  Earlier determinations of sediment 

chronologies have demonstrated that Hg loadings in some areas of the United States 

(USA) such as the Western United States (Gray et al., 2005, Menounou and Presley, 

2003), Midwestern United States (Engstrom and Swain, 1997, Swain et al., 1992), New 

England (Kamman and Engstrom, 2002, Perry et al., 2005), the Adirondack region of 

New York (Lorey and Driscoll, 1999), and Europe (Wihlborg and Danielsson, 2006, 

Yang and Rose, 2003) have decreased in recent years.  However, several of the lakes 

included in previous studies had recent increases in Hg accumulation.   

 

The results reported in this paper are part of a larger study, “Inland Lakes Trends 

Monitoring Program: Sediments,” to determine trends of organic and inorganic 

contaminant accumulation in Michigan’s inland lakes (2006).  Here the chronologies of 

Hg loading into lakes were determined from 26 
210

Pb-dated, confirmed by 
137

Cs and 

stable Pb, sediment cores from inland lakes throughout Michigan.  Anthropogenic 

inventories of Hg loadings to lakes were investigated at several spatial scales, and Hg 

accumulation rates, examined temporally to test the hypothesis that local-scale sources of 

Hg significantly contribute to Hg accumulation in inland lakes.  Understanding local 

scale sources for Hg will become increasingly important in assessing the efficacy of 

control measures for regional sources. 

 

Methods 

During the summers of 1999 through 2004, 26 lake sediment cores were collected 

aboard the U.S. Environmental Protection Agency (EPA) R/V Mudpuppy or Michigan 
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Department of Environmental Quality (MDEQ) M/V Nibi (Figure 2.1).  Lakes were 

selected to cover all regions of the state and varied in their watershed (area) and 

hydrological characteristics, such as whether they were headwater or seepage lakes.  An 

MC-400 Lake/Shelf multi-corer was used to extract four simultaneous cores for 
210

Pb-

dating and analysis of Hg and other metals.  The core was sectioned on shore shortly after 

retrieval at 0.5-1.0 cm intervals for the first 5-8 cm and 1 cm intervals for the remainder 

of the core; core lengths varied from 50-60 cm.  Sectioning of the  
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Figure 2.1. Inland lake trends monitoring program: sediments study lakes, trends of Hg 

loading over the last decade, and coal burning power plants.  An up-arrow indicates 

accumulation rates had increased toward the surface, a down-arrow indicates 

accumulation rates had decreased.  Solid triangles mean that accumulation rates were 

elevated but are not increasing or decreasing.  Solid circles indicate that accumulation 

rates had returned to pre-industrial rates. Open stars represent coal burning power plants 

greater than 25 MW generating capacity as of 2005. 
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cores used for determining Hg concentrations and 
210

Pb was conducted at the same 

stratigraphic resolution.  More detailed descriptions of the sectioning protocols and 

results of 
210

Pb are presented elsewhere (Yohn et al., 2002a, Yohn et al., 2001, Yohn et 

al., 2002b, Yohn et al., 2003).  Specific dating related information and methodology can 

be found in Appendix B. 

 

Sediment Focusing.  Sediment focusing is the movement of fine grained 

materials from erosional to depositional zones of a lake basin, and can be quantified by 

calculating a focusing factor, which is the ratio of observed to expected 
210

Pb inventory.  

The observed 
210

Pb inventory is the product of sediment dry mass and excess 
210

Pb 

summed over all core sections.  The expected inventory of 
210

Pb for this study region is 

0.574 Bq/cm
2
 (Golden et al., 1993).  Accounting for sediment focusing allows 

comparison of inventories and accumulation rates among lakes (Golden et al., 1993).   

 

Calculations.  Anthropogenic Hg concentration was calculated by subtracting the 

long-term geochemical background Hg concentration from the total concentration.  The 

background concentration was defined as that average concentration from the deepest 

core section to the point where concentrations began to increase that could be associated 

with human activities, primarily after colonization of the area by Europeans.  This point 

was determined graphically by determining where the concentration increased 

significantly.  Anthropogenic inventories, the mass of chemical in a sediment core due to 
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human inputs, were calculated as the product of anthropogenic Hg concentration and 

sediment dry mass for each individual core section.  Results for each core section were 

then summed over the entire core to determine the inventory.  The anthropogenic 

accumulation rate was calculated as the product of the sedimentation rate and the 

anthropogenic Hg concentration.  Inventories and accumulation rates were corrected for 

sediment focusing. 

 

Sedimentation rates in lakes vary considerably, and when sedimentation rates are 

great, bottom sections of the sediment core will not contain background concentrations of 

Hg.  Therefore, it was necessary to estimate the focusing-corrected background 

accumulation rate (FCBGAR).  These estimates were based on results of a backward 

stepwise multivariate regression model taking into account physical variables and 

surficial soil properties of the watershed.  This model assumes that soil properties have 

not significantly changed since the pre-industrial period and soil properties that control 

the mobility of Hg do not vary among watersheds.  Physical variables entered into the 

model included: lake area, watershed area, and watershed:lake area ratio (WS:LA).  Soil 

properties were determined via dasymetric mapping of STATSGO (USDA) soil 

characteristics using ArcInfo (ESRI, 1998) and included: cation-exchange capacity, 

%organic matter, %clay, carbonate as CaCO3, kfact and kffact, which is a slope adjusted 

kfact value.  Parameters for variables to enter the model included tolerance greater than 

0.6 and probability to enter/leave less than 0.15.  The final model (n=14, Adjusted r
2
 = 

0.66) is presented in equation 1; variables were significant at p<0.05 (one-tail t-statistic), 

tolerances were greater than 0.75, and residuals were randomly distributed. 
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LAWAORGFCBGAR 091.0015.0%225.0016.5 −++= , (1) 

 

where: %ORG is the percent organic matter in soil, WA is the watershed area and LA is 

the area of the lake.  The average (± SD) modeled FCBGAR was 7.9 (3.7) µg Hg/m
2
/yr, 

whereas the average of the observed FCBGAR was 6.0 (3.5) µg Hg/m
2
/yr.  The intercept, 

which would represent the FCBGAR in the hypothetical absence of the variables above, 

was reasonably close to the median FCBGAR of the observed values, 5.8 µg Hg/m
2
/yr.  

Thus, the predicted FCBGAR values were used to approximate anthropogenic 

accumulation rates for lakes that did not reach geochemical background Hg 

concentrations. Background estimations were not used to calculate anthropogenic 

inventories due to the temporal variation of mercury accumulation; however, these 

estimates would not change the accumulation rate profile.   

 

Previous models have used WA and LA to predict Hg accumulation and organic 

matter has been demonstrated to play a significant role in the cycling of mercury in the 

watershed (Lorey and Driscoll, 1999, Swain et al., 1992) .  Although the positive 

relationship between WA and FCBGAR was expected, the negative relationship between 

LA and FCBGAR was not anticipated.  Removal of LA from the model consistently 

resulted in poorer estimates, lower adjusted r
2
, of FCBGAR.  Greater inputs of Hg would 

be expected for large lakes and thus background values would reflect this relationship.  

We suspect that the LA variable may in part explain differences in sedimentation rates 
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observed in the larger lakes.  Observed background Hg concentrations and sedimentation 

rates, both of which would result in a low FCBGAR, were both least for larger lakes.  

Organic matter is important in the biogeochemical cycling of Hg in soils (Grigal, 2003, 

Meili, 1991).  Greater concentrations of organic matter in soils effectively retain Hg and 

other metals.  More effective retention in soils might lead to greater concentrations during 

runoff events resulting in the transport of Hg from the watershed (Scherbatskoy et al., 

1998).   

 

Quantification of Mercury. Total Hg concentrations were determined in 

lyphophilized sediment by use of a Lumex Thermal Decomposition Atomic Absorption 

Spectrometer  in accordance with EPA Method 7473 (USEPA, 1998).  Calibration of the 

instrument and in-run validation were performed using standard reference material 

(SRM) 1515 Apple Leaves or SRM1633b Coal Fly Ash; detection limits were 0.69 ng 

Hg/g, dw and 0.58 ng Hg/g, dw, respectively.  In-run SRM validation measurements were 

consistently within the range specified. 

 

Results and Discussion 

Anthropogenic Inventories.  Anthropogenic inventories are an accounting of the 

long-term loading of a contaminant to a lake.  Analysis of the spatial patterns of 

inventories among lakes can reveal patterns of source in a region.  For the purposes of 

this discussion a region has been defined as the entire state of Michigan whereas sub-

regions are smaller areas within the region, such as southeast Michigan.  A regional 

pattern of deposition is indicated if inventories decrease along some gradient, such as 
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population density or industrial development.  The source for the pattern of deposition 

may be common to all lakes, a common source, or similar watershed processes occurring 

at different rates, a source common to all lakes.  For example, Pb inventories in these 

study lakes decrease from the South to the North, implying a regional source (Yohn et al., 

2004).  Lead from the use of leaded gasoline is the most commonly accepted cause for 

this trend; greater lead inventories in the southern, more populated and industrialized 

portion of the state trend toward lesser inventories in the northern, less populated, 

portions of the state.  A regional source may also be present if inventories are similar 

among lakes within a sub-region.  Focusing-corrected copper inventories were found to 

be similar among depositional basins of Lake Michigan. (Kolak et al., 1998).  This 

suggests a regional source for copper entering Lake Michigan.   

Recent measurements of atmospheric deposition of Hg for the Great Lakes region 

have demonstrated a South to the North gradient (Keeler and Dvonch, 2005).  If this 

general South to North trend has been persistent over time then inventories plotted along 

this spatial gradient should follow a similar pattern, evidence of a regional source.  

Results of focusing-corrected anthropogenic Hg inventories for 18 Michigan lakes 

(Figure 2.2) were plotted along a South to North gradient to investigate the possibility of 

a regional source.  Mercury inventories varied among lakes, ranging from 0.3 µg Hg/cm
2
 

in Round Lake to 1.6 µg Hg/cm
2
 in Houghton Lake (Figure 2.2).  Anthropogenic Hg 

inventories were found to vary slightly in Lakes Michigan (0.08 – 0.17 µg Hg/cm
2
)
 
and 

Superior (0.02 – 0.15 µg Hg/cm
2
), with anthropogenic inventories decreasing from the 

South to the North (Long et al., 1995).  If the range of inventories determined in the 
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Great Lakes represents a regional estimate of Hg loading for this region (both the Upper 

and Lower Peninsulas of Michigan), then deviations from these patterns suggest the 

influence of sub-regional to local scale sources.  Most anthropogenic inventories from 

inland lakes are consistent with a regional source; however, notable exceptions include, 

Higgins, Houghton and Gull lakes. 

 

Figure 2.2. Focusing-corrected anthropogenic Hg inventories from 18 inland Michigan 

lakes.  Inventories are plotted along a south to north gradient.  The boxes represent the 

range of anthropogenic inventories for Lake Michigan and Lake Superior (Long et al., 

1995). 
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The relative importance of local sources can be determined by comparing the 

anthropogenic inventories of lakes from the same geographic region because these lakes 

would be expected to have similar loadings due to long range atmospheric loading so that 

differences could be attributed to more local sources.  Lakes Higgins and Houghton, in 

the central Lower Peninsula, and Elk and Torch lakes, in the NW Lower Peninsula, are 

examples of geographically proximal lakes.  Anthropogenic inventories differ among 

these pairs of lakes indicating that local, likely watershed-scale, sources were 

contributing to Hg loadings.  Crystal M and Littlefield lakes lie within the central portion 

of the state and have similar anthropogenic inventories.  Inventories for these lakes are 

within the range of those from Lake Michigan suggesting that Hg loading in this area is 

most likely due to regional sources of Hg.  The differences among the Upper Peninsula 

lakes, Gratiot, Imp, Round D, and Round, imply that local sources contribute 

significantly to Hg loadings; however, these lakes are within the range of anthropogenic 

inventories found in Lake Superior.  Portions of the Upper Peninsula are more 

mineralized than other areas of the state and have undergone intense mining, which may 

have lead to increased export of Hg from the watershed (Kerfoot et al., 1999, Kerfoot et 

al., 2004). 

Temporal Trends. In general, anthropogenic accumulation began in the late 

1800s and reached nominal peak values during the 1950s to 1980s depending on the lake 

(Figures 1.3-1.7).  Episodic events have been superimposed on this general trend.  These 

events may be unique to a lake or may be common among many lakes in a sub-region.  

Episodic increases common among lakes indicate that they resulted from increased 

accumulation and not post-depositional mobilization or spatial variability within the 
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sediments.  Episodic increases that are common among lakes may be due to a common 

source or watershed processes that are common to all lakes.  Profiles are grouped by sub-

region to highlight accumulation rate patterns.  Profiles for all of the other lakes that were 

studied can be found in Appendix B.   

 

Figure 2.3. 
210

Pb dated focusing-corrected anthropogenic accumulation rates for four 

southwestern Michigan lakes, dates older than 1850 were truncated to highlight more 

recent loading.  Note the change in scale of the x-axis. 
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Figure 2.4. 
210

Pb dated focusing-corrected anthropogenic accumulation rates for 4 

southeastern Michigan lakes.  Note the change in scale of the x-axis. 
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Figure 2.5. 
210

Pb dated focusing-corrected anthropogenic accumulation rates for five 

Upper Peninsula of Michigan lakes, dates older than 1850 were truncated to highlight 

more recent loading.  Note the change in scale of the x-axis. 
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Figure 2.6. 
210

Pb dated focusing-corrected anthropogenic Hg accumulation rates for two 

north-central Michigan lakes.  Note the change in scale of the x-axis. 
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Figure 2.7. 
210

Pb dated focusing-corrected anthropogenic accumulation rates for four 

northwestern Michigan lakes, dates older than 1850 were truncated to highlight more 

recent loading.  Note the change in scale of the x-axis.  
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Anthropogenic Hg profiles from lakes in southwestern Michigan reflect the 

proximity to industrialized areas and also include several episodic accumulation events 

(Figure 2.3).  The proximity of this sub-region to the Chicago, IL/Gary, IN area suggests 

that these lakes should reflect the impact of Hg from this highly industrialized region.  It 

has been suggested previously that the Chicago/Gary area is a source of Hg to southern 

Lake Michigan (Landis and Keeler, 2002, Landis et al., 2002) and it has been proposed 

that the Chicago/Gary industrial complex was a major source for lead, cadmium and zinc 

to these study lakes (Yohn, 2004).  The similarity, excluding episodic accumulation 

events, of the loading profiles observed for Gull and Birch lakes implies a source of Hg 

common to both lakes was present until the early 1990s, although the onset of the 

anthropogenic Hg accumulation occurred earlier in Birch Lake.  The recent recovery of 

Gull Lake to a rate of anthropogenic loading that is near zero is notable, since this was 

observed in only 2 of the 26 study lakes studied (see Littlefield Lake, Figure S1 in 

Appendix B ).  Accumulation rates in Birch and Muskegon lakes decreased toward the 

surface whereas the rates in Lake Paw Paw have increased.  The uniqueness of the 

accumulation rates observed near the surface of the core from Lake Paw Paw and the 

unique episodic events (ca 1960 and 1984) suggests a local source.  Paw Paw Lake was 

dated with a linear dating model using a single sedimentation rate (see Appendix B, 

Table S1).  Meaning, in Paw Paw Lake, episodic events were due to increased Hg 

concentration on the sediment and not increased sediment delivery.  Episodic events that 

were common among all southwestern lakes include a peak in the early 1990s and early 
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to mid 1970s.  Great anthropogenic Hg accumulation rates in Paw Paw and Muskegon 

lakes suggest that local-scale sources are significant contributors of Hg to these lakes. 

Southeastern Michigan is a highly populated and industrialized area of the state.  

This area also has the highest number of coal-fired utilities in the State; although all of 

these facilities lie to the east of the study lakes (Figure 2.1).  Winds are generally 

westerly or southerly in this region.  Mercury accumulation rates are greater in lakes from 

this sub-region which may be a consequence of greater atmospheric deposition in this 

region compared to less urban regions of Michigan (2005).  Mercury in the cores from 

Whitmore, Cass, and Otter lakes exhibit large anthropogenic accumulation rates with 

peak rates that were amongst the greatest measured for all of the lakes studied (Figure 

2.4).  Lakes Otter and Whitmore, which are situated in the northern part of this sub-

region, exhibit rapid increases in anthropogenic Hg accumulation during the latter part of 

the 1940s into the early 1950s.  This implies a common source or a source that is 

common to both lakes of Hg loading to both lakes during that period.  Furthermore, 

several of the episodic increases in Hg loading occurred simultaneously among these 

lakes, suggesting a source of Hg loading common to both lakes.  Episodic events in the 

early and mid 1990s are common among all of the southeastern lakes.  During the early 

2000s, episodic events occurred in Sand and Otter Lakes.  When accumulation profiles in 

these lakes were compared to those observed in the surficial portion of the core from 

Whitmore Lake it is possible that Whitmore Lake is currently experiencing a spike in Hg 

accumulation. If Whitmore Lake were revisited, the most recent sediments should show a 

decline in accumulation rate.   Dating-model error, measurement error and field 

methodologies all contribute to possible errors in sediment core chronologies.  However, 
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the observation that so many episodic events “line-up” among lakes suggests that the 

events are real.  Similar to Paw Paw and Muskegon lakes, the accumulation rates in Cass 

Lake were anomalously great; these rates suggest a unique source or a sub-regional 

source in close proximity to the lake.  Recently, decreases in Hg loading have been 

observed among all of the lakes in the southeastern sub-region (Figure 2.1), generally 

from maximal loading rates, in anthropogenic Hg accumulation.  Sediment cores from 

lakes in urban areas of Minneapolis, MN have demonstrated that loading rates of Hg have 

decreased in recent years (Engstrom and Swain, 1997).  The hypothesis stated for the 

decreased Hg loading to urban Minneapolis lakes is that limited growth in already built-

up areas has slowed the potential for new sources of Hg to the lakes.  This also 

adequately explains the recent declines observed for southeastern Michigan (suburban 

Detroit and Flint) lakes in our study; although the reasons for episodic increases are 

unclear at this time.  

Rates of anthropogenic Hg loading to five Upper Peninsula (UP) lakes, Gratiot, 

Imp, Round D, Round, and Witch, appears to be sub-regional in nature (Figure 2.5).  

Other than the episodic accumulation events, this conclusion is further supported by the 

similarity of profiles in the eastern portion of the UP (Round D and Round) compared to 

those in the western UP (Imp and Witch).  Both Round D and Round lakes appear to have 

reached a steady state accumulation rate shortly after reaching maxima in the early 1900s 

and 1950s respectively.  Then, during the late 1970s, Hg accumulation rates in both lakes 

increased and followed similar trajectories.  Witch and Imp lakes both reached maximal 

Hg accumulation rates in the 1960s followed by a steady decline until the 1990s.  After 

1990, both Imp and Witch lakes exhibited greater accumulation rates until 2000, followed 
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by a more recent decrease.  Except for a unique accumulation rate profile in more recent 

times, certain episodic increases in Hg accumulation during the 1910s, 1940s, and 1980s 

in Gratiot Lake were common to other western UP lakes, suggesting that Gratiot Lake 

would be included in this sub-region.  The episodic events after 1975 in Gratiot were 

superimposed on a generally increasing trend.  The extent of these events suggests that 

the source was local, most likely watershed, in scale.  

Anthropogenic Hg accumulation rate profiles from Lakes Higgins and Houghton 

in the north-central portion of the Lower Peninsula of Michigan exhibit simultaneous 

occurrence of episodic increases (Figure 2.6).  A notable deviation was observed during 

the mid to late 18
th

 century in Houghton Lake.  Reasons for not observing this 

phenomenon in other Michigan lakes that contain sediment of adequate age to record the 

disturbance are not yet clear, but may be due to the unique geography of the Houghton 

Lake area.  Higgins Lake lies 14 km due north of Houghton Lake, and their watersheds 

share a common boundary.  Houghton Lake lies at or near the headwaters of three major 

river systems, two of which flow into Lake Michigan (Muskegon and Manistee rivers) 

and one into Lake Huron (Au Sable River).  Native Americans commonly used rivers as 

efficient transportation corridors from West to East (Quimby, 1962) and the advantage of 

efficient travel may have led to early settlement.  Native American tribes during this 

period were known to travel inland over 100 km from the Lake Michigan shoreline 

(Quimby, 1962).  Other metals, such as, aluminum (Al), zinc and cadmium, do show an 

accumulation rate increase during this period suggesting a terrestrial input (Yohn et al., 

2003).  The disturbance that led to the increase of these metals is unclear, but may be due 

to the early trading and land-clearing activities in the region.   
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Prior to 1930, the Hg accumulation rate profiles of 4 northwestern Michigan 

lakes, Elk, Torch, Crystal B and Mullett were similar (Figure 2.7), which suggests a 

regional to sub-regional source of Hg.  After the 1930s, lakes Mullett and Torch appear to 

have been influenced by a more sub-regional source, whereas Elk and Crystal lakes show 

the effects of more local sources.  Loading rates of Al to Elk Lake decreased during the 

mid-20
th

 century episodic Hg increase.  These two observations, taken together, suggest 

that the source was a point source or local atmospheric deposition rather than terrestrial 

(Long et al., 2000).  Mercury accumulation rates in Crystal B Lake were found to be 

increasing towards the sediment water interface, which is unique for this sub-region, 

suggesting a local source. 

While it is clear that some episodic accumulation events are due to local-scale 

sources it is unclear at this time the reasons for these events.  Possible sources being 

considered include: waste incinerators (Liu et al., 2007), fuel combustion (Lynam and 

Keeler, 2006), dental office waste (Drummond et al., 2003), forest fire (Turetsky et al., 

2006), clear-cutting of forest (Porvari et al., 2003), pulp and paper mills (Hynynen et al., 

2004), and cement manufacturing (Pacyna et al., 2006). 

 

Recent Trends.  Hg concentration profiles in sediments from several lakes have 

recorded recent increases in Hg loading (Engstrom and Swain, 1997, Lorey and Driscoll, 

1999, Perry et al., 2005, Swain et al., 1992).  Over the last decade in Michigan, 8 of the 

26 lake profiles showed anthropogenic Hg accumulation rates that increased toward the 

surface, 11 showed trends that indicate anthropogenic loading had declined, 5 showed 

elevated accumulation rates but no clear increasing or decreasing trend, and 2 had 
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anthropogenic accumulation rates at background levels (Figure 2.1).  Considering the 

lakes experiencing increased loading, the lack of a spatial trend suggests that the source 

was not regional in scale.  Lakes that are increasing are not located in areas of the state 

that have a high density of coal-fired power plants (Figure 2.1), further evidence of the 

importance of local-scale sources of Hg to these lakes.  In addition, these results are 

inconsistent with a decrease in Hg emissions (Engstrom and Swain, 1997).  Possible local 

sources include: mobilization from watershed soils, industry, and agriculture.  The 

increase observed in sediment cores from Adirondack lakes have been attributed to a 

decrease in the retention of Hg by watershed soils (Lorey and Driscoll, 1999).  Some 

researchers have attributed the increase recorded in western Minnesota lakes to Hg-laden 

soils delivered from agricultural fields (Engstrom and Swain, 1997).  At this time it is 

unclear as to why we observe increased accumulation rates in more recent periods but 

one or all of the above may have contributed.   
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CHAPTER 3 

A REGIONAL ANALYSIS ON THE EFFECTS OF WATERSHED ATTRIBUTES ON THE 

RECOVERY OF INLAND LAKES FROM MERCURY ENRICHMENT. 

 

Abstract 

 

Sediments from inland lakes record recent declines in mercury (Hg) loading to the 

environment.  The rate of decline or recovery rate varies among lakes which we hypothesize to 

be due to differences in how watershed attributes influence the transport of Hg through the 

watershed.  Sediment cores were collected, dated using lead-210, and analyzed for Hg from 13 

inland lakes throughout the State of Michigan to test this hypothesis.  Slopes of linear recovery 

calculated from the most recent declines in concentration and accumulation rate were compared 

to watershed attributes using Pearson’s correlation coefficient.  Agricultural, forested and 

wetland attributes were all important determinants of recovery rate.  However, the strongest 

correlations were found for land cover types along highly conductive watershed flow paths or 

within close proximity to the lake.  These results highlight the importance of watershed attributes 

and the transport of Hg from the catchment to the lake.  However, this work also emphasizes the 

importance of location within the watershed as an important determinant of contemporary 

recovery. 

 

Introduction 

 

How aquatic systems are recovering from man-caused stresses continues to be a critical 

question for both researchers and natural resource managers.  Of particular concern is recovery 

from mercury (Hg) contamination because organic forms bioaccumulate in aquatic food webs 

and consumption of tainted fishes can impact human health (Hightower and Moore, 2003, 

USEPA, 1997).  Environmental archives (e.g., sediment chronologies) have been shown to be 

reliable recorders of anthropogenic activities and have demonstrated the efficacy of 
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environmental legislation (Bindler et al., 2001, Engstrom and Swain, 1997, Kamman and 

Engstrom, 2002, Long et al., 2010, Lorey and Driscoll, 1999, Swain et al., 1992).  However for 

Hg, sediment concentrations and fluxes for most lakes are still elevated above geochemical 

background values (Bindler et al., 2001, Engstrom et al., 2007, Kamman and Engstrom, 2002, 

Parsons et al., 2007, Swain et al., 1992)  This condition is in part due to continued Hg emissions  

and the transport of previously deposited Hg, so called “legacy Hg”, from the watershed to the 

aquatic ecosystem due to natural processes that might be exacerbated by human disturbances.  

However, as anthropogenic Hg emissions continue to decrease, which some have suggested for 

the Great Lakes region (Evers et al., 2011, Keeler and Dvonch, 2005), one might hypothesize 

that transport through the watershed might play an ever more important role in the rates of 

recovery of ecosystems from Hg contamination.  The activities that result in differences in Hg 

transport through the watershed will need to better defined, especially if those activities result in 

a slower recovery 

Sediment profiles of heavy metals (e.g., Cd, Cu, Pb, Zn and Hg) when influenced by 

human activities consist of three primary temporal phases, the first being a time which can be 

considered geochemical background, or reference condition, which in the State of Michigan 

occurs prior to European settlement, ca. 1850.  Throughout inland lakes of Michigan the next 

phase recognized in sediment profiles is the onset of deforestation.  This is followed by the 

increased production and consumption of heavy metals during the industrial revolution (Long et 

al., 2010) which is evidenced by rapidly increasing sediment concentrations and fluxes starting 

in the late 19
th

 century.  The final phase occurs after the passage of environmental legislation, 

i.e., Clean Air Act (US EPA, 2008), when the loading of metals to the environment significantly 

decreased.  This final, or recovery, phase is evidenced by decreasing sediment concentrations 
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and fluxes.  The rate of recovery, defined here as the slope of decreasing concentrations or 

fluxes, can differ among lakes which may be due in part to proximity to local sources, but also 

due to differences in watershed attributes or differing rates of landscape disturbance. 

 

Export rates of Hg from watersheds have been shown to be influenced by land use 

(Babiarz et al., 1998, Hurley et al., 1995b).  Although the transport of Hg through the watershed 

is not fully understood some generalizations can be made.  All catchments are sinks for 

atmospherically deposited Hg and rates of retention can be greater than 90% (Aastrup et al., 

1991, Harris et al., 2007).  Those landscapes that experience higher rates of erosion (e.g., 

agricultural) would be expected to have a higher probability to export rather than retain Hg 

(Munthe et al., 2007a).  Urban areas, in the absence of local emitters, have been suggested to 

export less Hg then most other land use types due to a lack of activities that disturb the landscape 

(Engstrom and Swain, 1997).  Forests have been shown to be sinks for Hg; but can release Hg 

during storm events (Munthe et al., 2007b), forest fires (Turetsky et al., 2006), and logging 

(Munthe and Hultberg, 2004, Porvari et al., 2003).  There does not appear to be a consensus 

about the effects of wetlands on Hg export.  Some have shown that wetland type or presence 

does not influence Hg export (St. Louis et al., 1996), while others have found that Hg is less 

likely to be retained when wetlands are present (Hurley et al., 1995a, Mierle and Ingram, 1991). 

 

Both sediment concentration and accumulation rate chronologies are commonly used to 

represent system state due to the unique information they provide about environmental condition.  

Concentration profiles provide information about environmental exposure that may be useful to 

natural resource managers and differences with respect to watershed concentrations that aid in 
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determining the state of recovery of the system from disturbance (see Long et al., 2010).  

Knowledge of the accumulation rates can be important since concentration can be diluted or 

amplified depending upon the changes in flux of allochthonous and autochthonous materials.  

For example, if the flux of Hg to sediment were fixed, consequences of an increase in lake 

productivity (e.g., increased calcium carbonate deposition) would dilute the Hg concentration 

recorded in the sediment.  However, the Hg accumulation rate would remain unchanged since the 

increase in sedimentation rate would offset the decrease in Hg concentration.  Likewise if the 

source of the terrestrial input would for some reason change, e.g., logging activities strip native 

top soil, see (Long et al., 2010), and the atmospheric flux of Hg is again fixed then the 

concentration might be expected to decrease.  The Hg accumulation rate would increase; 

however, since the flux of soil material would be expected to be much greater than under 

previous conditions.  Under this set of circumstances the definition of recovery is confounded 

since concentrations are decreasing, an indication of recovery, but accumulation rate is 

increasing.  A study of system recovery then must compare concentrations and accumulation 

rates since each can provide alternative interpretations or additional information about movement 

of Hg through the watershed. 

 

Sediment cores used for this study were collected from 14 inland lakes throughout the 

State of Michigan (Figure 3.1) as part of a larger Inland Lakes Trends Monitoring Program 

funded by the Michigan Department of Natural Resources and Environment.  Lakes included in 

this study vary in watershed land use from highly urban landscapes in southeast Michigan to the 

remote, highly forested region, of Michigan’s Upper Peninsula (Table 3.1).  Slopes of the 

concentrations and flux declines were compared against watershed attributes in order to 
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investigate the relationship between the recovery of inland lakes from anthropogenic Hg 

contamination and watershed land use. 

 

Figure 3.1. Location of study lakes.  
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Methods 

Core collection and recovery estimates.  Sediment cores were collected using an Ocean 

Instruments MC-400 from the deepest portion of the lake from the MDNRE R/V Nibi or US EPA 

R/V Mudpuppy between 1999 and 2007.  Sediment cores were sectioned on shore at 0.5 to 1.0 

cm increments and stored on ice in acid-cleaned polypropylene jars during.  In the laboratory, 

samples for mercury analysis were transferred to Whirl-Pak bags and lyophilized.  Mercury 

analysis was performed using a Lumex Mercury Analyzer following US EPA Method 7473 

(USEPA, 1998).  Samples for radiometric dating were submitted to the Freshwater Institute at 

the University of Manitoba.  The radionuclide 
210

Pb was measured in every slice to determine 

sedimentation rates and assign dates and cesium-137 (
137

Cs) was measured in select slices to 

determine peak activities.  Cesium-137 analyses were performed by direct counting of 5-10 g of 

sediment on a γ-spectrometer (Ge-Li) semiconductor detector.  Samples of 1-3 g were analyzed 

for 
210

Pb and radium-226 by leaching in 6N hydrochloric acid in the presence of a polonium-209 

tracer, autoplating on a silver disk, and counting the disk on an α-spectrometer, determining 

210
Pb via its polonium-210 daughter product.   Sediment slice ages were estimated using the 

constant rate of supply (CRS) (Appleby and Oldfield, 1978), constant flux:constant 

sedimentation (CF:CS) (Golden et al., 1993), or segmented CF:CS model (Heyvaert et al., 

2000).  Assigned dates were verified using peak activities of 
137

Cs (Appleby, 2001) and stable 

Pb (Alfaro-De la Torre and Tessier, 2002). 
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Recovery rates for concentration and accumulation rates were determined by calculating 

the slope of the most recent decreasing trend of Hg, measured from the most recent peak or 

change in slope trajectory.  To avoid inclusion of episodic or short term increases (Figure 3.2) in 

the calculation of slope the Hg profile was first smoothed using smooth command in Matlab 

(Mathworks, 1994 - 2008).  Slopes were compared to watershed attributes using Pearson’s 

product-moment correlation coefficient (r) which assumes a normal distribution and where 

necessary data were transformed to meet this assumption.  Statistical analyses were performed in 

the statistical environment R (The R Foundation for Statistical Computing, 2008).  Outliers, as 

indicated by statistical boxplots, were removed so that these data did not overly influence the 

results.  Only statistically significant results (p ≤ 0.10) are reported.  In the case of zeros in the 

dataset and the requirement to transform the data a constant was added to each original value 

equivalent to the value of the first quartile squared divided by the value of the third quartile. 

 

Determination of watershed attributes.  Land use data were obtained from the 2001 

IFMAP/GAP Lower and Upper Peninsula datasets (Michigan Department of Natural Resources, 

2003) for each watershed.  Land use was classified using the upper-most level Anderson 

classification and resulted in 7 land use types: urban (URB), agriculture (AG), forest (FOR), 

barren (BAR), upland (UPL), water (WAT) and wetland (WET).  Lowland forests originally 

included as wetland were reclassified as forested land use.  Flow inverted (FLI) and flow 

inverted squared (FLI2) land use values, for the watershed and within 100 m of the lake 

shoreline, were calculated by determining the flow length (i.e., the pathway a drop of water 

would take to the lake when dropped on the watershed) using the FLOWLENGTH command in 

ArcGIS (ESRI, 1998).  The inverse (1/flowlength) and inverse squared (1/flowlength
2
) of the 
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flowlength were then multiplied by the land use with the 30 m
2
 grid cell of individual land use 

coverages assigned a 1, for presence, or 0 for absence.  This method has the potential to provide 

information about land use in close proximity or along highly conductive flow paths that would 

not be represented by other measures.  All land use variables were also calculated for a 100 m 

buffer around the lake shoreline and converted to proportions for this analysis.  By convention 

land use type will precede FLI and FLI2 to indicate these transformations (e.g., AG.FLI is read 

flow length inverted agriculture).  Likewise land use calculated within the buffer is given the 

suffix M (e.g., AG.FLI.M is read flow length inverted agriculture in the 100 m buffer). 

Sulfate deposition (SD), used here as a proxy for coal combustion (Yohn, 2004), was 

estimated for the region by using inverse distance weighting of the 1990-2009 average sulfate 

deposition values for 19 National Atmospheric Deposition Program stations around the Great 

Lakes region (Illinois State Water Survey, 2008).  Soil erodibility, expressed here as the k-factor 

(K.F) and slope corrected k-factor (K.FF), was estimated using dasymetric mapping techniques 

using the State Soil Geographic Database (STATSGO) (USDA, 1994).   

Four physical variables were investigated along with land cover attributes: latitude, 

watershed area (WA), calculated with the lake removed, lake area (LA), and WA:LA.  

Watersheds were delineated from National Elevation Dataset (NED) 1 arc second digital 

elevation models (DEM), available from the USGS seamless website (USGS, 2008), using the 

watershed command in ESRI ArcGIS (ESRI, 1998).  Others have shown that WA:LA is an 

important determinant for sediment Hg fluxes (Swain et al., 1992).  Latitude was investigated as 

a proxy for atmospheric deposition rates which have been shown to decrease from the South to 

the North in this region (Keeler and Dvonch, 2005).  Since latitude only captures a regional trend 

Hg emissions estimates were included to detect possible correlations to local sources that may be 
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unique to a sub-region or an individual lake.  Mercury emissions were calculated using the 2002 

U.S. EPA Hg emissions estimates for the State of Michigan (USEPA, 2006) for 50 and 100 km 

buffers around the lake.  A complete list of the watershed characteristics for lakes in this study 

can be found in Table 1.  
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Table 3.1. Watershed attributes of study lakes: watershed area (WA), lake area (LA), watershed 

to lake area ratio (WA:LA), urban (URB), agriculture (AG), forest (FOR), upland (UP), barren 

(BAR), and wetland (WET). 

Lake 

Concentration 

Recovery 

Rate 

(µg/kg/y) 

Flux 

Recovery 

Rate 

Latitude 

WA   

(km
2
) 

LA     

(km
2
) WA:LA (µg/m

2
/y/y) 

Birch -2.7 -0.22 41.8669 16.9 1.2 14.2 

Cass -1.9 -1.14 42.6036 38.7 5.2 7.5 

Charlevoix -1 -0.57 45.2632 765.1 69.8 11 

Elk -1.5 -0.25 44.8690 85.8 31.3 2.7 

George -5.6 -1.45 44.3997 5.1 0.8 6.3 

Gull -1.3 -0.47 42.3963 55.3 8.2 6.8 

Hackert -4.3 -0.57 43.9827 1.6 0.5 3.2 

Houghton -4.5 -0.55 44.3203 382.7 81.2 4.7 

Mullett -0.3 -0.09 45.4850 1239.5 70.3 17.6 

Muskegon -4.5 -2.74 43.2333 884.7 16.8 52.7 

Nichols -6.5 -0.41 43.7292 0.9 0.7 1.3 

Otter -1.8 -0.52 43.2164 0.5 0.3 1.5 

Round D -7.8 -1.13 46.1462 6.8 1.8 3.8 

Torch -1.6 -0.27 44.9326 120.8 76 1.6 

 

 

Lake URB AG FOR UP BAR WET 

Birch 6.40% 48.30% 27.80% 7.80% 0.10% 4.40% 

Cass 24.80% 0.50% 37.50% 18.90% 0.10% 11.00% 

Charlevoix 3.40% 17.30% 61.00% 14.80% 0.30% 2.30% 

Elk 4.20% 20.40% 53.60% 18.60% 0.20% 1.80% 

George 5.00% 6.30% 59.90% 17.40% 0.20% 9.40% 

Gull 5.60% 59.80% 21.00% 6.10% 0.10% 4.90% 

Hackert 5.90% 33.80% 42.30% 10.20% 0.20% 4.30% 

Houghton 3.70% 0.80% 62.20% 14.60% 0.20% 16.40% 

Mullett 2.80% 7.20% 68.10% 17.70% 0.20% 3.20% 

Muskegon 7.00% 17.20% 47.40% 18.00% 0.40% 7.00% 

Nichols 0.90% 0.00% 86.40% 2.00% 0.20% 5.40% 

Otter 8.30% 4.80% 49.60% 16.70% 0.00% 17.90% 

Round D 0.20% 0.00% 78.60% 3.40% 0.10% 15.40% 

Torch 4.20% 18.60% 54.30% 19.40% 0.20% 1.50% 
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Table 3.1 (cont’d). 

Lake 

SD 

(kg/ha/y) K.F K.FF URB.M AG.M 

Birch 17.7 0.17 0.09 23.10% 3.70% 

Cass 14.3 0.22 0.11 17.30% 0.00% 

Charlevoix 11.8 0.17 0.19 1.60% 3.00% 

Elk 13 0.19 0.27 6.50% 7.10% 

George 12.2 0.22 0.04 12.80% 0.00% 

Gull 16.5 0.26 0.12 20.30% 1.00% 

Hackert 15.1 0.26 0.03 11.20% 14.60% 

Houghton 13.5 0.13 0.06 40.60% 0.00% 

Mullett 11.5 0.16 0.14 13.30% 0.80% 

Muskegon 16.7 0.21 0.1 31.20% 0.20% 

Nichols 15.2 0.17 0.09 3.00% 0.00% 

Otter 12 0.21 0.1 9.60% 0.00% 

Round D 8 0.15 0.14 0.00% 0.00% 

Torch 12.6 0.19 0.29 7.90% 2.90% 

 

 

Lake FOR.M UP.M BAR.M WET.M FOR.M 

Birch 40.20% 10.00% 0.00% 21.20% 40.20% 

Cass 42.60% 9.80% 0.00% 9.00% 42.60% 

Charlevoix 47.00% 15.30% 7.60% 11.90% 47.00% 

Elk 46.20% 10.20% 0.20% 9.00% 46.20% 

George 41.50% 14.10% 0.30% 8.10% 41.50% 

Gull 45.00% 12.20% 0.00% 11.00% 45.00% 

Hackert 42.70% 10.00% 0.20% 6.80% 42.70% 

Houghton 19.70% 8.60% 0.40% 9.00% 19.70% 

Mullett 43.70% 8.00% 0.00% 16.20% 43.70% 

Muskegon 5.30% 16.50% 8.40% 11.10% 5.30% 

Nichols 87.00% 3.70% 0.00% 2.20% 87.00% 

Otter 45.60% 14.90% 0.00% 23.70% 45.60% 

Round D 71.90% 4.10% 0.10% 3.20% 71.90% 

Torch 44.80% 12.20% 0.40% 7.00% 44.80% 
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Table 3.1 (cont’d) 

Lake URB.FLI AG.FLI FOR.FLI UP.FLI BAR.FLI 

Birch 14.20% 28.40% 38.20% 9.70% 0.00% 

Cass 19.30% 0.10% 41.60% 14.00% 0.00% 

Charlevoix 11.60% 11.60% 51.70% 15.00% 2.20% 

Elk 6.70% 17.10% 49.00% 14.40% 0.20% 

George 11.40% 2.20% 57.20% 16.70% 0.10% 

Gull 12.80% 23.90% 39.20% 11.20% 0.00% 

Hackert 9.00% 21.40% 46.60% 10.40% 0.10% 

Houghton 23.60% 0.80% 42.60% 11.70% 0.60% 

Mullett 8.20% 5.60% 60.80% 13.90% 0.10% 

Muskegon 26.80% 3.30% 25.60% 17.80% 4.50% 

Nichols 0.30% 0.00% 89.80% 2.60% 0.00% 

Otter 9.50% 2.20% 48.60% 18.10% 0.00% 

Round D 0.20% 0.00% 80.90% 2.00% 0.10% 

Torch 7.90% 7.90% 54.90% 16.30% 0.30% 

 

 

Lake WET.FLI URB.FLI2 AG.FLI2 FOR.FLI2 UP.FLI2 

Birch 8.20% 20.00% 6.50% 42.20% 11.70% 

Cass 10.90% 15.50% 0.00% 40.50% 9.10% 

Charlevoix 5.00% 15.60% 4.00% 43.50% 13.60% 

Elk 5.30% 4.50% 9.30% 50.60% 9.20% 

George 7.20% 11.30% 0.20% 51.40% 14.40% 

Gull 6.70% 14.30% 3.10% 43.30% 16.20% 

Hackert 4.90% 10.20% 15.10% 46.10% 8.90% 

Houghton 15.10% 36.40% 0.10% 27.20% 10.20% 

Mullett 6.80% 9.90% 1.80% 52.90% 9.50% 

Muskegon 9.30% 22.20% 0.20% 8.50% 17.10% 

Nichols 3.60% 0.00% 0.00% 91.40% 3.20% 

Otter 18.90% 7.10% 0.60% 45.70% 20.90% 

Round D 5.90% 0.00% 0.00% 69.40% 1.60% 

Torch 3.70% 6.30% 3.30% 49.80% 13.50% 
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Table 3.1 (cont’d). 

Lake BAR.FLI2 WET.FLI2 URB.FLI.M AG.FLI.M FOR.FLI.M 

Birch 0.00% 19.00% 23.90% 3.30% 43.80% 

Cass 0.00% 11.50% 18.00% 0.00% 40.30% 

Charlevoix 6.00% 8.60% 17.90% 3.10% 41.60% 

Elk 0.20% 8.90% 6.20% 7.80% 50.90% 

George 0.00% 8.60% 15.10% 0.00% 47.40% 

Gull 0.00% 10.10% 18.60% 1.30% 45.40% 

Hackert 0.10% 5.50% 11.80% 14.80% 45.50% 

Houghton 0.50% 10.80% 43.40% 0.00% 23.30% 

Mullett 0.00% 12.20% 13.70% 1.10% 49.90% 

Muskegon 7.30% 12.40% 28.10% 0.20% 5.30% 

Nichols 0.00% 1.80% 0.50% 0.00% 90.70% 

Otter 0.00% 21.20% 9.00% 0.00% 47.80% 

Round D 0.10% 4.30% 0.00% 0.00% 69.40% 

Torch 0.40% 6.80% 8.20% 2.90% 48.00% 

 

 

Lake UP.FLI.M BAR.FLI.M WET.FLI.M URB.FLI2.M AG.FLI2.M 

Birch 11.50% 0.00% 17.10% 23.20% 2.20% 

Cass 9.20% 0.00% 10.20% 17.30% 0.00% 

Charlevoix 13.80% 6.10% 8.90% 18.50% 2.80% 

Elk 9.30% 0.10% 9.20% 5.30% 7.50% 

George 15.50% 0.00% 8.90% 13.40% 0.00% 

Gull 14.80% 0.00% 9.60% 16.00% 1.20% 

Hackert 9.50% 0.20% 5.40% 11.50% 13.40% 

Houghton 9.70% 0.40% 8.70% 40.90% 0.00% 

Mullett 8.90% 0.00% 12.90% 11.70% 1.10% 

Muskegon 17.80% 7.20% 12.40% 26.10% 0.20% 

Nichols 3.50% 0.00% 2.10% 0.00% 0.00% 

Otter 18.30% 0.00% 21.20% 7.60% 0.00% 

Round D 2.40% 0.20% 4.20% 0.00% 0.00% 

Torch 12.80% 0.30% 7.00% 7.40% 2.60% 

 

 

 

 

 

 

 

 



53 

 

Table 3.1 (cont’d). 

Lake FOR.FLI2.M UP.FLI2.M BAR.FLI2.M WET.FLI2.M 

Hg.50 

(Lbs/y) 

Hg.100 

(Lbs/y) 

Birch 40.60% 11.70% 0.00% 21.70% 67 178.6 

Cass 38.40% 7.90% 0.00% 11.40% 1025.9 3127.7 

Charlevoix 38.60% 13.30% 7.00% 9.40% 77.8 118.5 

Elk 49.60% 7.70% 0.20% 9.80% 78.9 123.2 

George 47.50% 13.30% 0.00% 9.20% 1.2 864 

Gull 41.10% 16.60% 0.00% 10.90% 77.8 404 

Hackert 45.30% 8.40% 0.10% 5.70% 56.5 222.4 

Houghton 23.70% 9.40% 0.40% 9.20% 22.1 129.1 

Mullett 50.00% 8.40% 0.00% 13.20% 21 110 

Muskegon 4.60% 16.70% 6.90% 13.10% 170.2 255.5 

Nichols 91.60% 3.40% 0.00% 1.40% 30.8 317.7 

Otter 44.90% 20.90% 0.00% 21.80% 353.7 1306.2 

Round D 64.50% 1.70% 0.10% 4.50% 30.6 74.7 

Torch 46.30% 12.20% 0.40% 7.70% 78.9 119.6 
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Figure 3.2: Mercury concentration profiles (solid markers), results of profile smoothing (open 

markers) and recovery rate (solid line) for study lakes.   
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Figure 3.2 (cont’d) 
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Figure 3.2 (cont’d) 
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decade, or longer, as has been shown for this region (Prestbo and Gay, 2009) or that atmospheric 

deposition across the region would not vary enough to be reflected in sediment archives.  

Differences in the recovery slope are then mostly influenced by variation in watershed processes.  

A recovery slope closer to zero (plotting Hg on the abscissa and age on the ordinate) would be 

indicative of efficient removal of Hg from the landscape leading to the slow decline observed in 

the Hg profile.  This could be from watershed activities that denude the landscape e.g., 

agriculture or watershed processes that lead to the rapid release of Hg.  Conversely, a steep 

recovery slope suggests that Hg is being retained within the watershed quite possibly a result of a 

lack of activities that disturb the landscape or watershed attributes that tend to retain Hg. 

 

Patterns of watershed attributes.  The areal extent of the watersheds in this study ranged from 

0.95 to more than 1300 km
2
 with the majority falling below 200 km

2 
(Table 1).  Ratios of 

watershed area to lake area varied between 1.1 and 53 with most less than 10.  Watersheds with a 

higher percentage of URB are located in the southeastern Lower Peninsula; those high in AG 

along the western half of the Lower Peninsula.  Highly forested catchments are found in the 

northern Lower and Upper Peninsula and those in the southwest Lower Peninsula are the least 

forested.  Soil erodibility values, K.F and K.FF, were generally low, less than 0.2 for most 

watersheds, indicative of clay soils found throughout the state.  Sulfate deposition decreased 

from the South to the North which follows the general population and industrialization trend for 

the State, with the exception that sulfate deposition was higher in the southwest than the 

southeast Lower Peninsula(Yohn, 2004).  This is likely an indication of the importance of the 

large Chicago, IL/Gary, IN industrial complex located near southwest Michigan. 
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Patterns of concentration recovery rates.  Concentration recovery rates varied from -0.30 to -

7.8 µg Hg kg
-1

 y
-1

 with the more positive values indicating a slower recovery rate, i.e., max and 

reference concentrations being equal a return to reference conditions would take more time.  In 

lakes Gull, Houghton and Elk recovery rates were calculated from the mid-1960s until present.  

In other lakes the recovery rate had not changed for the last 10 y prior to sampling.  One 

exception was Round D lake which exhibited a sharp decline in concentration around 2000, in 

this case the most recent slope, which contained 8 sediment slices, was used (Figure 3.2).  This 

suggests that the choice of using the 2001 land use data set rather than an earlier data set was 

justified.  Round D and Nichols lakes have the fastest rate of recovery while Charlevoix and 

Mullett lakes are recovering much more slowly (8-26 times slower, respectively).  Lakes with 

very rapid concentration recovery rates have small watersheds that are primarily forested with 

very little urban or agricultural land uses.  Differences in land use distribution between the 

slowest and fastest recovery rates appear at first glance to be a greater percentage of agricultural 

land use in watersheds of lakes with slower rates of recovery (Table 1).  Similar rates of recovery 

were found for some lakes within close proximity of each other.  This may be due to comparable 

rates of atmospheric deposition for these systems or could be due to a similar distribution of land 

use and rates of disturbances within their watersheds.  For example, Elk and Torch lakes, located 

in northwest Lower Peninsula of Michigan have similar land use distributions within their, 

primarily forested, watersheds (Table 1) and similar concentration recovery rates.  The rate of 

recovery for Gull Lake, located in the southwestern portion of the Lower Peninsula, is similar to 

the northwestern Lower Peninsula lakes.  However, it has a very different land use distribution 

within it’s, primarily agricultural, watershed and different rates of atmospheric deposition of Hg 

would be expected between these two areas of the State (Keeler and Dvonch, 2005).  Others have 
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shown agricultural land-use to export Hg more rapidly than forested landscapes (Babiarz et al., 

1998, Hurley et al., 1995a), but this does not help to explain why Gull Lake was similar to the 

northwestern Lower Peninsula lakes. 

 

Patterns of flux recovery rates.  Rates of flux recovery ranged from -0.09 to -2.7 µg Hg m
-2

 y
-1

 

y
-1

 where more positive values again represent a slower rate of recovery.  Much like the slopes 

of concentration recovery, flux recovery slopes had not changed 10 y prior to sampling the lake.  

Unlike concentration recovery; however, flux recovery rates were most rapid for Muskegon and 

George whereas Birch and Mullett lakes were the slowest.   Common among the concentration 

and flux recovery rates was that Mullett had the slowest rate of recovery and that George had a 

high rate of recovery.  Lake Charlevoix which did have a slow concentration recovery was 

amongst the more rapid flux recovery lakes.  Lakes with more rapid flux recovery rates tended to 

have a higher percentage of URB while those with slower rates had higher AG land cover within 

a 100 m buffer of the lake.  As with concentration recovery, lakes that are in close proximity to 

one another tended to have similar flux recovery rates, e.g., Torch and Elk. 

 

Factors influencing concentration recovery rates.  Watershed area, WA:LA, SD, LAT, soil 

erosion factors, and Hg emissions were not found to be significantly correlated to the rate of 

concentration recovery.  This might have been expected if the rate of recovery is dependent upon 

land use and rate of disturbance of watershed soils rather than atmospheric deposition and 

proximity to local emission sources.   

The strongest correlation of the concentration recovery rate to land use was found for 

agricultural land, but only along watershed flowpaths (LN AG.FLI2: r = -0.75, p ≤ 0.004; 
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Hackert removed as outlier)) (Figure 3.3), the inverse relationship indicates that as AG.FLI2 

increases the rate of concentration recovery slows.  Other measures of agriculture within the 

watershed were also found to be significant but more poorly correlated, (AG.FLI: r = -0.62, p = 

0.025; Birch, Gull and Hackert removed as outliers) and (LN AG: r = -0.54, p = 0.087; Birch and 

Gull removed as outliers).  The association of slowed concentration recovery to AG found here is 

consistent with others that have found agricultural land use to be an important determinant for 

Hg accumulation (Balogh et al., 1998, Engstrom et al., 2007).   However, these results suggest 

that where these activities are located within the landscape to be more explanatory than total 

areal extent.     

Wetlands within the watershed were found to be moderately positively correlated (WET: 

r = 0.65, p = 0.02) to concentration recovery.  The positive relationship means that lakes with 

greater areal extent of wetlands showed faster rates of recovery.  Conversely, wetlands within the 

100 m buffer of the shoreline were found to be negatively correlated (WET.M: r = -0.61, p = 

0.005, Birch and Otter removed as outliers).  What this demonstrates is that the proximity of the 

wetland to the lake shoreline plays an important role in the cycling of Hg in the watershed.  

Wetlands have been reported to be sources of methyl-Hg, but there is disagreement in the 

literature if they act as sinks (St. Louis et al., 1996) or sources (Hurley et al., 1995b, Mierle and 

Ingram, 1991) for total Hg.    We interpret the contradiction between WET and WET.M to mean 

that wetlands on the landscape can act to sequester Hg, but when they are located close to the 

lake they can slowly release Hg, thus slowing the rate of recovery.  
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Figure 3.3. Mercury accumulation rate (Acc Rate) profiles (solid markers), results of profile 

smoothing (open markers) and recovery rate (solid line) for study lakes. 
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Figure 3.3 (cont’d) 
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Figure 3.3 (cont’d) 
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Factors influencing flux recovery rates.  As with concentration recovery, none of the physical 

attributes of the watersheds, e.g., WA, were correlated to flux recovery rates and neither were 

soil erodibility, Hg emissions or sulfate deposition.  

 

The relationships found to be significant for flux recovery were quite similar to those of 

concentration recovery.  Percentage wetlands within the watershed was found to have the 

greatest correlation (Ln WET: r = 0.68, p = 0.01).  As with concentration recovery, a proximity 

measure for wetlands was also found to be significantly correlated to flux recovery, WET.FLI 

(Ln WET.FLI: r = -0.69, p = -0.02; Houghton and Otter removed as outliers).  The reasons for 

the relationships found for wetland variables correlated to flux recovery are similar to those for 

concentration recovery.  Wetlands within the watershed act as traps for Hg leading to a faster 

recovery as WET increases; whereas, wetlands along the highly conductive flowpaths of the 

watershed tend to supply Hg to the lake, resulting in slower recovery.  Proximity measures of 

forest cover types were also found to be significant (FOR.FLI: r = -0.60, p = 0.05; Nichols and 

Round D removed as outliers,  FOR.FLI2: r = -0.60, p = 0.09; Round D, Nichols, Houghton, and 

Muskegon removed as outliers).  Similar to the results found for concentration recovery, flux 

recovery became slower as the percentage of forest along hydronamic flowpaths increased.  The 

arguments made for the relationship between concentration recovery and forest land cover are 

the same as those that can be made for flux recovery.   

 

Noticeably absent from the analysis of flux recovery was the agricultural land cover 

types.  This was not expected since agricultural land cover is generally associated with erosion of 
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the top soil layers leading to the export of contaminant laden particles (Balogh et al., 1998, 

Engstrom et al., 2007).  It would have been anticipated then that increases in agricultural land 

cover would have led to a decreased rate of flux recovery.  The reasons for the absence are 

unclear, but may be related to how drastically sedimentation rates are changed within highly 

agricultural watersheds compared to those lakes in highly forested landscapes and the changes in 

soil matrix that occurs as a result of erosional processes (Engstrom et al., 2007). 

 

Surprisingly, watershed attributes such as WA:LA, urban land cover, and Hg emissions 

were not identified as significant determinants of flux or concentration recovery.  The ratio of 

watershed to lake area has well been established as a predictor of Hg accumulation rates 

(Kamman and Engstrom, 2002, Lorey and Driscoll, 1999, Swain et al., 1992).  The model 

suggests that as WA:LA increased Hg accumulation rate is predicted to rise due to the greater 

surface area for atmospheric deposition and potential for export to the lake.  It was expected then 

that lakes with a larger WA:LA would have slower rates of recovery since the soil pool available 

for export is greater.  However, this relationship appears to break down when lakes are not in 

close proximity to each other or the group of lakes is diverse (Drevnick et al., 2011, Muir et al., 

2009) as would be the case for lakes in this study (Figure 3.1, Table 3.1).   

 

Urban landscapes have been suggested to export less Hg than other land cover types in 

recent decades due to decreases in atmospheric deposition and the lack of watershed disturbance 

(Engstrom and Swain, 1997).  It would then be anticipated that URB would be correlated to the 

rate of recovery with those lakes high in urban land cover having faster recovery rates.  Our data, 

although representing a broad range of watershed characteristics, had a maximum urban land 
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cover of 25% (Cass Lake) with most lakes less than 10%.  Interestingly, Cass Lake had one of 

the fastest flux recovery rates which may be a reflection of greater urban land cover.  However, 

the lack of distribution and representation of true “urban” lakes (URB > 50%) may be 

contributing to the lack of significant correlation.   

 

It was hypothesized that recovery rates would be slower in lakes that had high emission 

rates, but emissions were not found to be significantly correlated regardless of the radius chosen.  

Other variables used to represent atmospheric deposition, e.g., SD and LAT, were also found 

unimportant.  The lack of relationship could be related to the atmospheric transport of Hg and the 

possibility that Hg is being deposited far from the source; although, many studies have shown 

that the majority of Hg deposited derives from local to regional scale sources (Donahue et al., 

2006, Keeler et al., 2006, Menounou and Presley, 2003).  It has been shown that only a portion 

of the Hg deposited to the catchment is immediately transported to lake with most of the 

watershed load being made up of “legacy” Hg (Harris et al., 2007).  This means that it may have 

been more appropriate to use estimates from earlier decades rather than current emissions.  

However, if the pattern of Hg emissions has not changed greatly, a likely scenario, then this 

analysis would have resulted in similar outcomes.  If the majority of Hg is retained in the 

watershed, mostly sorbed to soil organic matter (Grigal, 2003, Meili, 1991, Obrist et al., 2011, 

Schuster, 1991, Skyllberg et al., 2000), it is then those activities within the catchment that disturb 

the soil Hg pool that control export and therefore recovery.  That is not to say that atmospheric 

emission and deposition of Hg are unimportant but rather the relative impact of these activities 

compared to watershed processes is small when comparing lakes within a region. 
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Although this analysis singles out certain watershed attributes that influence recovery 

from Hg enrichment it is likely that it is a combination of factors that in coordination determine 

the shape of Hg profiles and the trajectory of recovery.  That being said, this work has important 

implications for natural resource and watershed managers in that the locations of activities and 

processes within the watershed were found to be significant which may help investigators 

identify areas of interest in future catchment studies of Hg cycling.  
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CHAPTER 4 

INFERRING SOURCES FOR MERCURY TO INLAND LAKES USING SEDIMENT 

CHRONOLOGIES OF POLYCYCLIC AROMATIC HYDROCARBONS 

 

Abstract 

 

Sediment chronologies from inland lakes suggest the influence of local to sub-regional scale 

sources for Hg.  However, source apportionment using sediment chronologies is difficult due to 

the mixing of sources and pathways.  Mercury and polycyclic aromatic hydrocarbons (PAH) 

concentration profiles often share common sources and pathway into the environment.  

Therefore, sediment cores from seven inland lakes of Michigan were collected for the 

measurement of PAHs and Hg and dated using 
210

Pb.  To infer sources of PAHs and Hg, 

assuming common source, diagnostic ratios of kinetic and thermodynamic PAH isomers were 

used.  Ratios indicate the existence of modern combustion sources to each lake and historic 

combustion sources to lakes near cement kilns and an iron foundry.  Coal combustion sources 

were identified for two lakes near urban centers.  Whereas a petroleum combustion source was 

identified for a lake that has a coal fired power plant along its shoreline.  These results therefore 

have implications for the cycling of Hg on local to regional scales. 

Introduction 

 

Several studies have shown that much of the anthropogenic mercury (Hg) emitted to the 

atmosphere is a result of the combustion of coal and petroleum products (Bindler, 2003, 

Fitzgerald, 1989, Kamman and Engstrom, 2002, Keeler et al., 2006, Landis et al., 2002, 

Lindberg et al., 2007, Long et al., 1995, Menounou and Presley, 2003, Pacyna et al., 2006, 

Watras et al., 1994).  As a result of its physical properties Hg can reside in the atmosphere for up 

to a year resulting in global transport (Fitzgerald et al., 1998).  For example, several studies have 
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shown that Hg emitted in Asia has reached the North American continent (Boutron et al., 1998, 

Durnford et al., 2010, Jaffe et al., 2005, Jaffe and Strode, 2008, Obrist et al., 2008, Reidmiller et 

al., 2009, Valente et al., 2007).  Still others have demonstrated that much of the Hg emitted to 

the atmosphere can be attributed to local and regional sources (Donahue et al., 2006, Keeler et 

al., 2006).  As current environmental legislation (US EPA, 2011) attempts to reduce Hg release 

determining the source, especially the distinction between local, regional and global, becomes of 

impending importance.  Environmental archives of Hg (e.g., sediment and ice cores) have been 

used by others to elucidate the likely source of Hg by comparing the record to national 

production and consumption records (Engstrom and Swain, 1997) and event-based markers (e.g., 

major volcanic eruptions) (Schuster et al., 2002).  However, it is difficult to recognize the 

potential of local sources using these methods since only national trends are used or, in the case 

of ice cores, no local sources exist.  The study of source apportionment has been approached 

using atmospheric deposition collectors and multivariate statistical techniques providing 

evidence of local to global scale sources (Dvonch et al., 1999, Dvonch et al., 1998, Keeler et al., 

2006).  Their use is limited; however, due to the lack of atmospheric collectors and the uneven 

distribution of collectors throughout a region, nation or the world (Evers et al., 2011).   

 

Inland lakes are widely distributed and when many lakes can be sampled across a broad 

region have the potential to discriminate between local and regional sources.  However, since 

sediments incorporate both direct atmospheric sources and watershed processes the interpretation 

of source can become difficult.  This may be overcome if an independent marker could be used 

to infer source.  Polycyclic aromatic hydrocarbons (PAHs) are primarily formed during the 

incomplete combustion of petroleum products and organic material (e.g., vegetation) (Hites et 



76 

 

al., 1977).  Due to their volatility PAHs can remain in the atmosphere after emission which can 

result in long distance transport (Killin et al., 2004, Sofowote et al., 2011, Usenko et al., 2010), 

but can also be deposited nearer the source as a result of their particle reactivity (Barrick and 

Prahl, 1987).  Because they are particle reactive sediment chronologies can be used to infer the 

record of their release to the environment (Hites et al., 1977).  There are a variety of activities 

that result in a release of PAHs into the environment (e.g., coal combustion and vehicular 

exhaust) and the sedimentary record is a mixture of all sources which can make source 

apportionment difficult.  Sources of PAHs can be natural (e.g., oil seeps, bitumens, and forest 

fires) or anthropogenic (fossil fuels and combustion) (Yunker and Macdonald, 2003, Yunker et 

al., 2002).  Unique diagnostic ratios of PAHs have been shown to be useful in the identification 

of types of sources (Howe et al., 2004, Simcik et al., 1999, Sofowote et al., 2010, Yunker and 

Macdonald, 2003, Zheng et al., 2011). 

 

There have been many studies that measured metals and PAHs in the environment (Di 

Leonardo et al., 2009, Donahue et al., 2006, Gnandi et al., 2011, Mzoughi and Chouba, 2011).  

However, few of these studies investigated the correlations in environmental loading between 

them even though there is strong evidence that they might share common sources and pathways.  

For example, the sum of PAHs measured in aerosols from the North Sea was found to be 

significantly correlated to lead and other heavy metals (Chester et al., 1993).  In a study designed 

to investigate the impact of vehicular emissions on roadways a multivariate statistical analysis 

showed that Hg tended to cluster with the PAHs rather than the other trace metals, such as lead 

and zinc (Zechmeister et al., 2006) which could be an indication of the shared combustion source 

and pathway for Hg and PAHs in vehicular exhaust.  In New Orleans, LA, USA it was found that 
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PAH ratios indicated a pyrolytic source and that the PAHs were moderately correlated to trace 

metals (Wang et al., 2004). 

 

A significant problem with the use of diagnostic ratios of PAHs is the differential 

degradation of individual PAHs which are driven by differences in vapor pressure and resistance 

to photolytic decay (Yunker et al., 1999, Zhang et al., 2005).  Differences in the rate of 

degradation are greatest amongst the lower molecular weight PAHs, e.g., anthracene, making the 

use of diagnostic ratios that compare lower molecular weight PAHs troublesome.  Corrections 

for differential degradation can be made when meteorological and source data are available 

(Zhang et al., 2005); however, in most cases, and is the case in this study, these data are 

unavailable.  To overcome this issue most studies of PAHs in the environment use multiple 

diagnostic ratios of PAHs (Yunker and Macdonald, 2003). 

 

This work is a portion of the larger Michigan Department of Natural Resources and 

Environment Sediment Trends Monitoring Program (Michigan, 2011b).  Lakes for this study 

were chosen to investigate the hypothesis that Hg is derived mainly from local to regional scales 

sources.  If true then diagnostic ratios should identify local to regional scale sources or show a 

lack of impact from global scale combustion sources. 

Materials and Methods 

 

A detailed description of core collection (Parsons et al., 2007), 
210

Pb dating (Parsons et al., 

2007), Hg (Parsons et al., 2007) and PAH analysis (Kannan et al., 2005) can be found elsewhere.  

Briefly, cores were collected aboard the MDNRE R/V Nibi or US EPA R/V Mudpuppy using an 

Ocean Instruments MC-400 and sectioned on-shore immediately after collection.  Separate cores 
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were used for 
210

Pb dating, metals and organic analyses.  Sectioning of the Hg and 
210

Pb core 

was performed at equal intervals, 0.5 cm increments for the first 8 cm and 1 cm intervals 

thereafter.  The entire organics core was sectioned at 1 cm intervals.  Due to the limited quantity 

of sediment collected at 1-cm intervals, equal amounts of sediment were combined from 

successive sediment samples starting from the top of the core. 

 

Table 4.1. PAH parameters and abbreviations. 

Mass Compound Abbreviation 

152 Acenaphthylene Ayl 

154 Acenaphthene Aen 

166 Fluorene F 

178 Phenanthrene Ph 

 Anthracence An 

202 Pyrene Py 

 Fluoranthene Fl 

228 Chrysene Ch 

 Benz[a]anthracene BaA 

252 Benzo[b]fluoranthene BF 

 Benzo[j]fluoranthene BF 

 Benzo[k]fluoranthene BF 

276 Benzo[ghi]perylene BghiP 

 Indeno[1,2,3-cd]pyrene IP 

278 Dibenz[a,h]anthracene DhA 

 

Mercury analysis was performed using an Ohio Lumex Hg Analyzer according to EPA 

Method 7473.  Measurements of 
210

Pb were made by Paul Wilkinson at the University of 

Winnipeg’s Freshwater Institute; 
137

Cs was measured to verify age estimates.  The US EPA’s 16 

priority PAHs were analyzed using gas chromatography-mass spectrometry.  Sediments for 

organics analysis were Soxhlet extracted then treated with activated copper.  Extracts were 

passed through 10 g of activated Florisil (60-100 mesh; Sigma, St. Louis, MO) and the fraction 

eluted with 100 mL of 20% dichloromethane in hexane and then concentrated.  Results of PAHs 
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are reported here as ng/g dry weight.  Total PAHs (ΣPAH) is defined here as the sum of all 16 

US EPA priority PAHs, Table 1.   

 

Since the organics core was not sectioned at the same intervals as the 
210

Pb core dates for 

the organic core were estimated by calculating the local polynomial regression of depth versus 

age using the loess command in the statistical package R (The R Foundation for Statistical 

Computing, 2008).  Mercury concentrations were then estimated by interpolation using the 

estimated dates from the regression analysis. 

 

 

Results and Discussion 

 

Patterns of PAH and Hg.  Lakes chosen for this study (Figure 4.1) had at least a moderately 

high correlation (Pearson’s r > 0.7, Table 1) between ΣPAH and Hg possibly indicating a 

common source for these contaminants.  The pattern of peak and surficial ΣPAH loosely follows 

the South to North industrialization and population trend, a pattern which was also found for 

peak lead (Pb) concentrations for this region (Yohn et al., 2004).  The higher surficial and peak 

ΣPAH concentrations in Muskegon and Otter suggest a more local than regional source which 

was found for Pb.  Peak and surficial ΣPAHs were greatest in Otter and lowest in Avalon Lake.  

The year of peak ΣPAH concentration occurred earliest in Avalon, 1915, and Round lakes, 1929, 

whereas peak concentration was observed in the surficial sediments of Crystal Lake.  The timing 

of peak ΣPAHs in Avalon and Round are not consistent with the peak in atmospheric deposition 

described by others (Barrick and Prahl, 1987, Fernandez et al., 2000, Lima et al., 2003, 

Wakeham et al., 1980, Yunker and Macdonald, 2003); peaks in ΣPAH near the turn of the last 

century have been attributed to the burning of wood, e.g., forest fires and home heating 
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(Fernandez et al., 2000).  Crystal Lake showed a peak in the middle of the last century (Figure 

4.2c) consistent with an anthropogenic combustion source, but had higher concentrations in the 

surficial sediment which may be evidence of newer sources.  The year of peak ΣPAH 

concentrations corresponded to the year of peak Hg concentration in Round Lake.  Muskegon, 

Otter and Sand lakes had peak ΣPAH years similar to that of Hg; whereas, Avalon, Birch and 

Crystal lakes peak ΣPAH and Hg concentrations did not occur in the same year.  Surficial Hg 

concentrations were lowest in Avalon and greatest in Round and there is a positive correlation 

between surficial Hg and ΣPAHs concentrations.  Lakes with greatest PAH and Hg 

concentrations tend to be located near urban centers of the State; Muskegon near the City of 

Muskegon, Otter near the City of Flint, and Sand near the City of Detroit.  The exception being 

Round, located in the Michigan’s Upper Peninsula, which could be described as a remote lake 

lacking significant urban development other than sparse shoreline housing.   

Table 4.2. ΣPAHs (ng/g dry wt) and Hg (mg/kg dry wt) concentration in the surficial sediments 

and at maximum.  The first column shows the Pearson’s correlation coefficient between Hg and 

ΣPAH. 

Lake r ΣPAHs 

(surficial) 

ΣPAHs 

(peak) 

ΣPAH 

Peak Year 

Hg 

(surficial) 

Hg 

(peak) 

Hg Peak Year 

Avalon 0.75 949 1612 1915 0.050 0.052 1971 

Birch 0.86 1224 2093 1957 0.068 0.095 1977 

Crystal 0.90 1707 1707 2006 0.082 0.084 1990 

Muskegon 0.70 2844 4663 1978 0.16 0.37 1973 

Otter 0.76 3323 8046 1958 0.12 0.25 1960 

Round 0.92 1888 1977 1929 0.17 0.18 1929 

Sand 0.92 1849 2932 1982 0.095 0.12 1988 

 

Prior to the rise of ΣPAHs in the late 1800s and early 1900s mass 252 PAH dominate the core 

profile in Avalon, Birch, Crystal and Round Lakes (Figure 4.2a-c & 4.2f).  This is in contrast to 

what has been found for the Fraser River Basin (Yunker et al., 2002) where the mass 178 and 

202 PAHs were dominant.  This may suggest a petrogenic origin for the mass 252 PAHs to these 
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lakes (Yunker et al., 1993).  In Sand Lake (Figure 4.2g) mass 178 and 202 were greater than the 

other PAHs which is consistent with the burning of grass, hardwood and softwoods (Fine et al., 

2001, Jenkins et al., 1996, Masclet et al., 1995).  Masses 228 and 276 were for the most part the 

least prevalent PAH prior to 1900 in all lakes which, a reflection of the lack of fossil fuel 

combustion in the region at the time (Yunker and Macdonald, 2003).    
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Figure 4.1. Study lakes.   
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Figure 4.2a. Concentration profiles of Hg and PAH isomer groups for Avalon Lake. 
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Figure 4.2b. Concentration profiles of Hg and PAH isomer groups for Birch Lake. 
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Figure 4.2c. Concentration profiles of Hg and PAH isomer groups for Crystal Lake. 
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Figure 4.2d. Concentration profiles of Hg and PAH isomer groups for Muskegon Lake. 
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Figure 4.2e. Concentration profiles of Hg and PAH isomer groups for Otter Lake. 
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Figure 4.2f. Concentration profiles of Hg and PAH isomer groups for Round Lake. 
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Figure 4.2g. Concentration profiles of Hg and PAH isomer groups for Sand Lake. 
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After the turn of the last century until recent times the masses 202, 252 and 276 PAHs 

were dominant in most lakes.  In Avalon, Round and Sand lakes all three of these mass groups 

were elevated to near equal concentrations after their respective peaks (Avalon and Round) or 

after 1940 (Sand).  Mass 202 was greater after the ΣPAH peak in Avalon and after 1920 in Sand 

Lake; whereas, mass 276 was greatest among PAH mass groups after ca. 1920 in Round Lake. 

Birch was similar to Avalon and Sand lakes, but mass 202 was clearly the major constituent after 

the peak in ΣPAH around ca. 1960.  During the mid-century ΣPAH peak, 1950-1970, the masses 

202 and 276 were dominant in Crystal Lake.  The mass 202 PAHs were the major constituent in 

Muskegon and Otter throughout the entire core (Figures 4.2d & 4.2e, respectively).  Profiles of 

PAHs from the Strait of Georgia also showed mass 202 to be the major constituent (Yunker and 

Macdonald, 2003) and is associated with sources from urbanized or industrialized areas 

(Lipiatou and Saliot, 1991, Yunker et al., 1993).  These sources include the burning of gasoline, 

diesel and coal which have also been shown to be important sources for masses 202, 252, and to 

a lesser extent 228 and 276 (Oros and Simoneit, 2000, Rogge et al., 1993, Wang et al., 1999). 

 

The significant correlation between the ΣPAH and Hg concentration profiles in these 

lakes implies that throughout the lakes history a common influence on their concentrations.  

However, there are several instances of coincident increases and decreases that can be either 

unique or shared among the PAH mass groups.  In Avalon Lake the slight concentration increase 

across all mass groups during the mid-1990s may be related to the coincident increase in Hg 

concentration during the same period.  Curiously Hg does not peak until more recent times, ca. 

1970, in Avalon while those of the PAH mass groups peaked much earlier, ca. 1920, and have 

since declined.  The Huron Portland Cement Company started near the town of Alpena (located 
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about 20 miles to the east of Avalon Lake) around the turn of the 19
th

 century and by 1910 was 

the largest cement plant in the world (NOAA, 2011).  Cement kilns have long been recognized as 

contributors of Hg to the environment (Munthe et al., 2007), that combined with the increased 

demand for cement due to the construction of the first concrete roads in Michigan (Morrison, 

1945) could be a likely reason for the earlier than expected peak of PAHs in Avalon Lake.  In 

Birch Lake the peak of Hg in ca. 1980 followed by decline until present is mimicked by most 

mass groups.  The trajectory of increase in Hg after 1920 in Crystal Lake closely resembles that 

of mass groups 202 and 276 than the other groups.  This would be consistent with an 

urbanization of the watershed and the combustion of grasses for the clearing of agricultural land 

(Fine et al., 2001, Jenkins et al., 1996, Masclet et al., 1995).  Whereas the increase in Hg 

between 1830 and 1890 more closely resembles the increases in masses 252 and 202.  The 

profiles of Hg from Muskegon and Otter lakes resembles all of the PAH masses suggesting a 

common influence for all mass groups and Hg.   In Round Lake the profiles of Hg and the PAH 

masses were quite similar from 1860 until the 1920s when Hg becomes nearly constant. 

  

Diagnostic PAH Ratios.  The ratio of PAH isomers are used to identify sources.  However, their 

use as a diagnostic tool to differentiate sources can be confounded by differences in volatility, 

water solubility, and adsorption (Zhang et al., 2005).  These attributes can cause differential 

environmental transport and thus alter ratios.  To deal with this problem researchers generally 

limit studies to PAHs with multiple isomers with interpretive support using multiple diagnostic 

ratios (Wang et al., 2004, Yunker and Macdonald, 2003, Yunker et al., 2002).  The isomer ratios 

compare the least stable, or kinetic, isomer to the more stable, thermodynamic, isomer.  When 

combustion sources are predominant the least stable isomer is enhanced (Yunker and 
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Macdonald, 1995) thus, the PAH mass groups with the greatest range in stabilities between the 

isomers have more potential to differentiate between petroleum and combustion sources (Yunker 

et al., 2002).  The PAH molecular masses with the greatest range of stability, in order of most 

potential for discrimination to least, are 276, 202, 252 and 178 (Yunker et al., 2002).  Examples 

of specific diagnostic ratios include the following.  A ratio of anthracene to phenanthrene plus 

anthracene (An/178) less than 0.1 indicates a dominance of petroleum, e.g., naturally occurring 

oil seeps or unburned gasoline, while ratios greater than 0.10 indicates combustion processes 

(Yunker et al., 2002).  Fluoranthene to fluoranthene plus pyrene (Fl/Fl + Py) less than 0.40 

indicates petroleum, a value between 0.40 and 0.50 reflects liquid fossil fuels and ratios greater 

than 0.50 are characteristic of grass, wood or coal combustion.  Ratios of Benzo[a]anthracene to 

benzo[a]anthracene plus chrysene (BaA/228) tend to be less than 0.20 for petroleum sources, 

between 0.20 and 0.35 can indicate petroleum or combustion sources, and greater than 0.35 for 

combustion sources.  Values of the indeno[1,2,3-cd]pyrene to indeno[1,2,3-cd]pyrene plus 

benzo[ghi]perylene  (IP/IP + Bghi) ratio less than 0.20 are likely representative of petroleum 

whereas those values greater than 0.5 imply grass, wood and coal combustion, while those values 

in between 0.20 and 0.50 are characteristic of liquid fossil fuel combustion. 

 

Prior to ca. 1930 Avalon, Birch and Sand lakes showed a predominance of petroleum 

sources (Figure 4.3a-b & 4.3g); whereas, Crystal and Round (Figure 4.3c & 4.3f, respectively) 

lakes showed influence from combustion sources as indicated by the An/178 ratio.  Muskegon 

and Otter (Figure 4.3d & 4.3e, respectively) lakes show evidence of only combustion sources, 

likely due to the short time period covered by the sediment cores and industrial sources within 

proximity of these lakes.  The Fl/Fl+Py ratio reveals grass/wood/coal combustion for nearly all 



93 

 

sediment slices in all lakes except for Muskegon where fossil fuel combustion was found to be 

important prior to the early 1980s while afterwards a predominant source could not be identified.  

In Birch, Crystal, Round and Sand lakes the ratio of BaA/228 is lower at the base of the sediment 

cores, indicative of petroleum sources, then increases towards petroleum combustion ratios 

between 1880 and 1900 except for Sand Lake where the transition was later, ca. 1930.  

Conversely in Avalon Lake, the BaA/228 ratio suggests combustion sources throughout much of 

the core.  In Otter Lake a combustion source was identified for the entire core; whereas a mixture 

of petroleum and combustion sources were found for Muskegon Lake.  The sources indicated by 

the ratio of IP/IP+Bghi were mixed between grass/wood/coal combustion and fossil fuel 

combustion.  In Crystal, Round and Sand lakes the older portions of the core are characterized by 

grass/wood/coal combustion sources.  Round and Sand showed grass/wood/coal combustion 

important recently in contrast to Crystal which like Muskegon Lake was dominated by fossil fuel 

combustion.  Avalon and Birch lakes IP/IP+Bghi ratios varied between fossil fuel and 

grass/wood/coal combustion source.  Conversely, Otter Lake seems dominated by 

grass/wood/coal combustion.  
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Figure 4.3a. Selected ratios of PAH isomers in sediment of Avalon Lake.  Vertical lines 

represent specific PAH diagnostic ratios used to distinguish source, see text for specific 

examples. 
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Figure 4.3b. Selected ratios of PAH isomers in sediment of Birch Lake.  Vertical lines represent 

specific PAH diagnostic ratios used to distinguish source, see text for specific examples. 
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Figure 4.3c. Selected ratios of PAH isomers in sediment of Crystal Lake.  Vertical lines represent 

specific PAH diagnostic ratios used to distinguish source, see text for specific examples. 
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Figure 4.3d. Selected ratios of PAH isomers in sediment of Muskegon Lake.  Vertical lines 

represent specific PAH diagnostic ratios used to distinguish source, see text for specific 

examples. 
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Figure 4.3e. Selected ratios of PAH isomers in sediment of Otter Lake.  Vertical lines represent 

specific PAH diagnostic ratios used to distinguish source, see text for specific examples. 
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Figure 4.3f. Selected ratios of PAH isomers in sediment of Round Lake.  Vertical lines represent 

specific PAH diagnostic ratios used to distinguish source, see text for specific examples. 
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Figure 4.3g. Selected ratios of PAH isomers in sediment of Sand Lake.  Vertical lines represent 

specific PAH diagnostic ratios used to distinguish source, see text for specific examples. 
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In Avalon Lake the sediment ratios of Fl/Fl+Py and IP/IP+Bghi do not indicate the same 

source for PAHs.  The Fl/Fl+Py ratio can be interpreted as being from a combustion source 

which is consistent with the PAH profile plots that revealed the cement plant in Alpena as the 

most likely source for both Hg and PAHs.  The conflict then is likely a result of sources mixing.  

Flouranthene can be enriched in particulate transported long distances (Yunker and Macdonald, 

2003) resulting in the higher Fl/Fl+Py ratios observed in Avalon Lake while the more local 

source of IP would be from the combustion of fossil fuels, possibly the power generating station 

located due west of the lake (Figure 4.4) which combusts natural gas or local vehicle traffic.  The 

latter is unlikely however since this area of the State is lightly populated.  Although both natural 

gas combustion and cement production are sources of Hg it is likely that cement production 

would be more dominant in this case since the IP/IP+Bghi ratio hovers between fossil fuel and 

biomass combustion and the Fl/Fl+Py clearly indicates biomass combustion.  The cause for the 

decoupling of the Hg profile from that of the PAH profile is unclear.  Decreases in PAH could be 

a result of decreased demand for cement coupled with new sources of limestone or coal fly ash 

used in the production that had a higher Hg content resulting in further increases of Hg between 

1920 and 1980.   

 

The cause of concurrent peaks of Hg and PAHs in the sediments of Birch Lake in the 

1990s could not be clearly identified using indicator ratios or profile plots.  However, similar to 

Avalon Lake, PAH ratios do not indicate the same source.  The ratio of Fl/Fl+Py indicates a 

combustion source while that of IP/IP+Bghi varies between fossil fuel sources and biomass 

combustion.  The mixture of sources is confirmed by the BaA/228 ratios which transition from 

petroleum deep in the core towards combustion and petroleum sources coincident with the 
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stabilization of the Fl/Fl+Py and IP/IP+Bghi ratios.  Since Birch Lake is located in a highly 

agricultural landscape it is likely that the combustion source identified by the increased Fl is 

from the increased combustion of coal from the greater Chicago, IL/Gary, IN area.  The State 

Line Power Plant along the Indiana/Illinois border, to the southwest of Birch Lake, was built in 

the 1920s (Indiana, 2011) concurrent with the transition of the An/178 ratio from petroleum to 

combustion and a change in the rate of Hg increase.  During the peak of PAHs in the late 1980s 

into the 1990s mass group 202 and 252 are dominant consistent with results found for areas 

downwind of industrialized and urbanized areas (Yunker and MacDonald, 2003).   

 

In Crystal Lake between 1820 and 1880 the Fl/Fl+Py and IP/IP+Bghi ratios indicate 

biomass combustion, consistent with the burning and clearing of forest that occurred in this 

region (Long et al., 2010).  After about 1930, both of these indicator ratios become stabilized 

near the ratio discriminating between fossil fuel and biomass combustion.  This is likely the 

result of sources mixing since Crystal Lake is within close proximity of several natural gas 

consumers and immediately east of several coal fired power plants (Figure 4.4). 

 

Muskegon Lake is located within a large metropolitan area and has a coal fired power 

plant, along with other industrial activities, on its shoreline.  One might assume that the PAH 

diagnostic ratios would be dominated by a coal signal.  However, the Fl/Fl+Py and IP/IP+Bghi 

ratios both indicated fossil fuel combustion as the dominant source rather than coal.  Ratios 

indicating fossil fuel combustion could be due to a vehicular source which would be likely for 

this urbanized region; vehicle emissions were found to contribute just under 10% of PAH load to 

southern Lake Michigan (Simcik et al., 1999) but, it is unlikely that a vehicular source could 
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result in the concentrations of Hg in the lake sediments (Parsons et al., 2007).  Therefore, a 

potential source could be the natural gas and fuel oil electricity generating stations located in 

southeast Wisconsin, about 90 miles west and west-southwest of Muskegon Lake, for example 

the Milwaukee County Power Plant has burned natural gas or #2 fuel oil for electricity 

generation since 1970 (Resources, 2011). 
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Figure 4.4.  Industrial and utility energy emitters according to the 2002 Mercury Emissions 

Inventory for the State of Michigan. 
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The diagnostic ratios from Otter Lake reveal a dominant source for PAHs is from 

biomass combustion.  Mercury and PAHs concentrations are highly correlated suggest a 

common source for these contaminants; the proximity of Otter Lake to the coal fired power 

plants (Figure 4.4) combined with diagnostic ratio data could indicate a common source, the 

combustion of coal for power production. 

 

In Round Lake, ratios of Fl/Fl+Py and IP/IP+Bghi indicate a biomass combustion source 

throughout much of the core.  Combustion sources in this area would likely be limited to the 

burning of grasses and forests prior to 1900.  Round Lake, located in the middle of the Upper 

Peninsula, is not currently in close proximity to any industrial sources (Figure 4.4).  A major 

industrial activity in Upper Peninsula is mining; however, most historic mining related activities 

have been located to the northwest on the Keewenaw Peninsula.  The town of Fayette, 

approximately 80 km south of the lake, would have been the closest industrial source.   Located 

on the shores of Little Bay De Noc between 1867 and 1891, Fayette was a major iron ore smelter 

and used local timber to fuel the process (Michigan, 2011a).  The peak of Hg and PAHs occurred 

during the late 1920s into the 1930s, similar to Avalon Lake.  And much like Avalon the higher 

mass PAHs were predominant during the peak.  This would be consistent with a biomass 

combustion source (Yunker and Macdonald, 2003) during the industrial period of the town and 

until recent times.  Ratios tend to show biomass combustion after about 1900, which may be an 

indication of the mining related activities occurring in Michigan’s Upper Peninsula at the turn of 

the last century or the clearing of forests for agriculature or timber.  The Hg profile was similar 

to those of the PAHs until the peak and then became decoupled.  The decoupling occurs at the 

time of decline in the mining industry, due to the economic factors and maturity of the mines, in 
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the region.   Diagnostic ratios after the peak ca. 1920 are consistent with the combustion of 

biomass (e.g., coal) a likely source for Hg to Round Lake. 

 

Sand Lake is located near the City of Detroit.  Prior to 1900 Fl/Fl + Py and IP/IP + Bghi 

ratios in the sediment indicate biomass combustion, consistent with biomass burning during 

intense clear cutting of forests.  Mercury also shows an increase prior to 1900 which is likely due 

to the erodibility of forest cleared watersheds (Long et al., 2010).  After 1900, Hg and PAH start 

to increase which is most likely due to the the installation of the cement kiln in Cement City due 

west of Sand Lake (Figure 4.5).  The kiln was shut down in the early 1960s (Morrison, 1945).  

After ca. 1940, the ratios of Fl/Fl + Py and IP/IP + Bghi were consistent with a biomass 

combustion source.  The predominance of the mass group 202 after 1920 suggests burning of 

grass, hardwood and softwood; although it is usually accompanied by the mass group 178 (Fine 

et al., 2001, Jenkins et al., 1996, Masclet et al., 1995).  The presence of the mass group 202 may 

be related to the use of marl at the Cement City cement manufacturer, which would contain 

remnants of grasses and softwoods washed in from the marl source watershed.  The slope of Hg 

and PAH concentration profiles are similar between 1900 and 1950.  After 1950, concentrations 

of both contaminants continue to increase; however, Hg does so at a much higher rate.  This may 

be due to the decommissioning of the cement kiln and commissioning of 2 major coal-fired 

power plants to the east of Sand Lake in the City of Detroit.  The coincident peak and decline of 

Hg and PAH in the 1980s and 1990s implies a common source or influence and would be 

consistent with the implementation of abatement technologies required by the Clean Air Act. 
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Figure 4.5.  Current cement kilns in the State of Michigan.  The historic cement kiln located in 

Cement City, MI is not shown but would have been located approximately 20 km due west of 

Sand Lake.  
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Sediment chronologies of contaminants reflect activities within the watershed and 

atmospheric sources that could be located within or outside of the watershed.  This makes the 

identification of sources challenging since the concentration recorded in the sediment profile 

contains potential information from all sources.  Earlier research attempts to assign sources based 

on sediment chronologies have successfully used production and consumption records of 

contaminants (Engstrom and Swain, 1997, Lockhart et al., 2000).  This work compliments those 

studies and helps to confirm sources identified using production/consumption methods.  

Furthermore, this approach has demonstrated that sources for PAHs, both historic and modern, to 

inland lakes throughout the State of Michigan vary by region.  Assuming that PAHs and Hg 

share common sources and pathways, then identifying these local to regional scale sources has 

important implications for legislation seeking to limit the release of Hg to environment.  

Furthermore, some of the historic sources of Hg may have not been identified using traditional 

methods (e.g., cement kilns, Avalon and Sand lakes, and mining related activities, Round Lake).  

A modern coal combustion source was found to be significant for lakes in the southern portion of 

the State and in some cases can be correlated to plant start-ups.  A coal combustion source could 

not be identified for Muskegon Lake which has a coal-fired power plant on its shoreline, which 

provides further insight into the local scale transport of Hg.  This approach is limited; however, 

to the availability and quality of PAH data and can be enhanced by including those PAHs 

identified by others to have more discriminatory power (e.g., retene see (Yunker and Macdonald, 

2003)).   
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CHAPTER 5 

ASSESSING THE NATURAL RECOVERY OF A LAKE CONTAMINATED WITH HG 

USING ESTIMATED RECOVERY RATES DETERMINED BY SEDIMENT 

CHRONOLOGIES. 

 

Abstract 

Deer Lake is an impoundment located near Ishpeming, MI, USA.  Iron mining assay laboratories 

located in Ishpeming disposed of Hg salts to the city sewer whose outfall was located along an 

inlet to Deer Lake.  An effort to remediate the system in the mid 1980s which consisted of 

drawing down water in the impoundment in order to volatize Hg from the sediments did not 

result in recovery of the system.  Since the mid 1990s, the remediation strategy has been to allow 

the continual burial of the contaminated sediments, i.e., natural recovery.  The goal of this study 

was to assess the effectiveness of this strategy.  This was accomplished by investigating the state 

of the system in terms of its recovery and estimating the time frame for recovery.  Sediment 

cores were collected in 2000 to determine historical trends in accumulation rates and 

concentrations of Hg and other metals.  Sedimentation rates and sediment ages were estimated 

using 
210

Pb.  Event based dating (e.g., peak of 
137

Cs in 1963) was used to supplement 
210

Pb 

data due to non-monotonic features in the 
210

Pb profile and activities that were not at supported 

levels at the base of the core.  Selected results are that 1) drawdown significantly influenced 

sedimentation patterns causing slopes for 
210

Pb profiles that reflected the influx of older 

sediment, 2) periods of iron production correlate to Hg loading indicating the point source for 

contamination, a relationship not previously identified, 3) Hg:Al ratios indicate a recent change 

to a watershed pathway for Hg loading and 4) Hg concentrations had decreased from their peak, 

remain elevated, and were increasing after 1997.  The cause of the recent Hg concentrations may 

be related to influx of contaminated watershed soils or sediments.  Estimating the time frame for 
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recovery is challenging in this system because the process of natural recovery seems to have 

been arrested and deeper, uncontaminated sediments, were not recovered as a basis for reference.  

However, a recovery to background conditions is likely not achievable since rates of Hg loading 

to nearby lakes and the current rate of atmospheric deposition are greater than an estimate of 

background conditions for Deer Lake.  Assuming recovery continued after 2000, estimates of the 

time required for recovery varied based on the system state used to define it (e.g., recent rates of 

wet Hg deposition or Hg surface concentrations/fluxes from similar systems), but were less than 

12 y.  However, the recent increasing values of recovery indicators (e.g., Hg concentrations) 

suggests that these estimates are conservative and will be longer if recovery remains arrested, 

which may in part be due to the legacy of Hg contamination on the landscape.  This study shows 

that estimates of recovery of highly disturbed lake systems can be made in the absence of within 

lake reference conditions by using comparisons to reference systems and challenges of 

estimating ages from atypical 
210

Pb activity profiles can be overcome in part using event-based 

dating techniques. 

Introduction. 

Deer Lake is an impoundment located in the western Upper Peninsula of Michigan within 

the Marquette Iron Range (Figure 5.1).  An ecological assessment of the lake in 1979 determined 

that fish and sediments were contaminated with Hg (MDNR, 1987).  In 1981 a Michigan 

Department of Natural Resources (MDNR) fish survey determined that fish contained up to 1.38 

mg Hg/kg wet weight greatly exceeding the 1981 US average of 0.2 mg Hg/kg and the State of 

Michigan Fish Consumption Advisory level (MDNR, 1987).  Past gold and iron mining related 

activities were considered to have led to the contamination of the system (MDNR, 1987).  As a 

result of the widespread contamination and threats to ecosystem and human health, the Deer 
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Lake area, including a portion of the Carp River (Figure 5.1), was designated an Area of Concern 

(AOC) by the International Joint Commission in 1985  (USEPA, 2007b). 

 

The first steps in the remediation of Deer Lake consisted of lake-level drawdown, fish 

eradication, and then water level stabilization.  In the fall of 1984 Deer Lake was drawn down to 

its lowest level to facilitate Hg degassing from the sediments and to assist with fish eradication 

(D'Itri et al., 1992, USEPA, 2007b).  Fish eradication efforts included addition of a sharp grate 

on the dam exiting Deer Lake (killing any fish that might pass through), net-and-kill, and 

rotenone application; fish were not removed from the system.  Prior to 1984 lake levels in Deer 

Lake were allowed to fluctuate in order to control spring floods and flow through the Cliffs 

Electric Service Company hydroelectric dam.  Fluctuating lake levels might have led to 

increased rates of Hg methylation in the sediments (D'Itri et al., 1992).  Therefore, maintaining a 

constant water level was included as part of the remediation strategy.  In 1987 the lake was 

refilled and restocked with yellow perch and walleye.  It was thought that water level 

stabilization would reduce the potential for the sediments to act as a source of methyl-Hg to the 

water column, and reduce Hg burdens in fish.  However, in 1999 Hg burdens in large fish were 

still elevated with respect to other local lakes (USEPA, 2007b)   
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Figure 5.1. Deer Lake study area.  Expanded view shows an areal photograph of the study area 

clipped to the Deer Lake shoreline during the major drawdown.  Yellow circles indicate 

sampling locations.  Also shown are the approximate locations of the Rope’s Gold Mine, Carp 

River Dam and the City of Ishpeming WWTP Outfall. 
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Since initial remediation efforts failed, three alternative remediation strategies were 

proposed: 1) dredging to remove the most contaminated sediments, 2) installing a gel-cap to 

isolate the contaminated sediments from newly deposited sediments or 3) allowing new sediment 

to accumulate and bury the contaminated sediment (natural recovery).  To gain insight into the 

feasibility of natural recovery, sediment cores were taken from the lake to assess current 

conditions and if temporal trends of Hg loadings and concentrations indicated natural recovery.  

Natural recovery processes would be indicated by Hg loadings showing a decreasing trend.  If 

recovery is occurring then the time to recovery could be estimated as the time required for the 

surface sediments to have concentrations or fluxes similar to geochemical background.  In 

addition when the major pathway for contaminant is atmospheric transport as it is for Hg, then 

another indicator for the state of recovery would be current atmospheric deposition rates. 

 

History and Site Description 

A complete history of the Deer Lake AOC is described  in the 1987 Remedial Action 

Plan (RAP) available from the U.S. Environmental Protection Agency (USEPA) AOC website 

(USEPA, 2007a).  Key dates for this study are highlighted in Table 1.   

 

Deer Lake was directly impacted by two mining operations, the Rope’s Gold Mine 

(RGM) and Cleveland Cliffs Incorporated (CCI). The RGM operated on the western shore of 

Deer Lake from 1882-1899; Hg was used to amalgamate gold during this period.  Tailings piles 

from the mine still exist along the northwestern shoreline of Deer Lake (Figure 5.1); however, 

most of these tailings are covered by sediments or the road way that separates Causeway Pond 

from Deer Lake.  CCI operated iron mines in the region and maintained analytical laboratories in 
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the City of Ishpeming.  From 1929 to 1981 CCI used mercuric chloride to assay iron ore and 

discharged the wastes into the City of Ishpeming sewer system.  The sewer outfall for the City of 

Ishpeming was located on Carp Creek (Figure 5.1), approximately 1 km upstream of Deer Lake.  

CCI ceased this activity in 1981 after an ecological survey of the area determined that the 

sediments and fish of Deer Lake were contaminated with Hg.       

 

Deer Lake has undergone significant hydrologic changes over time.  Prior to the 

installation of a series of dams between 1912 and 1942 on the Carp River, Deer Lake was much 

smaller (36 ha) than present day (367 ha).  The first dam was installed by the RGM, near the 

present dam site, to satisfy water needs for the mining process.  The present dam was installed by 

the Cliffs Electric Service Company.  Between 1979 and 1984, the water level of Deer Lake was 

regulated for flood control of spring run-off and power generation, resulting in annual water 

level changes of approximately 2 m.  It has been estimated that 52% of Deer Lake sediments 

were exposed to the atmosphere during these annual water level fluctuations (MDNR, 1987). 

 

The City of Ishpeming waste water treatment plant (WWTP) prior to 1986 consisted of 

only primary treatment of the incoming waste stream and therefore did not remove dissolved 

heavy metals or nutrients (D'Itri, 2008).  Mercury wastes from CCI were in particulate form and 

did, for the most part, settle out during treatment; however, heavy rains would cause flooding of 

the treatment plant resulting in solid waste flowing into Carp Creek (D'Itri, 2008).  Excess 

nutrient load from the WWTP resulted in the eutrophication of Deer Lake with dissolved oxygen 

supersaturation of the epilimnion and hypolimentic anoxia (MDNR, 1987).  This has important 

implications for the cycling of Hg in the water column and sediments of the lake.  Methyl-Hg 
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production is favored and methyl-Hg bioaccumulation is significantly enhanced under anoxic 

conditions (Eckley et al., 2005, Munthe et al., 2007, Watras et al., 1994).  Therefore, 

anthropogenic eutrophication may have lead to the increased rate of Hg methylation in Deer 

Lake and consequently higher Hg burdens in fish.  A new WWTP, serving the City of 

Ishpeming, which has the capability of removing nitrogen and phosphorus, was put on-line in 

1986.  Reduced nutrient input should result in a reduced rate of eutrophication; this should also 

result in decreased rates of Hg methylation by reducing the periods of anoxia in bottom waters. 

 

Although it cannot be shown that the water level stabilization in Deer Lake resulted in 

reduced rates of Hg methylation, recent work has shown that methyl-Hg production may be 

enhanced during sediment resuspension (Sunderland et al., 2004, Tseng et al., 2001) and 

drying/re-wetting cycles (Rumbold and Fink, 2006).  The fluctuation in water level would also 

expose areas of the lake bottom to periods of higher energy regimes that would lead to 

movement of more sediment into depositional zones.  Under stable water level conditions these 

sediment would not otherwise be transported (Shotbolt et al., 2005).  Thus, higher energy 

regimes could result in the transport of Hg contaminated sediments from the littoral zone to the 

profundal zone in Deer Lake, increasing the burden of sediments exposed to anoxic bottom 

waters.  The increased mass of Hg-contaminated sediments exposed to anoxic bottom waters 

may have led to increased rates of methyl-Hg production and increased fish Hg burdens. 

 

Sampling and Analytical Methods 
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In the summer of 2000 sediment cores were retrieved from the deepest portion of the 

North and South basins of Deer Lake.  Aerial photography indicated these sites had remained 

under water during the major drawdown period (1984-1987).  Sediment cores were collected 

using an Ocean Instrument MC-400 Multicorer (www.oceaninstruments.com) deployed from the 

US EPA R/V Mudpuppy.  The MC-400 collects four simultaneous cores which were used for 

porewater metals analyses, radiometric dating, and sediment metals analyses; the fourth core was 

kept as an archive core.  Polypropylene jars and polyethylene bottles used to collect and/or store 

samples for trace metal analyses were thoroughly acid cleaned, using trace metal grades 

hydrochloric (HCl) and nitric (HNO3) acids, using one of three procedures:  1) cold-acid 

washing; cold 24hr 10% hydrochloric acid (HCl) cycle followed by a 24hr pure water (≥18 µS-

cm) rinse; 2) hot acid washing, hot 24hr 15% HCl cycle followed by a 24hr pure water rinse; 3) 

clean-acid washing, cold 24hr 1:1 HCl cycle followed by a hot 24hr 1:1 HNO3 cycle followed by 

a 24hr pure water rinse.  Cores intended for radiometric dating and sediment metals analyses 

were sectioned on-shore immediately after retrieval at 0.5 cm increments for the first 8 cm and at 

1 cm increments for the remainder of the core.  The effects of core smearing during extrusion 

were reduced by discarding those sediments in contact with the walls of the core tube (metals 

core only).  Sediment samples were placed in cold-acid-washed polypropylene jars and stored on 

ice until return to the laboratory.   

 

In the laboratory, sediment samples for elemental analysis were stored frozen until being 

freeze-dried prior to microwave-assisted nitric acid digestion using EPA Method 3051 (USEPA, 

2007c).  Samples for radiochemical dating were shipped to the Freshwater Institute, Winnipeg, 

Canada.  Reference material NIST 8704 Buffalo River Sediment (RM8704) and procedural 
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blanks were analyzed with each digestion batch.  Precision of the digestion procedure was 

evaluated with NIST RM8704, Buffalo River Sediment, %RSD for 10 replicates was 9.0% and 

6.0% for Al and Hg, respectively.  Concentrations of metals in procedural blanks were 

consistently lower than the quantification limit (MDL) of the analytical method (HgMDL = 1.27 

ng/mL, AlMDL = 91.93 ng/mL).  Digestates were diluted to 100 mL with pure water (≥18 µS-cm) 

prior to filtration with acid-cleaned, cold 10% HNO3 followed by a 24hr pure water rinse, 0.40 

µm Nucleopore filters.  Total metal and Hg samples were filtered into separate hot acid washed 

60 mL polyethylene bottles.  Samples for Hg analysis were preserved by adding 200 µL of a 100 

ppm gold chloride solution.  All samples were stored in the dark at 4ºC prior to analysis.  

Sediment iron and calcium concentrations were determined using atomic absorption 

spectrophotometry (Yohn et al., 2002).  All other sediment metal concentrations were 

determined using a Micromass Platform (now Thermo) ICP-MS with hexapole collision cell 

technology.  A 2% HNO3 rinse solution was used for all sediment metals analyses, except for Hg 

which used a 2.5% HNO3 + 2.5%HCl + 10 ppm gold chloride rinse solution. The HNO3/HCl + 

gold solution was used to prevent memory effects of Hg in the mass spectrometer (Allibone et 

al., 1999).   

 

The radionuclide 
210

Pb was used to determine sedimentation rates and assign dates to the 

sediment cores and cesium-137 (
137

Cs) was measured in select slices of sediment from the North 

Basin to determine the peak value in 
137

Cs activity.  Detailed methods of analysis for 
210

Pb and 

137
Cs can be found elsewhere (Wilkinson and Simpson, 2003).  Cs-137, was  determined by 

direct counting of 5-10 g of sediment on a γ-spectrometer (Ge-Li) semiconductor detector.  
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Samples of 1-3 g were analyzed for 
210

Pb and radium-226 by leaching in 6 N HCl in the 

presence of a 
209

Po tracer, autoplating Po onto a silver disk, and counting the disk on an α-

spectrometer to determine 
210

Pb via its 
210

Po daughter.  Sediment slice ages were estimated 

using the constant rate of supply (CRS) model (Appelby and Oldfield, 1978) or the regression 

equation of excess 
210

Pb activity versus total accumulated sediment dry mass using the constant 

flux:constant sedimentation (CF:CS) (Golden et al., 1993) and segmented CF:CS models 

(Heyvaert et al., 2000).   

 

Results and Discussion 

 

Effects of Lake Level Drawdown on 
210

Pb Profiles.  Vertical changes in the slope of excess 

210
Pb versus depth are used to identify changes in sedimentation rates caused by natural 

(Appleby et al., 1998) or anthropogenic processes (Heyvaert et al., 2000) and were used here to 

investigate the effects of the major drawdown period in the mid to late 1980s on sedimentation 

rates in Deer Lake.  Higher sedimentation rates are indicated by more vertical slopes of the 

excess 
210

Pb profile.  It was anticipated that during the drawdown period more material from the 

littoral areas would be focused into the deeper portions of the lake because of the increased 

energy regimes (Shotbolt et al., 2005).  Such focusing would be reflected by an increase in slope 

during the drawdown. 
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Vertical profiles of excess 
210

Pb activities, in general, increased to the surface in both 

sediment cores (Figure 5.2).  However, in the South Basin 
210

Pb activities increased until about 

17 cm depth.  Then between 17 and 10 cm there was a large deviation from the log-linear trend.   

 

Figure 5.2. Excess 
210

Pb profiles (solid circles) from the South and North Basins and the 
137

Cs 

profile (open circles) from the North Basin of Deer Lake.  Double arrows indicate the large 

deviation in the excess 
210

Pb profile; CRS model dates were assigned to the beginning and end 

of the large deviation for their associated mass depths. 
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Maximum 
210

Pb activity was at approximately 4 cm and then decreased towards the sediment-

water interface.  In the North Basin 
210

Pb activities generally increased until around 22 cm 

depth.  From 20 to 14 cm activities were lower and constant.  Above 14 cm 
210

Pb activities 

increased and peaked at 3 cm and then decreased to the surface.   

 

From our past work (Parsons et al., 2007, Yohn et al., 2004, Yohn et al., 2002) the 

CF:CS and CRS models were considered the most appropriate methods of estimating dates for 

sediment cores collected from inland lakes of Michigan.  The CF:CS model assumes a constant 

flux of 
210

Pb and a constant sedimentation rate and more appropriately models core profiles that 

exhibit a log-linear trend (Appleby et al., 1998, Robbins and Edgington, 1975).  The CRS model 

also assumes a constant flux of 
210

Pb to the sediment surface but allows for changes in 

sedimentation rate to account for the inventory of excess 
210

Pb activity, where the inventory is 

the product of sediment dry mass and excess 
210

Pb summed for the entire core.  This model 

would be useful for interpretations of small scale deviations in the 
210

Pb profile, such as those 

above 15 cm in the South Basin.  However, to calculate the CRS model unsupported 
210

Pb must 

reach 99% equilibrium with the supporting 
226

Ra which occurs in approximately 150 y (Appelby 

and Oldfield, 1978, Krishnaswamy et al., 1971, Robbins, 1978) which was not observed in either 

sediment core. 
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Cesium-137 is a radionuclide introduced to the environment during the atmospheric 

testing of nuclear weapons.  Testing of these weapons peaked in 1963 thus supplying a 

chronostratigraphic marker in lake sediments (for a review of chronostratigraphic markers see 

(Appleby, 2001)).  When the CF:CS model was used to estimate dates the peak in 
137

Cs activity 

from the North Basin core was assigned a date of 1956, almost a decade early.  Furthermore, the 

deviation in 
210

Pb activity at 22 cm depth, which we assume to be a result of lake level 

management or draw down occurred in 1973, five years before the active water level 

management of the lake.  It appears that the CF:CS model did not assign appropriate dates to 

these events, and it would be useful to date the core with an alternative method.  Since excess 

210
Pb was detected in the bottom slices of the South and North basin sediment cores use of the 

CRS model might be considered limited because the 
210

Pb inventory could not be calculated 

directly (Appelby and Oldfield, 1978).  However, in an effort to more appropriately reflect the 

changes in the trajectories observed in the excess 
210

Pb profile a modified approach to the CRS 

model was used.  First, activities of excess 
210

Pb for the North Basin were extrapolated to 

equilibrium with supported 
210

Pb.  Resultant dates were then adjusted by adding 
210

Pb 

inventory (less than 1%) to the last core sample so that the peak of 
137

Cs occurred in 1963.  

Using this approach the deviation in the 
210

Pb profile that occurred at 22 cm dated to 1978, the 

start of the active water level management period.  Activities of excess 
210

Pb between 20 and 14 

cm were constant indicating a zone where sediments have been mixed.  Both the modified CRS 
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approach and the CF:CS model assigned a date of 1987, the year the lake was refilled, to the 

upper portion of this zone. 

 

Since the CRS dates for the North Basin more appropriately reflected the period of active 

water level management period (1979-1984, Table 1) and the major drawdown and lake refilling 

(1984-1987, Table 1) a similar modified CRS model approach was used to assign dates to the 

South Basin core.  The South Basin core was not submitted for 
137

Cs analysis so the trajectory 

change in excess 
210

Pb at 17 cm was used to adjust dates with the assumption that the change 

occurred in the late 1970s or early 1980s coincident with the start of active water-level 

management of Deer Lake.  Similarly to the North Basin, excess 
210

Pb inventory (~1%) was 

added to the last core sample so that the 17 cm transition to lower 
210

Pb activities occurred in 

1981.  Doing so placed the upper limit of the mixing zone, at 10 cm, in 1988.  This is similar to 

the procedure used to correct for old date error (Binford, 1990).  The CF:CS model assigned 

dates of 1979 and 1993 to the 17 and 10 cm depths, respectively.  Although the former date 

appears to reflect the beginning of the water-level stabilization period the latter does not 

correspond to the refilling of Deer Lake as might be expected and found for the North Basin.  

Since the 
137

Cs profile could not be used to verify the dates assigned by the CRS model, the 

peak in stable Pb concentration was used to assess the accuracy of the assigned dates (Figure 5.3)  

Stable Pb concentrations in sediment cores should peak in the mid 1970s consistent with the 

removal of Pb from gasoline and this approach has been used to confirm sediment ages (Alfaro-

De la Torre and Tessier, 2002, Yohn et al., 2004, Yohn et al., 2002).  The Pb concentration 

profile from the South Basin had two peaks: the first in the early 1960s and the second in the 
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early 1970s using the CRS model (Figure 5.3).  The older peak had concentrations that were 

greater, but following the more recent peak concentrations steadily decreased.   We consider the 

latter peak, occurring in 1973 (1971 using the CF:CS model), followed by the decline to be 

indicative of the removal of leaded gasoline and therefore useful as a event-based dating tool.  In 

the North Basin the peak in Pb concentration occurred in the late 1970s (1974 using the CF:CS 

model) (Figure 5.3)  The  approach of using a modified CRS model resulted in a more 

appropriate reflection of age information obtained from the peak in stable Pb as well as events 

influencing sedimentation rates in Deer Lake.  Thus, the dates from the modified CRS approach 

will be used here.  
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Figure 5.3. Profiles of mercury (open markers) and lead (solid markers) normalized to their 

respective maximums to highlight similarities between the profiles. 

  

Trends of 
210

Pb activities that are steep or approaching vertical would be anticipated as a 

result of increased sediment fluxes and mixing during the draw down (e.g., (Appleby et al., 

1998, Robbins, 1982); however, the negative slopes were not.  Sediment dry mass was higher 

during this period consistent with an increased flux of sandy sediment from the littoral zones of 

the lake (Figure 5.4), evidenced by sediment color and texture change.  The negative slopes 

indicate that sediments were diluted with older (i.e., lower 
210

Pb activities) sediment.  Dates 

corresponding to the 17 and 22 cm depths were 1981 and 1978 in the South and North basins, 
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respectively, which is just prior to the active water level management period of Deer Lake (Table 

1).  It is highly probable that, during the water level management period and major drawdown, 

older sediment from shallower non-depositional zones of the lake as well as shoreline sediments 

were focused to the deeper areas where the samples were taken.  The prolonged exposure of 

lake-bottom sediments would 1) allow wind erosion of exposed sediments and 2) create zones of 

higher energy at lake locations that would otherwise be at lower energy regimes (Shotbolt et al., 

2005).  These processes could result in the transport of older sediment into the depositional zone 

diluting the activity of 
210

Pb.  Lead can be influenced by post depositional mobility (Benoit and 

Rozan, 2001); however, vertical patterns of 
210

Pb activities would not be expected if this 

processes were occurring and the correlation of 
210

Pb deviations with human activities provides 

strong evidence against the mobility of Pb in the sediment column.  



133 

 

 

Figure 5.4. Dry mass profiles from the South and North basins of Deer Lake.  Double arrows 

indicate the large deviation in the excess 
210

Pb profile; dates are assigned to the beginning and 

end of the large deviation for their associated mass depths.  

 

The peak in excess 
210

Pb activities occurred at about 4 and 3 cm depths in the South and 

North basins, respectively.  Near the surface 
210

Pb activity values are often homogenized 

because of biotubation and currents resulting in near vertical slopes (Robbins, 1982).  Again, the 

negative slopes imply that older sediment was deposited over and perhaps mixed with newer 

material.  However, lake levels have not been intentionally lowered as was interpreted to be the 

cause for the negative slopes down core.  Thus a possible explanation might be explained by 

drought conditions that existed in the study area during the 1990s. 
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The Palmer modified drought index (PMDI) indicated that there was a period of 

prolonged drought (PMDI < 0) between June 1997 and June 1999 (National Oceanic and 

Atmospheric Administration, 2007).  This was followed by a brief, four month, recovery (PMDI 

between 0 and 2) between July 1999 and October 1999.  Drought conditions then persisted until 

January 2001.  This prolonged drought may have resulted in lake level lowering and exposure of 

lake-bottom sediment and the influx of older sediment, similar to what may have occurred during 

the major draw down. 

 

Impact of mining activities on mercury concentration in Deer Lake.  In the South Basin, 

temporal changes in sediment Hg concentrations were more variable and concentrations higher 

than in the North Basin (Figure 5.5).  This is most likely due to the proximity of this basin to 

Carp Creek, the discharge location for the City of Ishpeming WWTP (Figure 5.1).  Recently, 

sediment Hg concentrations from both basins have remained constant albeit elevated above 

background concentrations from other Upper Peninsula of Michigan lakes (Parsons et al., 2007).  

Prior to this, in the South Basin, sediment Hg concentrations increased steadily from the late 

1920s until the mid 1940s, declined until the late 1950s, and then slowly increased until the mid 

1970s.  During the mid to late 1970s sediment Hg concentration increased, remained elevated 

and then rapidly declined until the early 1980s, consistent with the removal of the point source of 

Hg contamination.  Concentrations then increased until the late 1980s followed by decreased 

concentrations until the late 1990s.  In the North Basin, sediment Hg concentrations slowly 

declined from the 1950s until the mid 1960s, then increased until the early 1980s.  Since then, 
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sediment concentrations declined until the late 1990s. 

 

Figure 5.5. Hg concentration (mg/kg) profiles from the South and North basins of Deer Lake 

(open circles) and production of usable iron ore from Michigan (closed circles, metric 

ton(x1000)). 

 

Because of the  long history of base-metal mining in Michigan’s Upper Peninsula the 

impact of mining activities has been well documented (Kerfoot et al., 1999, Kerfoot et al., 2004, 

Kerfoot and Lauster, 1994, Kolak et al., 1998, Kolak et al., 1999) and although CCI was 

eventually found liable for the contamination of Deer Lake the RAP (MDNR, 1987) does not 

provide geochemical evidence to link CCI’s mining activities to Hg accumulation in Deer Lake. 

The role of the abandoned RGM, specifically the mine tailings on the northwestern shore of the 

lake, to mercury contamination has been unclear.  Since our sediment records can not provide 
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information about the potential contribution of the mine tailings to mercury contamination (i.e., 

do not contain sediment of adequate age), profiles of Hg concentrations were compared to 

production of iron ore from the Upper Peninsula of Michigan (USGS, 2009).  The assumption is 

that an estimate of CCI’s activities can be deduced from these production records.  In other 

words, when production of CCI was producing more iron they would in turn being assaying 

more iron resulting in an increased load of Hg to Deer Lake.  Therefore, if the sediment Hg 

profiles can be correlated to the production records of iron ore then this would tend to indicate 

CCI’s activities as the primary source of contamination  Deer Lake Hg concentration profiles and 

usable iron ore production from the Marquette Range of Michigan’s Upper Peninsula (1940-

2000) (USGS, 2009) are shown in Figure 5.5.  Production of iron ore from the State of Michigan 

was greatest in the 1940s, when iron was needed for wartime manufacturing, and 1970s, when 

monetary inflation and other economic forces created renewed interest in mining iron ore 

(Fenton, 1998).     

 

In the South Basin, sediment Hg concentrations exhibited high concentrations in the mid 

1940s coincident with higher iron production during the 1940s and Hg concentration generally 

tracks the production of iron ore between 1950 and 1980 (Pearson’s r = 0.59, p = 0.001) (Figure 

5.5) providing further evidence for a mining related source for the Hg contamination of Deer 

Lake.  Mercury concentrations and iron ore production appeared to be correlated after the early 

1980s to 1990, but their trends become decoupled after 1990.  In the North Basin, iron ore 

production and sediment Hg concentration did not correlate as well as in the South Basin 

between 1950 and 1980 (Pearson’s r = 0.52, p = 0.006) (Figure 5.5).  A general decrease in iron 

ore production corresponds to the decrease in Hg concentration between 1950 and 1965 and the 
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peak in Hg concentration in the late 1970s correlates with the peak in iron ore production during 

this period providing evidence for an iron-mining related source.  Mercury concentration and 

iron ore production become decoupled after ca. 1985, slightly earlier than what was observed in 

the South Basin but more consistent with the removal of the point source of Hg contamination.  

The smoother North Basin Hg concentration profile and poorer correlation to iron ore production 

are suggestive of a slow bleed of Hg contaminated sediments from the South Basin.  This 

evidence coupled with the decreasing concentrations of Hg after removal of the point source 

indicate that the Hg in the North Basin were also related to the CCI mining activities rather than 

contributions from the RGM mine tailings. The reason for the later decoupling in the South 

Basin is unclear, but may be related to watershed disturbance and is discussed below.   

 

The influence of watershed processes on mercury concentrations in Deer Lake.  If the City 

of Ishpeming sewer were the sole pathway of Hg to Deer Lake via Carp Creek then Hg 

concentrations should have decreased after CCI stopped the disposal of mercuric chloride into 

the sewer in 1981.  In both basins Hg concentrations clearly declined after 1981 (Figure 5.5); 

however, the decrease in the South Basin was rapid while in the North Basin more gradual.  The 

more rapid decline of Hg concentrations in the South Basin is likely due to the response of this 

basin to the removal of the point source and the proximity of this Basin to the WWTP discharge 

location.  The gradual decline observed in the North Basin could then be interpreted as a muted 

response to the point source removal combined with inter-basin mixing of contaminated 

sediments. 
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Since watershed soils are known to be significant sinks of metals (Mason and Sheu, 

2002), when disturbed by human activities or climatic changes they can be significant sources of 

metals to aquatic ecosystems.  Metal/aluminum concentration ratio and aluminum concentration 

profiles are often used to infer and quantify the contribution of chemicals derived from terrestrial 

material (i.e., watershed soils) into a lake (Bruland et al., 1974, Koelmans, 1998, Tuncer et al., 

2001, Yohn et al., 2002).  Ratios of Hg:Al were calculated for both basins and are shown in 

Figure 5.6 along with aluminum concentrations.  In the South Basin Al concentrations steadily 

decreased from the late 1920s until the early 1980s, increased rapidly until the late 1980s and 

have since decreased (Figure 5.6).  The Hg/Al ratio was relatively constant prior to 1935 then 

increased until the mid 1940s, decreased until the mid 1950s and generally increased again until 

the mid 1970s (Figure 5.6).  After the mid 1970s the ratio rapidly increases, peaking in the late 

1970s, then rapidly decreases until the mid 1980s.  Ratio values then generally decline until the 

mid 1990s and increase thereafter.  The above trends are interesting in that they can be 

interpreted to indicate two different pathways of Hg to the South Basin.  Between 1930 and the 

early 1980s the Hg/Al ratio and Al concentration profiles were not correlated, which clearly 

indicates a point source for Hg, i.e., mercuric chloride from CCI, to Deer Lake during this 

period.  During the major draw down period Al concentrations increased while the Hg/Al profile 

decreased suggesting a dilution of Hg concentration due to increased sediment focusing, which is 

the likely reason for the sharp decline in Hg concentrations at the beginning of the draw down 

(Figure 5.5).  After the late 1980s, about the time Deer Lake was refilled, and until the mid 1990s 

Al concentrations once again start to decline and appear coupled to the Hg/Al ratio which 

suggests a terrestrial pathway for Hg.  After 1995 the two profiles are again decoupled, 

indicating an additional source for Hg to the lake.   The profile of Pb was similar to that of Hg 
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between 1983 and 1995 suggesting a watershed pathway for Pb as well (Figure 5.3), the profiles 

prior the early 1980s were not as similar indicating unique sources for each chemical.  

 

Figure 5.6. Profiles of Al (open circles) and Hg:Al ratio (solid circles) for the South and North 

basins of Deer Lake. 

 

In the North Basin Al concentrations, in general, decreased between 1950 until 1970, 

increased until ca. 1983, decreased rapidly then slowly increased between 1983 and 1987 and 

had since been generally declining until the late 1990s (Figure 5.6).  The ratio of Hg/Al was 

relatively constant between the 1950s and mid 1960s, increased from 1965 until the early 1970s, 
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remained relatively constant or increased slowly until 1985, and had since declined.  The trends 

in Al and Hg:Al ratio of the North Basin differ from those of the South Basin.  The most 

apparent difference is the broad nature of the trends compared to the more abrupt changes 

observed in the South Basin.  The effects of the direct addition of mercuric chloride are most 

evident between 1965 and 1972.  From 1972 to 1985 both the Hg/Al ratios and Al concentrations 

were high which might indicate a contribution to Hg levels from South Basin contaminated 

sediment as well as direct inputs.  The correlated decrease in Hg/Al ratio and Al concentrations 

between 1985 and 1997 can be interpreted as burial of contaminated sediments by less 

contaminated sediment.  The profile of Pb in the North Basin was more similar to Hg than the 

South Basin throughout the entire sediment core.  This is indicative of the processes leading to 

deposition of chemical to the North Basin i.e., transport of sediment from the South Basin.  

 

These patterns are interpreted to indicate that the pathway for Hg has changed from being a point 

source to that of a terrestrial source (i.e., Hg laden soils/sediment from the watershed or Carp 

Creek sediments).  The possibility of the Carp Creek sediments as a source/pathway has 

important implications for the recovery of Deer Lake in that total recovery may not take place 

until the sediments of Carp Creek have been remediated.   

 

Estimating Recovery using Hg Accumulation Rates and Sediment Concentrations.  The 

recovery of a system is often defined as the condition when contaminant loading rates or 

concentrations reach a specified threshold or reference value (Magar, 2001).   Threshold values 

are concentrations or fluxes of contaminants to the environment usually defined by state and 

federal agencies as above which there are adverse effects on ecological and human health.  
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Because threshold values are defined independent of system processes, they cannot be used to 

indicate recovery of disturbed watershed-lake systems.  Reference values are estimates of the 

geochemical background flux or concentration of a contaminant prior to human perturbation.  

However, recovery to a reference value may not be achievable when current loading rates are 

greater than pre-disturbance conditions.  For example, 1999 wet deposition rates of Hg along the 

border between Wisconsin and Michigan’s Upper Peninsula varied between 9.0 and 13.3 µg Hg 

m
-2

 y
-1

 (Illinois State Water Survey, 2008) compared to the background flux of about 8.3  µg Hg 

m
-2

 y
-1

 for 5 Upper Peninsula lakes (Parsons et al., 2007).  Total deposition would be greater 

due to dry deposition of Hg (Lindberg et al., 2007) which can equal that of wet deposition for 

this region (Landis and Keeler, 2002).  A more reasonable recovery condition would then be that 

of similar systems, in this case surface concentrations/fluxes of nearby inland lakes or equal to 

the atmospheric deposition rate of a contaminant.  In this way the recovery of a system could 

then be defined as when the system comes into balance (steady-state and equilibrium processes) 

with current inputs (e.g., atmospheric and watershed inputs) (Long et al., 2010).   

 

To estimate the effects of the natural recovery remediation strategy for Deer Lake focusing 

corrected accumulation rates (FCAR) of Hg were calculated as: 

FF

ymgRateSedkgmgHg
ymgRateAccHg

)()(
)(

121
12

−−−
−− ×

=µ (1) 

where FF is the focusing factor and is calculated as the ratio of the actual 
210

Pb inventory to that 

which is expected and Sed Rate is the sedimentation rate calculated from the profiles of excess 

210
Pb.  The expected inventory of excess 

210
Pb for this region is 0.574 Bq cm

-1
 (Golden et al., 
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1993). Since neither core was deep enough to observe 
210

Pb equilibrium with 226-Radium, the 

excess 
210

Pb inventory was estimated by extrapolation (Parsons et al., 2007).  The FF’s were 

approximately 1.7 and 2.7 for the South and North basins, respectively and were similar to other 

Michigan lakes which range from 1 - 3 (Parsons et al., 2007, Yohn et al., 2004). 

 

On average, focusing corrected accumulation rates (FCAR) for Hg were higher in the South 

Basin than the North Basin (Figure 5.7) and are higher than other Upper Peninsula lakes (Parsons 

et al., 2007) consistent with the pollution history of Deer Lake.  Mercury FCAR showed only 

small changes in the North or South basin since 1997, and may have started to increase, 

suggesting that natural recovery had ceased.  Surficial FCAR were greater for the North Basin 

(1167 µg Hg m
-2 

y
-1

) than the South Basin (719 µg Hg m
-2 

y
-1

) and both are much higher than 

what would be expected for wet Hg deposition to this region (Illinois State Water Survey, 2008).  

The reasons for the cessation of recovery are unclear but may be due to watershed disturbance or 

leaching of Hg from the RGM tailings piles.  Surficial Hg FCAR for other Upper Peninsula lakes 

vary between 14 and 63 µg Hg m
-2 

y
-1

 (Parsons et al., 2007) and would be expected for Deer 

Lake in the absence of point-source Hg pollution.  To estimate the time required for surficial 

sediment Hg FCAR in Deer Lake to achieve a flux of 20 µg Hg m
-2 

y
-1

, the median surficial Hg 

flux for 5 Upper Peninsula lakes (Parsons et al., 2007), a linear regression was made on Hg 

FCAR starting in 1993 and 1991 in the South Basin and North Basin, respectively (Figure 5.8).  

These dates were chosen because they represent the most recent peaks or slope changes in Hg 

FCAR.  It is assumed here that the regions of relatively constant FCAR represent a brief period 

of arrested recovery and were not included in the regression and that the processes resulting in 
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clean sediment being deposited on top of the more contaminated sediment continue at the same 

rate.  Regression equations calculated from the FCAR profile were shifted to the most recent 

sediment slice to calculate a rate of recovery, that is, if recovery were to begin again how long 

would it take for fluxes/concentrations to be in the new system state. However, it is not certain if 

or when recovery will resume since the initial recovery was arrested, indicated by relatively 

constant or increasing FCAR since 1997 (Figure 5.8).  Results of this regression suggest that 

recovery in the South and North Basins would be approximately 3 and 7 years, respectively.  

Using the average of the 1999 wet deposition for the four Wisconsin and the northeast Minnesota 

Mercury Deposition Network sites (9.1 µg Hg/m
2
/y, Illinois State Water Survey, 2008), chosen 

for  their proximity to Deer Lake, as the system state the same results were found.  This indicates 

that the rate of recovery for Deer Lake is rapid and that natural recovery appears to be a proper 

remediation strategy for this system.  However, there is no guarantee that the loading of Hg to 

Deer Lake will remain constant and a longer term monitoring strategy should be adopted.   

 

Calculating fluxes of contaminants permits comparisons among lakes and comparisons to 

atmospheric deposition rates.  However, fluxes do not provide direct information about potential 

exposure of benthos to sediment contaminants.  The concentrations of Hg in the surficial 

sediments were about one order of magnitude greater than most Upper Peninsula lakes (Parsons 

et al., 2006).  Thus, it would be helpful to know when concentrations of Hg in the surficial 

sediment of Deer Lake would be more reflective of other Upper Peninsula lakes.  Similar to the 

flux regression analysis above, a linear regression on concentration was made to determine the 
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Figure 5.7. Focusing corrected Hg accumulation (µg/m2/y) rates for the South and North basins 

of Deer Lake. 
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Figure 5.8. Hg FCAR profiles for the South and North basins of Deer Lake, 1980 to present.  The 

dashed line shows the linear model used to determine the time to recovery, equations used are 

also shown.  The dash-dot-dash line shows the model applied to predict the year of recovery. 
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Figure 5.9. Hg concentration profiles for the South and North basins of Deer Lake, 1980 to 

present.  The dashed line shows the linear model used to determine the time to recovery, 

equations used are also shown.  The dash-dot-dash line shows the model applied to predict the 

year of recovery. 

 

time it would take for Deer Lake sediments to have Hg concentrations similar to surficial 

sediments of other Upper Peninsula lakes (Figure 5.9).  Assuming that sedimentation rates 

remained constant, to be similar to current Hg concentrations (0.16 mg Hg/kg; average of 5 

Upper Peninsula lakes (Parsons et al., 2007)) the South Basin would require at least 3 y, whereas 

the North Basin would require 12 y.  Again this analysis points out the connection between the 

two basins of the lake.  That is, the estimated recovery to current concentration, wet deposition 

and surficial fluxes were the same for the South Basin, while those recovery estimates for 
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concentration in the North Basin were longer than the other two system states.  This suggests that 

the recovery of the North Basin is coupled to the recovery of the South Basin due to the transport 

of sediment from the South to the North basin. 

 

Conclusions 

 

The goal of this study was to assess the state of recovery of a Hg contaminated lake in which 

remediation is through the natural burial of contaminated sediments.  The results revealed two 

previously undocumented assumptions 1) a correlation between iron ore production from the 

Marquette Range of Michigan’s Upper Peninsula and Hg concentrations in the profiles clearly 

demonstrates the influence of mining related activities on Deer Lake and 2) Al concentration and 

Hg:Al ratio profiles show a change in pathway for Hg from a point source to a non-point source 

(atmospheric deposition and watershed runoff)  with cessation of mining activities.     

  

This study also shows the challenges in interpreting the states of highly disturbed systems.  In 

this case, atypical 
210

Pb profiles and lack of within lake historic uncontaminated sediments 

posed challenges to age determination and a reference condition for recovery assessment 

comparison.  These problems were caused by human and climatically induced water-level 

fluctuations which introduced older sediments into the profundal areas of the lake and the depth 

of contaminated sediment.  Sedimentation rates and sediment ages were determined via 

modifications to the constant rate of supply (CRS) model, combined with event-based dating 

techniques.  Several definitions of system state (e.g., flux and concentrations) were used to 

estimate the time required for recovery.   
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Although recovery to background conditions is often one of the types of goals for a remediation 

program it could not be used here because current rates of atmospheric Hg deposition for the 

region are greater than an estimate of background conditions for Deer Lake.  Thus, Hg loadings 

can only recover to atmospheric loading rates.  Considering this and using the most recently 

measured surface sediment as a starting condition   once recovery begins, and remains 

uninterrupted, it will take between 3 and 7 y for the South and North Basin, respectively, for 

recovery  based on a flux reference and  3 y and 12 y, respectively, based on a concentrations 

reference.  However, the recently increasing values of recovery indicators (e.g., Hg 

concentration) suggest that these estimates are conservative and will be longer if recovery 

remains arrested.  This may be due in part to the legacy of Hg contamination on the landscape. 
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CHAPTER 6 

SUMMARY AND RECOMMENDATIONS 

 

Summary 

 

The working hypothesis of this research is: local scale sources and watershed scale 

processes have more impact on the rate of Hg accumulation in the aquatic environment than 

regional to global scale sources.  The hypothesis was investigated using the following 

approaches: 1) local scale sources are reflected in the sediment record as discontinuities in spatial 

scale analysis of anthropogenic inventories and Hg profiles should be unique to a lake or sub-

region, 2) watershed scale processes will impact the rate of modern recovery from Hg 

contamination and variations in the recovery rate between watersheds can be correlated to 

differences in watershed attributes and 3) diagnostic ratios of PAHs infer sources of Hg since 

they share a common source and pathway. 

Spatial analysis of anthropogenic inventories amongst Michigan inland lakes were 

indicative of a regional source for Hg assuming the inventories found for Lakes Michigan and 

Superior are representative of a regional source.  However, there were notable exceptions to this 

generalization, specifically lakes Houghton, Higgins, Gull.  Additionally, lakes that are in close 

proximity should have anthropogenic inventories that are similar if a regional source were 

present.  Elk and Torch and Higgins and Houghton share watershed boundaries, but have quite 

different anthropogenic inventories more consistent with watershed scale sources or processes.  

Inventories from Upper Peninsula lakes were consistent with those found for Lake Superior, but 

were varied suggesting the influence of watershed scale processes. 

In general anthropogenic accumulation of Hg in the study lakes first occurred in the late 

1800s consistent with the habitation of the lower Great Lakes region by European settlers.  

Increased anthropogenic accumulation continues until the middle or latter part of the previous 
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century.  Lakes from sub-regions of the study area had similar profiles of anthropogenic Hg 

accumulation suggesting sources that were common to these lakes.  Episodic accumulation 

events common among those lakes provide further evidence of more local scale processes.  

Recent trend analysis showed that several lakes had increasing Hg accumulation none of which 

were located near coal-fired power plants, a predominant source for Hg, providing further 

verification for local-scale or watershed process influence for these lakes. 

To examine the impacts of watershed attributes on the modern recovery of lakes from Hg 

contamination slopes of recent declines in Hg concentration and accumulation were calculated 

and compared to GIS delineated watershed attributes.  Strong correlations were found for 

agriculture, forest and wetland attributes.  However, those attributes along highly conductive 

flowpaths or within close proximity to the lake had the strongest relationships.  Though 

relationships between the accumulation of Hg to the environment and watershed attributes have 

been studied previously, the relationship between watershed attributes and dynamic flowpaths 

was unique to this study.  What may be a more important finding of this study is the lack of 

relationship between recovery rate and measures of atmospheric Hg such as sulfate deposition 

and Hg emissions.  This lack of relationship suggests that local scale sources and watershed 

processes determine the recovery of lakes from Hg enrichment rather than regional decreases in 

Hg emission.  However, the lack of relationship may also be related to “legacy Hg” deposited to 

the landscape and the lag time required for that Hg to reach the aquatic ecosystem. The 

implications of this are it is then those activities that disturb the landscape that control 

accumulation of Hg in inland lakes. 

Diagnostic ratios of PAHs can often be used to differentiate sources of these 

contaminants.  Mercury and PAHs share common sources and pathways allowing these 
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diagnostic ratios to infer sources of Hg to the environment.  Modern ratios of PAH showed that 

combustion sources predominate across the State.  The prevalence of combustion sources prior to 

1900 in Avalon and Round lakes may be indicative of early industrial activity near these lakes, 

i.e., cement manufacturing and iron smelting, respectively. Coincident with the ratios of An/178 

and Fl/Fl+Py a coal combustion source was potentially identified for Birch Lake, i.e., coal fired 

power plants in the Chicago/Gary industrial complex.  A coal combustion source was also 

presumed to cause the increase in Hg in Sand Lake, which was coincident with the 

commissioning of power plants in southeast Michigan.  In Muskegon Lake where a coal-fired 

power plant resides on the lakes’ shoreline no coal combustion source was identified.  Rather a 

source consistent with fossil fuels was observed.  This could have two explanations either a 

vehicular or natural gas power plant source.  The lake is in a highly urbanized area of the state 

and lies due east of a natural gas fired power plant in Wisconsin.  The latter is more likely due to 

the elevated Hg levels observed in the sediment of Muskegon Lake and the geochemical cycle of 

Hg.  Furthermore, the lack of evidence of a biomass combustion source may be indicative of the 

long range transport of Hg due to the height of power plant smokestacks.  Unlike Muskegon 

Lake, Otter Lake showed evidence of influence by biomass combustion throughout the entire 

core, likely coal fired power plants due to its proximity to power plants fired with coal to the 

north and east.  Crystal Lake showed a varied response between fossil fuel and biomass 

combustion, evidence of mixed sources to the lake. 

Burial in deep sediments is often the fate of Hg emitted to the environment.  This was the 

case for Deer Lake where Hg was used to assay iron ore in the Cleveland Cliffs Laboratory and 

dumped to the City of Ishpeming municipal sewer system.  Deer Lake became an Area of 

Concern when it was determined that fish in the lake had concentrations of mercury that 



157 

 

exceeded health limits along with other beneficial use impairments.  A high concentration of Hg 

in the sediments was suspected to be the primary cause of fish Hg.  When the original 

remediation attempt failed to lower fish tissue concentrations it was determined to allow the lake 

to recover naturally by the accumulation of clean sediments.   Although the point source had 

been removed Hg concentrations were still not reflective of a recovering system.  Using Hg:Al 

ratios it was determined that a watershed or erosional source for Hg could be an important 

contemporary source which could be contaminated sediments upstream or in the floodplain of 

the creek used for wastewater discharge.  Calculations based on the slope of modern 

concentrations and accumulation rates indicate a quick, ~10 y, recovery to those concentrations 

and accumulation rates of nearby Upper Peninsula lakes even though surficial concentrations are 

an order of magnitude greater than nearby lakes.  This has important implications for the use of 

natural recovery as a remediation strategy. 

This is the first research to show strong correlations between watershed attributes and the 

recovery of inland lake systems and the first to use ratios of PAHs to infer sources of Hg.  Much 

of the previous work investigating watershed attributes has focused on the impact of specific 

land cover types, investigated a narrow time period or used a limited number of lakes.  The high 

correlation between Hg recovery and watershed attributes gives promise to this approach when 

choosing sediment archives for contaminant trend monitoring.  It also has implications for 

watershed managers attempting to manage daily loads of contaminants to environmental 

systems.  Inferring source of Hg using PAHs showed great promise in the elucidation of source 

and source areas for these contaminants to the environment.  Though several studies have 

presented PAHs and heavy metal data, few have attempted to correlate the two measures of 
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environmental state.  The powerful potential insight into sources of Hg using diagnostic ratios of 

PAHs should not be overlooked in future Hg studies. 

Recommendations 

Below are suggestions for future work based on the outcome of this study. 

1) The statistical outcomes shown in Chapter 3 demonstrate the effectiveness of this 

approach; however, ground truth studies would be useful in determining the transport 

mechanics in these systems.  Highly dynamic flowpaths of a watershed can easily be 

determined using GIS techniques.  In depth mechanistic studies of Hg release and 

transport from these flowpaths should be identified. 

2) Apply the lake recovery models to more lakes.  Based on the results of Chapter 2 

there were a limited number of lakes that could be used to investigate the impact of 

watershed attributes on recovery.  The correlations should have widespread 

applicability and should be tested using a larger sample size of lakes and potentially a 

larger range of watershed attributes.  A larger sample size may also allow us of more 

powerful multivariate statistics. 

3) Increase the number of organic tracers measured in the sediment core.  The results of 

using diagnostic tracers of PAHs was effectively demonstrated, but could be made 

even more powerful by measuring those organics that are more discerning of source 

including: alkyl PAHs, simonellite and retene.  These organics have been used 

successfully to delineate combustion and vegetation sources of PAHs to the 

environment. 

4) Ground truth the relationship between PAHs and Hg, i.e., correlation is not causation.  

The high correlation observed between PAHs and Hg combined with knowledge of 
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their geochemical cycles provides confidence in stating that they share common 

sources and pathways to the environment.  However, a more detailed atmospheric 

based study of the relationship between these contaminants and their sources and 

pathways would provide further discriminating power to this approach. 

5) Extend the use of diagnostic PAHs and recovery models to other metals.  Mercury is 

not the only metal of concern in the Great Lakes region and with the vast body of data 

available the approach taken here for Hg could easily be extended to lead, and to a 

lesser extent zinc, cadmium and copper. 

6) Return to resample Deer Lake to evaluate the system state and verify predictions 

made based on the linear models of recovery. 

This research has many practical benefits that may extend beyond the research 

community.  The use of inland lake sediment chronologies to determine areas of 

increased contaminant loading in a region cannot be overstated.  They also provide 

important information regarding the potential for exposure to recreational users of the 

lake.  Atmospheric deposition monitors are expensive to maintain and require a long-term 

commitment for meaningful data. In addition, they do not incorporate information 

concerning the overland transport of contaminants.  Sediment chronologies provide a 

long term and relatively inexpensive method for determining system state; however, 

identifying the source or ratio of sources is difficult at best.  The potential of an organic 

tracer to help elucidate source is unique, but still may have difficulty determining 

proportions of mixed sources.  Watershed managers will find useful the contributions of 

dynamic flowpaths to Hg recovery since reduction of loads to aquatic systems is the goal 

of many of their programs.  The costs of remediating contaminated sediment systems can 
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often soar into the hundreds of millions of dollars.  A less costly alternative would be 

natural recovery if the system can be managed in such a way to the make the strategy 

feasible.  Here we have demonstrated how sediment chronologies can be used to monitor 

such a strategy. 

 The approach taken here has identified the importance of local sources and 

determined the watershed processes that impact Hg accumulation in inland lakes.  The 

techniques used here can easily be translated to other regions, that is to say, to the extent 

that a significant amount of lakes exist in the area to sample.  
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APPENDIX A. SEDIMENT CHEMICAL DATA 

 

 

 

 

Sediment concentration, 
210

Pb activities and dates, and core desciptions can be found in 

Michigan Department of Environmental Quality reports including: 

 

Cass, Gratiot, Gull, Elk and Higgins lakes: 

Simpson, S.J., Long, D.T., Geisy, J.P., and Fett, J.D., 2000.  Inland lakes sediment trends: 

sediment analysis results for five Michigan Lakes (MI/DEQ/SWQ-01/030), Department of 

Environmental Quality, Lansing, MI. 

http://www.michigan.gov/deq/0,1607,7-135-3313_3686_3728-32365--,00.html 

 

Crystal M and Littlefield lakes: 

Yohn, S.S., Long, D.T., Giesy, J.P., Fett, J.D., and Kannan, K., 2001.  Inland lakes sediment 

trends: sediment analysis results for two Michigan Lakes (MI/DEQ/WD-02/115), Department of 

Environment Quality, Lansing, MI. 

 

Cadillac, Crystal B, Mullett, Paw Paw, and Whitmore lakes: 

Yohn, S.S., Long, D.T., Giesy, J.P., Scholle, L.K., Patino, L.C., Fett, J.D., and Kannan, K., 2002.  

Inland lakes sediment trends: sediment analysis results for five Michigan Lakes (MI/DEQ/WD-

03/052).  Department of Environmental Quality, Lansing, MI. 

 

Houghton, Hubbard, Imp, Round, Torch and Witch lakes: 

Yohn, S.S., Parsons, M.J., Long, D.T., Giesy, J.P., Scholle, L.K., and Patino, L.C., 2003.  Inland 

lakes sediment trends: sediment analysis results for six Michigan lakes (MI/DEQ/WB-04/066).  

Department of Environmental Quality, Lansing, MI. 

 

Avalon, Birch, Muskegon, Sand and Shupac lakes: 

Parsons, M. J.; Yohn, S. S.; Long, D. T.; Giesy, J. P.; Bradley, P. W., 2004. Inland Lakes 

Sediment Trends: Sediment Analysis Results for Five Michigan Lakes (MI/DEQ/WB-06/003).  

Michigan Department of Environmental Quality: Lansing, MI. 

 

Crystal M04, George, Hackert, Otter and Round lakes: 

Parsons, M. J.; Yohn, S. S.; Long, D. T.; Giesy, J. P.; Patino, L.C., 2005. Inland Lakes Sediment 

Trends: Sediment Analysis Results for Five Michigan Lakes (MI/DEQ/WB-07/078).  Michigan 

Department of Environmental Quality: Lansing, MI. 

 

Mercury analysis for all lakes above: 

Parsons, M. J.; Yohn, S. S.; Long, D. T.; Patino, L. C.; Stone, K. A., 2006.  Inland Lakes 

Sediment Trends: Mercury Sediment Analysis Results for 27 Michigan Lakes (MI/DEQ/WB-

06/090). Michigan Department of Environmental Quality, Water Bureau: Lansing, MI. 

 

Charlevoix, Cadillac05, Gull05, Nichols, Campau, Muskegon06 and White lakes: 



164 

 

Parsons, M. J.; Yohn, S. S.; Long, D. T.; Giesy, J. P.; Patino, L.C., 2005. Inland Lakes Sediment 

Trends: Sediment Analysis Results for Seven Michigan Lakes (MI/DEQ/WB-09/069).  Michigan 

Department of Environmental Quality: Lansing, MI. 

 

 



 

165 

 

Table A1. 
210

Pb activities for Deer Lake South sediment core. 

SAMPLE  DRY ACCUMULATED POROSITY Thickness WATER Excess ACTIVITY ERROR 

  WT DRY WT       Pb-210  Pb-210 (+/- 1 SD) 

  (g) (gm./sq.cm.)   (cm) (%) (Bq/g) (Bq/g) (Bq/g) 

DEER1-1 0.44 0.0062 1.00 0.44 98.6 4.88E-01 5.28E-01 1.64E-02 

2 0.55 0.0140 0.99 0.32 97.6 5.73E-01 6.13E-01 1.64E-02 

3 0.78 0.0250 0.99 0.40 97.3 5.77E-01 6.17E-01 1.44E-02 

4 1.20 0.0419 0.99 0.52 96.8 6.28E-01 6.68E-01 1.22E-02 

5 1.34 0.0608 0.99 0.50 96.3 6.18E-01 6.58E-01 1.16E-02 

6 1.45 0.0813 0.98 0.46 95.6 7.13E-01 7.53E-01 1.36E-02 

7 1.98 0.1092 0.98 0.45 94.1 7.91E-01 8.31E-01 1.41E-02 

8 1.68 0.1329 0.98 0.40 94.2 8.44E-01 8.84E-01 1.63E-02 

9 2.44 0.1673 0.97 0.46 92.9 7.12E-01 7.52E-01 1.29E-02 

10 2.22 0.1986 0.98 0.44 93.2 7.14E-01 7.54E-01 1.47E-02 

11 2.55 0.2346 0.97 0.45 92.4 6.19E-01 6.59E-01 1.23E-02 

12 2.51 0.2700 0.97 0.42 92.0 5.54E-01 5.94E-01 1.05E-02 

13 2.83 0.3100 0.97 0.45 91.7 5.12E-01 5.52E-01 1.06E-02 

14 3.36 0.3574 0.97 0.51 91.2 4.87E-01 5.27E-01 9.55E-03 

15 3.47 0.4063 0.96 0.45 89.9 3.25E-01 3.65E-01 7.91E-03 

16 4.14 0.4647 0.95 0.42 87.4 2.61E-01 3.01E-01 7.25E-03 

17 8.95 0.5910 0.95 0.93 87.5 2.12E-01 2.52E-01 6.84E-03 

18 9.35 0.7229 0.95 0.91 86.8 1.80E-01 2.20E-01 6.05E-03 

19 8.68 0.8454 0.96 0.95 88.1 1.94E-01 2.34E-01 6.46E-03 

20 7.03 0.9446 0.96 0.93 90.1 1.91E-01 2.31E-01 5.24E-03 

21 9.77 1.0824 0.95 0.95 86.8 1.49E-01 1.89E-01 4.27E-03 

22 3.45 1.1311 0.98 0.92 94.9 2.71E-01 3.11E-01 6.72E-03 

23 2.69 1.1690 0.99 0.96 96.1 2.33E-01 2.73E-01 5.77E-03 

24 3.60 1.2198 0.98 0.91 94.6 2.45E-01 2.85E-01 7.13E-03 

25 3.99 1.2761 0.98 0.98 94.4 3.06E-01 3.46E-01 9.38E-03 
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Table A1 (cont’d) 

SAMPLE  DRY ACCUMULATED POROSITY Thickness WATER Excess ACTIVITY ERROR 

  WT DRY WT       Pb-210  Pb-210 (+/- 1 SD) 

  (g) (gm./sq.cm.)   (cm) (%) (Bq/g) (Bq/g) (Bq/g) 

26 4.62 1.3413 0.97 0.88 93.0 3.16E-01 3.56E-01 1.04E-02 

27 4.78 1.4087 0.97 0.92 93.0 3.29E-01 3.69E-01 9.00E-03 

28 4.57 1.4732 0.98 0.90 93.1 3.04E-01 3.44E-01 7.92E-03 

29 4.10 1.5310 0.98 0.86 93.6 2.99E-01 3.39E-01 8.55E-03 

30 4.07 1.5885 0.98 0.90 93.9 2.68E-01 3.08E-01 7.62E-03 

31 4.16 1.6472 0.98 0.84 93.3 2.48E-01 2.88E-01 7.22E-03 

32 4.02 1.7039 0.98 0.81 93.3 2.10E-01 2.50E-01 8.57E-03 

33 3.89 1.7587 0.98 0.82 93.6 2.17E-01 2.57E-01 7.03E-03 

34 4.20 1.8180 0.98 0.90 93.7 2.36E-01 2.76E-01 8.34E-03 

35 4.03 1.8749 0.98 0.85 93.6 2.25E-01 2.65E-01 7.19E-03 

36 4.30 1.9355 0.97 0.81 92.9 2.10E-01 2.50E-01 8.23E-03 

37 5.44 2.0123 0.97 0.87 91.6 1.89E-01 2.29E-01 7.74E-03 

38 5.72 2.0930 0.97 0.88 91.4 1.67E-01 2.07E-01 6.03E-03 

39 6.89 2.1902 0.96 0.91 90.0 1.69E-01 2.09E-01 6.70E-03 

40 6.19 2.2775 0.97 0.87 90.6 1.72E-01 2.12E-01   

41 5.99 2.3620 0.97 0.88 90.9 1.64E-01 2.04E-01   

42 5.97 2.4462 0.97 0.90 91.2 1.57E-01 1.97E-01   

43 7.47 2.5516 0.96 0.99 90.0 1.48E-01 1.88E-01   

44 7.27 2.6542 0.96 0.89 89.3 1.40E-01 1.80E-01   

45 6.95 2.7523 0.96 0.90 89.8 1.33E-01 1.73E-01   

46 6.11 2.8385 0.96 0.81 90.1 1.27E-01 1.67E-01   

47 6.29 2.9272 0.97 0.90 90.7 1.21E-01 1.61E-01   

48 5.33 3.0024 0.97 0.86 91.7 1.16E-01 1.56E-01   

49 7.51 3.1084 0.96 0.88 88.9 1.10E-01 1.50E-01   

50 7.29 3.2112 0.96 0.92 89.6 1.04E-01 1.44E-01   
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Table A1 (cont’d) 

SAMPLE  DRY ACCUMULATED POROSITY Thickness WATER Excess ACTIVITY ERROR 

  WT DRY WT       Pb-210  Pb-210 (+/- 1 SD) 

  (g) (gm./sq.cm.)   (cm) (%) (Bq/g) (Bq/g) (Bq/g) 

51 7.71 3.3200 0.96 0.91 88.9 9.81E-02 1.38E-01   

52 8.32 3.4374 0.96 0.91 88.1 9.21E-02 1.32E-01   

53 8.55 3.5580 0.95 0.86 87.1 8.64E-02 1.26E-01   

54 9.32 3.6895 0.95 0.91 86.7 8.05E-02 1.20E-01   

55 9.65 3.8256 0.95 0.90 86.3 7.48E-02 1.15E-01   

56 10.03 3.9671 0.95 0.91 85.9 6.93E-02 1.09E-01   

57 10.22 4.1113 0.94 0.90 85.4 6.42E-02 1.04E-01   

58 11.43 4.2726 0.94 0.93 84.5 5.42E-02 9.42E-02 2.88E-03 

59 12.37 4.4471 0.94 0.96 83.8 5.37E-02 9.37E-02 3.37E-03 
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Table A2. 
210

Pb activities for Deer Lake North sediment core. 

SAMPLE  DRY ACCUMULATED POROSITY Thickness WATER Excess ACTIVITY ERROR 

  WT DRY WT       Pb-210  Pb-210 (+/- 1 SD) 

  (g) (gm./sq.cm.)   (cm) (%) (Bq/g) (Bq/g) (Bq/g) 

DEER2-1 1.38 0.0195 0.99 0.60 96.8 4.88E-01 6.71E-01 1.38E-02 

2 1.69 0.0433 0.97 0.31 92.7 5.73E-01 7.26E-01 1.66E-02 

3 2.02 0.0718 0.98 0.40 93.3 5.77E-01 7.70E-01 1.65E-02 

4 2.18 0.1026 0.98 0.44 93.3 6.28E-01 8.05E-01 1.65E-02 

5 2.06 0.1316 0.97 0.40 93.1 6.18E-01 8.39E-01 1.35E-02 

6 2.30 0.1641 0.97 0.42 92.7 7.13E-01 8.82E-01 1.47E-02 

7 2.94 0.2056 0.97 0.56 92.9 7.91E-01 8.48E-01 1.48E-02 

8 1.88 0.2321 0.97 0.33 92.3 8.44E-01 8.16E-01 1.44E-02 

9 2.36 0.2654 0.97 0.37 91.5 7.12E-01 7.88E-01 1.46E-02 

10 1.90 0.2922 0.97 0.31 91.9 7.14E-01 7.09E-01 1.51E-02 

11 2.38 0.3258 0.97 0.35 91.1 6.19E-01 7.47E-01 1.43E-02 

12 2.45 0.3603 0.97 0.43 92.3 5.54E-01 6.95E-01 1.24E-02 

13 2.74 0.3990 0.97 0.47 92.1 5.12E-01 6.12E-01 1.17E-02 

14 2.69 0.4369 0.96 0.35 90.0 4.87E-01 5.65E-01 1.01E-02 

15 2.46 0.4716 0.97 0.34 90.5 3.25E-01 5.15E-01 9.49E-03 

16 2.77 0.5107 0.97 0.42 91.3 2.61E-01 4.99E-01 9.20E-03 

17 5.69 0.5910 0.97 0.86 91.2 2.12E-01 4.79E-01 1.19E-02 

18 5.78 0.6725 0.97 0.84 90.9 1.80E-01 4.36E-01 1.38E-02 

19 6.06 0.7580 0.97 0.87 90.7 1.94E-01 4.24E-01 1.15E-02 

20 5.96 0.8421 0.97 1.02 92.2 1.91E-01 3.70E-01 9.30E-03 

21 7.24 0.9443 0.96 0.88 89.2 1.49E-01 3.14E-01 6.58E-03 

22 7.66 1.0523 0.96 0.94 89.3 2.71E-01 2.83E-01 6.45E-03 

23 7.81 1.1625 0.96 0.97 89.4 2.33E-01 2.89E-01 6.64E-03 

24 7.34 1.2661 0.96 0.94 89.7 2.45E-01 2.83E-01 6.59E-03 

25 6.87 1.3630 0.96 0.89 89.8 3.06E-01 2.87E-01 5.87E-03 
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Table A2. (cont’d) 

SAMPLE  DRY ACCUMULATED POROSITY Thickness WATER Excess ACTIVITY ERROR 

  WT DRY WT       Pb-210  Pb-210 (+/- 1 SD) 

  (g) (gm./sq.cm.)   (cm) (%) (Bq/g) (Bq/g) (Bq/g) 

26 6.92 1.4606 0.96 0.88 89.7 3.16E-01 2.78E-01 6.02E-03 

27 7.17 1.5618 0.97 1.01 90.6 3.29E-01 2.88E-01 6.92E-03 

28 7.19 1.6632 0.96 0.94 89.9 3.04E-01 2.79E-01 6.23E-03 

29 7.55 1.7698 0.96 0.92 89.3 2.99E-01 3.00E-01 6.42E-03 

30 6.75 1.8650 0.97 0.97 90.8 2.68E-01 3.58E-01 7.52E-03 

31 5.68 1.9451 0.97 0.90 91.6 2.48E-01 3.58E-01 7.37E-03 

32 5.98 2.0295 0.97 0.97 91.8 2.10E-01 3.50E-01 7.36E-03 

34 5.53 2.1075 0.97 0.94 92.1 2.17E-01 3.39E-01 7.02E-03 

35 5.45 2.1844 0.97 0.94 92.3 2.36E-01 3.21E-01 7.24E-03 

36 5.60 2.2634 0.97 0.94 92.0 2.25E-01 3.04E-01 6.40E-03 

37 5.84 2.3458 0.97 0.88 91.2 2.10E-01 2.89E-01 6.13E-03 

38 6.73 2.4407 0.97 0.99 91.0 1.89E-01 2.93E-01 5.15E-03 

39 6.47 2.5320 0.97 0.94 90.8 1.67E-01 2.81E-01 5.14E-03 

40 6.37 2.6219 0.97 0.90 90.6 1.69E-01 2.64E-01 5.11E-03 

41 7.38 2.7260 0.96 1.00 90.2 1.72E-01 2.50E-01 4.82E-03 

42 6.42 2.8166 0.96 0.89 90.4 1.64E-01 2.43E-01 7.45E-03 

43 6.99 2.9152 0.96 0.96 90.4 1.57E-01 2.15E-01 6.63E-03 

44 6.82 3.0114 0.96 0.94 90.4 1.48E-01 1.81E-01 6.62E-03 

45 6.84 3.1079 0.97 0.96 90.5 1.40E-01 1.96E-01 6.63E-03 

46 5.79 3.1896 0.97 0.83 90.8 1.33E-01 1.78E-01 5.71E-03 

47 6.97 3.2880 0.97 0.98 90.6 1.27E-01 1.62E-01 5.56E-03 

48 6.35 3.3775 0.97 0.89 90.5 1.21E-01 1.77E-01 6.12E-03 

49 6.53 3.4697 0.96 0.90 90.4 1.16E-01 1.71E-01 5.67E-03 

50 6.82 3.5659 0.96 0.91 90.2 1.10E-01 1.77E-01 4.03E-03 

  



 

170 

 

Table A2. (cont’d) 

SAMPLE  DRY ACCUMULATED POROSITY Thickness WATER Excess ACTIVITY ERROR 

  WT DRY WT       Pb-210  Pb-210 (+/- 1 SD) 

  (g) (gm./sq.cm.)   (cm) (%) (Bq/g) (Bq/g) (Bq/g) 

51 6.53 3.6580 0.96 0.88 90.2 9.81E-02 1.94E-01 4.22E-03 

52 7.10 3.7582 0.96 0.90 89.6 9.21E-02 1.73E-01 4.43E-03 

53 8.14 3.8730 0.96 0.95 88.8 8.64E-02 1.52E-01 3.67E-03 

54 8.63 3.9948 0.95 0.87 87.1 8.05E-02 1.42E-01 3.33E-03 

55 9.17 4.1242 0.95 0.93 87.3 7.48E-02 1.41E-01 3.68E-03 

56 9.23 4.2544 0.95 0.91 86.9 6.93E-02 1.38E-01 3.45E-03 

57 9.33 4.3860 0.95 0.93 87.0 6.42E-02 1.27E-01 3.12E-03 

58 9.69 4.5227 0.95 0.93 86.6 5.42E-02 1.09E-01 3.91E-03 

59 9.25 4.6532 0.95 0.92 87.0 5.37E-02 1.10E-01 3.55E-03 
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Table A3. Metal concentrations for Deer Lake south core (mg/kg). 

Sample Depth Sc Ti V Cr Co Ni Cu As Mo Cd Pb 

Deer 1-1 0.5 2.19 161.03 27.71 36.96 7.04 29.11 151 31.85 1.66 1.03 46.67 

Deer 2-1 1.0 2.21 165.55 30.05 45.22 6.90 27.21 155 32.45 1.54 1.03 47.64 

Deer 3-1 1.5 2.10 131.55 27.36 42.00 7.92 29.52 110 34.52 2.08 0.95 45.77 

Deer 4-1 2.0 2.26 156.33 26.65 40.68 8.04 32.02 76 35.03 2.04 1.00 45.77 

Deer 5-1 2.5 2.57 51.43 30.89 47.88 8.50 32.23 68 33.06 1.90 1.01 50.89 

Deer 6-1 3.0 2.43 33.28 30.66 45.53 9.59 33.48 54 39.92 2.16 0.93 46.02 

Deer 7-1 3.5 2.93 41.14 35.42 53.98 9.86 36.06 74 41.61 1.81 1.06 49.30 

Deer 8-1 4.0 3.36 37.85 39.11 64.73 11.48 43.39 79 33.54 2.14 1.37 57.68 

Deer 9-1 4.5 3.23 26.30 37.14 64.06 11.92 44.40 59 35.94 2.97 1.24 62.95 

Deer 10-1 5.0 3.13 24.92 35.93 60.41 10.43 41.48 64 37.60 2.99 1.26 63.52 

Deer 11-1 5.5 3.18 47.08 36.96 62.73 9.67 36.88 66 38.82 2.94 1.51 80.29 

Deer 12-1 6.0 3.01 38.57 36.11 56.76 9.75 31.43 220 36.64 2.89 1.43 84.26 

Deer 13-1 6.5 3.14 28.35 37.45 60.73 10.20 32.30 48 36.11 2.83 1.77 96.58 

Deer 14-1 7.0 3.07 29.06 35.24 58.71 11.10 32.99 76 43.29 3.64 2.11 97.51 

Deer 15-1 7.5 3.94 55.46 41.69 74.88 12.29 41.82 78 40.51 3.17 2.61 123.88 

Deer 16-1 8.0 3.22 226.63 32.99 60.56 9.20 30.73 87 28.43 2.02 2.35 103.11 

Deer 17-1 9.0 3.45 235.10 34.85 68.37 9.64 32.90 117 27.10 1.98 2.43 106.32 

Deer 18-1 10.0 3.72 251.76 36.30 71.15 9.83 35.07 104 26.92 1.76 2.53 131.30 

Deer 19-1 11.0 3.25 184.31 34.15 72.99 8.92 31.28 86 24.25 1.96 2.14 123.37 

Deer 20-1 12.0 2.65 158.05 28.69 49.88 6.94 24.67 79 16.68 1.74 1.65 96.34 

Deer 21-1 13.0 2.71 170.00 28.47 55.06 6.55 24.67 161 21.14 2.57 1.86 103.96 

Deer 22-1 14.0 2.21 169.31 21.37 42.90 5.36 21.85 77 21.76 3.70 1.32 79.96 

Deer 23-1 15.0 2.18 131.25 20.96 43.16 4.82 21.68 103 23.70 3.95 1.58 83.08 

Deer 24-1 16.0 2.09 130.39 21.09 46.33 5.26 20.88 114 24.74 3.76 1.65 91.66 

Deer 25-1 17.0 2.41 141.63 23.44 57.03 5.72 21.27 156 27.96 4.60 2.30 117.50 
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Table A3. (cont’d) 

Sample Depth Sc Ti V Cr Co Ni Cu As Mo Cd Pb 

Deer 26-1 18.0 2.37 138.38 23.83 54.50 5.88 21.54 149 25.62 4.20 2.33 129.76 

Deer 27-1 19.0 2.29 141.41 22.29 54.55 5.94 20.89 120 22.86 4.29 2.21 133.00 

Deer 28-1 20.0 2.56 165.85 22.79 56.20 6.28 22.54 126 23.51 6.47 2.60 148.91 

Deer 29-1 21.0 2.46 55.95 23.36 55.44 6.26 24.47 38 17.17 7.15 2.61 166.19 

Deer 30-1 22.0 2.38 213.98 23.16 53.03 6.04 21.98 157 23.62 4.11 2.36 158.17 

Deer 31-1 23.0 2.54 209.94 25.48 57.62 5.82 24.14 199 25.08 3.88 2.48 180.90 

Deer 32-1 24.0 2.28 190.86 22.46 61.65 5.01 19.67 167 23.54 3.63 2.48 172.28 

Deer 33-1 25.0 2.56 64.13 24.78 76.24 7.70 26.65 45 20.98 4.96 2.72 189.76 

Deer 34-1 26.0 2.22 161.77 21.18 70.55 5.49 19.56 108 22.26 2.72 2.36 158.63 

Deer 35-1 27.0 2.63 182.13 25.76 121.67 7.31 24.50 181 26.47 3.82 3.03 176.04 

Deer 36-1 28.0 2.48 163.73 25.42 119.79 8.23 23.06 168 22.58 3.02 2.60 155.10 

Deer 37-1 29.0 2.53 156.32 26.26 101.81 8.56 23.91 155 23.25 3.50 2.80 167.28 

Deer 38-1 30.0 2.52 155.26 24.85 79.73 8.19 21.15 141 20.02 3.77 2.74 160.25 

Deer 39-1 31.0 2.76 194.58 27.00 98.35 8.31 23.42 112 18.67 3.57 2.53 172.11 

Deer 40-1 32.0 2.54 70.51 25.42 70.81 8.56 17.86 90 19.83 4.09 2.71 229.96 

Deer 41-1 33.0 2.70 39.10 28.62 54.49 9.71 19.64 99 18.89 2.62 2.43 200.27 

Deer 42-1 34.0 2.39 55.34 25.84 50.27 8.77 15.93 103 17.65 2.47 2.24 183.45 

Deer 43-1 35.0 3.04 81.90 30.73 54.15 10.00 30.49 207 24.92 2.77 2.15 177.87 

Deer 44-1 36.0 2.91 40.39 29.44 50.27 9.71 28.89 170 23.53 3.01 2.06 178.14 

Deer 45-1 37.0 2.77 100.22 28.02 47.76 9.44 27.62 120 22.30 3.35 2.00 159.60 

Deer 46-1 38.0 2.78 199.46 28.70 48.83 9.54 29.75 158 20.86 2.74 2.26 155.48 

Deer 47-1 39.0 3.21 68.08 32.44 57.67 11.28 33.74 103 20.04 4.27 2.14 174.71 

Deer 48-1 40.0 3.20 85.72 32.77 57.97 11.37 33.61 98 20.57 6.19 2.23 164.61 

Deer 49-1 41.0 3.10 95.19 32.70 52.21 11.23 32.43 103 22.56 5.83 2.09 146.60 

Deer 50-1 42.0 3.37 173.52 35.78 53.96 11.89 35.36 116 23.35 4.66 2.03 131.89 
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Table A3. (cont’d) 

Sample Depth Sc Ti V Cr Co Ni Cu As Mo Cd Pb 

Deer 51-1 43.0 3.28 181.19 34.43 52.06 11.82 35.32 90 25.67 4.15 2.15 126.03 

Deer 52-1 44.0 3.22 199.47 34.84 51.35 11.41 33.55 104 24.57 3.53 2.12 120.12 

Deer 53-1 45.0 3.37 200.77 35.68 50.47 11.87 34.20 116 25.03 2.82 2.13 114.52 

Deer 54-1 46.0 3.56 242.82 38.51 52.82 12.49 36.48 134 26.58 2.97 2.27 118.71 

Deer 55-1 47.0 3.28 246.18 35.80 46.53 11.60 33.56 103 25.97 2.81 2.29 111.10 

Deer 56-1 48.0 3.33 215.27 35.55 46.81 11.47 49.88 100 25.30 2.48 1.99 107.23 

  



 

174 

 

Table A3. (cont’d) 

Sample Depth Al Zn Se Sr Mg K Mn Ba U Fe Ca Hg 

Deer 1-1 0.5 6686 172 3.08 40.18 3344 1065 3098 337 2.23 554 185 2.05 

Deer 2-1 1.0 6828 168 3.25 41.20 3280 857 3603 415 2.28 601 226 2.28 

Deer 3-1 1.5 6357 160 2.98 36.47 3165 837 3110 297 2.18 547 210 2.18 

Deer 4-1 2.0 6873 175 3.15 33.79 3350 845 2570 225 2.14 533 203 1.90 

Deer 5-1 2.5 7838 197 3.26 35.69 3839 856 2601 152 2.36 618 239 1.96 

Deer 6-1 3.0 7652 187 3.17 34.23 3598 717 2728 85 2.39 613 228 1.88 

Deer 7-1 3.5 8690 218 3.17 34.26 4396 765 3187 136 2.75 708 270 1.75 

Deer 8-1 4.0 10612 251 3.07 36.08 5433 931 2994 121 2.94 782 324 1.84 

Deer 9-1 4.5 10124 251 3.23 37.95 4903 929 2840 93 2.61 743 320 2.26 

Deer 10-1 5.0 9651 240 3.07 38.01 4704 955 2633 87 2.54 719 302 2.38 

Deer 11-1 5.5 10553 282 3.27 39.04 4555 861 2451 136 2.71 739 314 4.20 

Deer 12-1 6.0 10921 267 3.20 39.57 4238 763 2320 129 2.56 722 284 4.86 

Deer 13-1 6.5 10957 319 3.03 40.26 4701 871 2435 97 2.73 749 304 5.60 

Deer 14-1 7.0 11140 406 3.35 43.66 4735 824 2233 98 2.70 705 294 6.52 

Deer 15-1 7.5 14544 471 3.53 53.62 6421 1104 2017 170 2.70 834 374 8.09 

Deer 16-1 8.0 12392 342 2.70 43.10 5616 796 1386 210 2.13 660 303 7.87 

Deer 17-1 9.0 13376 358 2.81 49.11 5997 845 1338 281 2.23 697 342 8.02 

Deer 18-1 10.0 18516 370 2.96 48.36 6102 968 1640 261 2.16 726 356 10.09 

Deer 19-1 11.0 12592 323 2.99 48.38 5787 711 1454 244 2.34 683 365 9.26 

Deer 20-1 12.0 10142 237 1.99 40.34 5480 567 1228 223 2.22 574 249 5.77 

Deer 21-1 13.0 11169 249 3.31 61.65 4968 606 1700 358 2.20 569 275 6.90 

Deer 22-1 14.0 7797 184 3.30 75.52 3762 581 1091 280 1.79 427 215 5.52 

Deer 23-1 15.0 7388 232 3.83 63.37 3212 490 1307 301 2.43 419 216 4.93 

Deer 24-1 16.0 7582 233 3.86 64.36 3110 469 1135 348 2.81 422 232 8.03 

Deer 25-1 17.0 8007 290 4.24 65.81 3339 499 1426 411 3.55 469 285 15.78 
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Table A3. (cont’d) 

Sample Depth Al Zn Se Sr Mg K Mn Ba U Fe Ca Hg 

Deer 26-1 18.0 8247 300 4.42 66.51 3376 501 1185 416 3.51 477 273 25.50 

Deer 27-1 19.0 7536 267 4.27 65.73 3276 481 781 373 3.12 446 273 24.89 

Deer 28-1 20.0 8105 317 5.39 72.31 3712 543 791 380 3.45 456 281 25.35 

Deer 29-1 21.0 8308 405 4.98 64.32 3622 712 798 50 4.67 467 277 24.34 

Deer 30-1 22.0 7942 310 5.79 70.21 3419 632 857 395 3.98 463 265 11.87 

Deer 31-1 23.0 8728 334 3.56 77.84 3930 663 1040 472 3.90 510 288 11.86 

Deer 32-1 24.0 8014 331 3.12 77.43 3433 599 971 453 3.73 449 308 13.58 

Deer 33-1 25.0 9011 427 2.85 81.61 4178 686 1002 64 4.13 496 381 15.96 

Deer 34-1 26.0 7300 299 3.00 67.72 3549 494 1077 349 4.24 424 353 11.62 

Deer 35-1 27.0 8946 447 3.76 75.14 4623 599 1563 398 4.36 515 608 13.23 

Deer 36-1 28.0 9277 415 3.65 70.23 4765 594 2212 405 4.33 508 599 11.40 

Deer 37-1 29.0 9175 376 4.49 73.77 4872 578 2246 409 4.63 525 509 13.13 

Deer 38-1 30.0 8955 331 4.19 67.90 5166 628 1592 380 4.45 497 399 12.56 

Deer 39-1 31.0 9678 394 4.13 65.15 6106 759 1352 351 4.33 540 492 10.30 

Deer 40-1 32.0 9087 383 5.55 71.08 4771 676 1945 300 5.19 508 354 13.33 

Deer 41-1 33.0 10406 349 4.40 68.60 4899 775 2050 252 4.82 572 272 12.66 

Deer 42-1 34.0 9403 320 4.35 63.35 4438 669 1880 271 4.39 517 251 10.98 

Deer 43-1 35.0 11060 348 4.39 73.89 5064 1394 2423 319 5.69 615 271 9.60 

Deer 44-1 36.0 10145 358 4.10 78.83 5040 1259 2642 308 5.51 589 251 11.92 

Deer 45-1 37.0 10177 359 4.77 74.91 5203 1256 1868 274 4.69 560 239 14.09 

Deer 46-1 38.0 10561 437 3.77 76.23 5501 1238 1916 305 4.29 574 244 14.00 

Deer 47-1 39.0 12086 428 4.03 75.71 6583 1312 1892 179 4.58 649 288 17.31 

Deer 48-1 40.0 12329 435 4.51 75.45 6632 1373 1655 118 4.55 655 290 18.71 

Deer 49-1 41.0 11658 407 3.62 72.58 6597 1280 1866 127 4.33 654 261 19.72 

Deer 50-1 42.0 12911 377 3.79 71.36 7434 1451 1822 197 3.96 716 270 18.62 
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Table A3. (cont’d) 

Sample Depth Al Zn Se Sr Mg K Mn Ba U Fe Ca Hg 

Deer 51-1 43.0 12833 382 3.28 75.22 6763 1289 1687 224 3.79 689 260 19.21 

Deer 52-1 44.0 12461 349 3.20 71.90 6152 1239 1774 221 3.29 697 257 18.31 

Deer 53-1 45.0 13160 347 3.18 70.08 6307 1294 1985 232 3.00 714 252 17.63 

Deer 54-1 46.0 13791 364 3.19 72.72 6870 1311 1994 233 2.74 770 264 16.73 

Deer 55-1 47.0 12928 393 2.81 63.74 6339 1168 1883 202 2.35 716 233 15.39 

Deer 56-1 48.0 13024 384 2.62 62.68 5804 1151 1721 183 2.27 711 234 15.25 
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Table A4. Metal concentrations for Deer Lake north core (mg/kg). 

Sample Depth Sc Ti V Cr Co Ni Cu As Mo Cd Pb 

Deer 1-2 0.5 2.68 232.1 35.57 62.07 14.55 68.27 0.00 23.52 2.52 1.73 58.93 

Deer 2-2 1.0 2.55 230.9 34.81 59.88 14.44 65.01 0.00 24.11 2.42 1.73 55.34 

Deer 3-2 1.5 2.34 223.6 32.03 54.13 13.22 59.78 0.00 20.33 2.04 1.56 51.13 

Deer 4-2 2.0 2.29 205.4 31.74 54.68 12.23 59.78 0.00 17.85 1.84 1.55 51.21 

Deer 5-2 2.5 2.43 203.9 33.37 55.67 13.30 63.65 0.00 18.27 2.24 1.49 52.30 

Deer 6-2 3.0 2.51 226.7 34.38 59.59 13.88 65.17 0.00 18.76 2.32 1.54 54.32 

Deer 7-2 3.5 2.58 229.6 34.16 58.64 14.40 66.84 0.00 20.14 2.54 1.68 56.17 

Deer 8-2 4.0 2.54 210.7 32.58 56.06 13.32 61.39 0.00 19.46 2.25 1.59 55.75 

Deer 9-2 4.5 2.50 217.0 32.37 58.38 13.85 64.24 0.00 20.46 2.62 1.71 58.34 

Deer 10-2 5.0 2.54 207.7 32.72 61.47 15.89 68.38 0.00 24.21 3.15 1.82 63.68 

Deer 11-2 5.5 2.58 218.0 31.77 55.24 15.78 67.78 0.00 24.29 3.31 1.85 66.12 

Deer 12-2 6.0 2.49 198.4 30.92 58.41 16.71 64.73 0.00 24.96 3.31 1.98 68.06 

Deer 13-2 6.5 2.52 222.2 31.31 57.69 16.80 64.81 0.00 26.00 3.52 2.11 70.07 

Deer 14-2 7.0 2.41 195.9 30.22 53.74 17.07 62.48 0.00 26.87 3.59 2.09 70.26 

Deer 15-2 7.5 2.48 200.1 31.01 55.13 18.63 66.48 0.00 29.17 3.85 2.24 75.32 

Deer 16-2 8.0 2.56 217.0 30.85 56.33 18.69 69.56 0.00 29.98 3.94 2.23 75.67 

Deer 17-2 9.0 2.52 196.7 30.45 55.54 19.92 66.25 0.00 30.79 3.92 2.34 75.57 

Deer 18-2 10.0 2.46 206.3 30.20 55.58 19.84 69.65 0.00 30.39 3.95 2.28 74.62 

Deer 19-2 11.0 2.56 228.5 31.17 54.34 20.72 63.65 0.00 31.74 3.95 2.30 75.64 

Deer 20-2 12.0 2.63 230.4 30.84 57.17 19.62 65.30 0.00 30.36 3.96 2.27 77.17 

Deer 21-2 13.0 2.73 257.5 32.12 60.00 18.23 63.87 0.00 29.71 4.06 2.13 78.87 

Deer 22-2 14.0 2.73 259.2 31.40 60.36 14.19 59.41 0.00 26.34 4.23 1.99 80.55 

Deer 23-2 15.0 2.70 252.0 31.95 62.74 12.15 59.46 0.00 23.14 4.35 1.77 81.77 

Deer 24-2 16.0 2.51 214.3 29.64 57.92 10.71 56.88 0.00 21.78 4.09 1.70 81.01 

Deer 25-2 17.0 3.16 254.3 36.70 73.96 12.60 71.37 0.00 24.87 5.29 2.15 104.27 
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Table A4. (cont’d) 

Sample Depth Sc Ti V Cr Co Ni Cu As Mo Cd Pb 

Deer 26-2 18.0 2.62 229.2 31.18 58.76 10.51 58.54 0.00 19.96 4.38 1.83 86.98 

Deer 27-2 19.0 2.83 232.1 31.16 62.25 11.09 65.35 74.98 21.98 4.21 1.86 86.74 

Deer 28-2 20.0 2.41 203.6 29.84 53.27 10.73 59.45 45.18 22.45 3.88 1.67 74.76 

Deer 29-2 21.0 2.73 238.1 30.99 64.67 9.34 61.72 56.71 20.60 4.42 1.72 88.26 

Deer 30-2 22.0 2.72 246.5 30.33 59.64 9.12 61.05 53.71 19.94 4.28 1.63 87.42 

Deer 31-2 23.0 2.67 274.0 30.92 56.25 9.12 61.93 55.08 19.64 4.08 1.61 83.09 

Deer 32-2 24.0 2.55 245.6 30.22 54.38 8.64 59.96 40.88 19.63 4.09 1.47 78.09 

Deer 33-2 25.0 2.48 228.8 27.96 58.60 8.19 57.50 51.58 17.63 4.13 1.50 79.42 

Deer 34-2 26.0 2.50 249.6 31.72 52.84 8.75 60.45 52.59 19.36 3.91 1.57 77.86 

Deer 35-2 27.0 2.46 246.2 32.08 55.07 10.69 62.50 57.37 20.99 4.37 1.52 78.46 

Deer 36-2 28.0 2.46 261.6 29.84 54.15 7.90 57.86 50.36 18.32 3.77 1.44 76.29 

Deer 37-2 29.0 2.31 136.6 26.13 46.20 6.39 53.37 43.04 18.63 4.02 1.17 79.96 

Deer 38-2 30.0 2.22 222.4 25.95 47.72 5.58 54.44 51.39 18.99 3.91 1.15 79.98 

Deer 39-2 31.0 2.22 237.8 26.94 50.73 5.47 49.86 56.27 19.96 3.69 1.02 70.18 

Deer 40-2 32.0 2.26 234.0 29.48 54.83 6.07 50.02 52.34 20.72 3.41 1.04 64.11 

Deer 41-2 33.0 2.47 257.8 32.41 59.35 6.73 52.22 46.92 22.25 3.59 1.02 66.33 

Deer 42-2 34.0 2.44 247.9 31.63 48.65 6.29 50.97 53.61 19.92 3.49 0.93 59.98 

Deer 43-2 35.0 2.27 169.7 29.22 50.20 6.40 50.60 40.76 18.25 3.38 1.05 62.94 

Deer 44-2 36.0 2.21 167.1 28.18 41.02 5.90 47.40 53.20 16.70 3.59 1.29 61.91 

Deer 45-2 37.0 2.27 177.6 27.37 44.03 5.60 47.50 41.51 15.61 3.40 0.98 59.66 

Deer 46-2 38.0 2.22 175.7 26.97 43.66 5.49 47.56 53.50 14.55 2.97 0.91 57.40 

Deer 47-2 39.0 2.35 208.7 28.52 42.35 5.26 47.59 48.23 16.99 3.22 0.94 64.10 

Deer 48-2 40.0 2.45 212.0 30.70 44.05 5.95 48.92 44.28 16.51 2.79 0.95 64.23 

Deer 49-2 41.0 2.55 239.5 31.33 48.84 6.16 50.81 58.73 16.87 2.93 0.95 65.17 

Deer 50-2 42.0 2.30 192.1 28.19 42.30 5.49 46.36 45.43 15.76 2.84 0.82 52.70 
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Table A4. (cont’d) 

Sample Depth Sc Ti V Cr Co Ni Cu As Mo Cd Pb 

Deer 51-2 43.0 2.50 247.4 30.29 44.00 5.55 47.27 47.21 15.82 3.24 0.88 51.86 

Deer 52-2 44.0 2.49 208.3 28.97 43.82 5.36 49.03 61.44 15.38 3.06 0.84 55.21 

Deer 53-2 45.0 2.43 211.3 31.38 46.80 5.83 47.14 41.94 17.18 3.23 1.03 53.51 

Deer 54-2 46.0 2.36 233.7 32.01 43.87 6.02 46.99 43.89 17.85 3.22 1.00 51.13 

Deer 55-2 47.0 3.11 275.9 32.81 42.29 6.19 48.38 57.40 17.38 3.18 1.00 51.64 
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Table A4. (cont’d) 

Sample Depth Al Zn Se Sr Mg K Mn Ba U Fe Ca Hg 

Deer 1-2 0.5 11616 272 4.29 42.09 4653 924 1491 110.42 3.62 67515 16879 4.39 

Deer 2-2 1.0 10966 255 4.32 40.02 4171 903 1604 118.66 3.69 69470 17367 4.28 

Deer 3-2 1.5 10289 233 4.11 37.86 3879 919 1572 120.17 3.33 64758 16190 3.94 

Deer 4-2 2.0 10144 232 4.31 36.97 3910 868 1334 110.86 3.27 63405 15851 4.23 

Deer 5-2 2.5 10312 238 4.93 37.29 3947 864 918 103.90 3.71 63028 15757 4.29 

Deer 6-2 3.0 12743 250 4.65 36.39 4091 879 789 96.24 3.92 63444 15861 4.36 

Deer 7-2 3.5 11153 260 4.69 35.90 4217 884 853 91.05 3.96 67870 16968 4.67 

Deer 8-2 4.0 10528 249 4.71 33.76 4010 807 948 79.09 3.52 70258 17565 4.49 

Deer 9-2 4.5 11436 263 4.78 35.11 4139 900 981 76.07 3.68 68015 17004 4.78 

Deer 10-2 5.0 11158 291 5.03 36.14 4272 857 822 74.23 3.89 58787 14697 5.24 

Deer 11-2 5.5 11587 304 4.52 35.74 4388 910 781 78.72 3.56 53258 13315 5.40 

Deer 12-2 6.0 12838 319 5.02 35.59 4374 867 817 78.75 3.61 54471 13618 5.94 

Deer 13-2 6.5 11876 336 4.39 36.48 4381 927 803 81.44 3.61 54852 13713 6.00 

Deer 14-2 7.0 15683 339 4.91 36.07 4231 853 801 84.78 3.54 54593 13648 6.22 

Deer 15-2 7.5 11934 378 5.22 38.96 4447 908 868 84.37 3.56 56149 14037 6.58 

Deer 16-2 8.0 12082 376 4.79 39.19 4431 945 947 84.25 3.60 57615 14404 6.52 

Deer 17-2 9.0 12084 407 5.03 40.85 4439 893 1107 85.86 3.63 56271 14068 6.57 

Deer 18-2 10.0 12053 407 4.70 48.31 4406 930 1346 95.01 3.63 56090 14022 6.80 

Deer 19-2 11.0 12607 400 4.62 43.34 4523 977 1303 89.50 3.62 54879 13720 6.88 

Deer 20-2 12.0 12387 393 4.54 46.06 4593 1020 1250 92.87 3.67 52231 13058 7.13 

Deer 21-2 13.0 12825 357 4.65 46.52 4775 1106 1042 94.77 3.75 52154 13038 7.38 

Deer 22-2 14.0 12393 301 4.33 45.03 4870 1090 688 95.64 3.97 49981 12495 7.74 

Deer 23-2 15.0 12114 263 4.69 45.61 4928 1080 561 93.90 4.12 47968 11992 8.19 

Deer 24-2 16.0 11260 240 4.76 45.30 4906 944 528 90.67 4.13 45494 11374 8.52 

Deer 25-2 17.0 14167 289 6.22 57.77 6141 1122 623 112.70 5.37 56539 14135 10.78 
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Table A4. (cont’d) 

Sample Depth Al Zn Se Sr Mg K Mn Ba U Fe Ca Hg 

Deer 26-2 18.0 12997 240 5.21 48.11 5141 1023 550 95.05 4.38 47179 11795 9.01 

Deer 27-2 19.0 12032 260 5.35 50.23 5077 801 644 97.46 4.34 48450 12112 9.05 

Deer 28-2 20.0 11936 222 5.20 55.10 4205 650 616 88.73 4.00 44824 11206 7.31 

Deer 29-2 21.0 11589 227 4.98 49.46 4969 835 585 89.61 4.53 47984 11996 8.78 

Deer 30-2 22.0 11679 218 4.84 48.41 4850 856 580 86.12 4.53 48069 12017 8.43 

Deer 31-2 23.0 11718 202 4.88 47.89 4639 938 512 79.76 4.32 49482 12371 7.81 

Deer 32-2 24.0 11145 183 5.05 49.12 4269 839 460 73.03 4.20 46837 11709 7.17 

Deer 33-2 25.0 10660 188 4.81 46.69 4303 799 486 75.62 4.31 42423 10606 7.31 

Deer 34-2 26.0 10840 195 4.84 58.02 4501 834 520 84.99 4.25 41890 10473 7.54 

Deer 35-2 27.0 10806 195 5.03 55.10 4261 809 465 76.70 4.56 49006 12251 7.20 

Deer 36-2 28.0 10477 176 4.85 53.21 4099 859 474 79.92 4.15 45230 11307 5.57 

Deer 37-2 29.0 9571 168 4.39 68.31 3560 777 580 83.78 4.02 40630 10157 4.81 

Deer 38-2 30.0 9847 141 4.31 47.86 3160 741 325 76.31 4.07 43492 6524 4.42 

Deer 39-2 31.0 9759 122 4.12 50.16 2992 773 327 77.31 4.22 47020 7053 3.67 

Deer 40-2 32.0 10253 123 4.55 52.63 3201 799 343 80.26 4.21 42164 6325 3.05 

Deer 41-2 33.0 11398 128 4.98 58.29 3554 899 383 84.16 4.39 44196 6629 3.27 

Deer 42-2 34.0 11155 107 4.80 58.25 3470 875 406 78.53 4.23 40806 6121 2.90 

Deer 43-2 35.0 10101 108 5.19 59.88 3481 653 391 79.18 4.27 40040 6006 2.90 

Deer 44-2 36.0 10311 104 5.25 60.70 3479 657 353 77.52 4.02 39057 5859 2.85 

Deer 45-2 37.0 10186 97 5.22 60.64 3535 697 344 77.54 3.93 37391 5609 2.80 

Deer 46-2 38.0 10234 95 4.74 60.69 3528 704 338 78.31 3.82 33898 5085 2.80 

Deer 47-2 39.0 11540 101 4.76 62.74 3799 825 347 83.06 4.35 37148 5572 2.93 

Deer 48-2 40.0 11265 105 4.42 65.83 3820 825 351 86.13 3.99 36475 5471 3.11 

Deer 49-2 41.0 12026 108 4.54 68.88 3965 1708 362 90.08 3.96 37529 5629 3.11 

Deer 50-2 42.0 11116 95 4.16 67.90 3724 817 350 85.04 3.48 35720 5358 3.13 
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Table A4. (cont’d) 

Sample Depth Al Zn Se Sr Mg K Mn Ba U Fe Ca Hg 

Deer 51-2 43.0 12454 96 4.24 72.11 4011 997 357 91.11 3.48 38789 5818 3.20 

Deer 52-2 44.0 12483 92 4.20 74.98 4096 904 359 97.53 3.27 38099 5715 3.25 

Deer 53-2 45.0 11865 102 4.13 74.07 3667 851 345 93.03 3.48 39028 5854 3.70 

Deer 54-2 46.0 11678 100 3.81 73.24 3483 876 337 90.86 3.38 40287 6043 3.75 

Deer 55-2 47.0 12243 103 3.93 73.20 3636 1024 342 93.36 3.24 38359 5754 3.81 
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Figure S1. 
210

Pb dated focusing-corrected anthropogenic accumulation rates for four 

Michigan lakes, dates older than 1850 were truncated to highlight more recent loading.  

Note the change in scale on the x-axis. 
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Figure S2. 
210

Pb dated focusing-corrected anthropogenic accumulation rates for three 

Michigan lakes, dates older than 1850 were truncated to highlight more recent loading.  

Note the change in scale on the x-axis. 

Dating Methodology 

 

Methods for determining appropriate sediment ages for these cores were adapted from a 

decade of work in the Great Lakes region (Golden et al., 1993, Kolak et al., 1998, Kolak et 

al., 1999, Pearson et al., 1998, Pearson et al., 1997a, Pearson et al., 1997b, Simick et al., 

1996, Wong et al., 1995).  Four different 
210

Pb dating models were compared to determine 

accurate dates for sediment cores collected in this study (Table S1).  The constant flux: 

constant sedimentation (CF:CS) model assumes a constant flux of 
210

Pb to the sediment and 

a constant rate of sedimentation (Golden et al., 1993).  However, if clear sedimentation rate 

changes occurred within the core indicated by changes in slope of the accumulated dry mass 

versus excess 
210

Pb plot then a segmented CF:CS (SCF:CS) model was used (Heyvaert et 
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al., 2000).  If a mixing zone was present, appearing as a vertical straight line in the 

accumulated dry mass versus excess 
210

Pb plot, then the rapid steady state mixing model 

(RSSM) (Robbins, 1982) may be used.  When excess 
210

Pb inventories could be calculated 

the constant rate of supply model (CRS) was also evaluated (Oldfield et al., 1978).  The 

most appropriate dating model was chosen based on three separate qualifiers: date of peak 

137
Cs activity (ca. 1963) (Walling and Qingping, 1992), age of oldest sediment containing 

excess 
210

Pb (ca. 1850), and stable Pb peak concentration (ca. 1970) (Alfaro-De la Torre 

and Tessier, 2002) (Table S1).  Maximum stable Pb concentration not placed in the mid-

1970s does not conclude an incorrectly dated sediment core if significant local watershed 

sources exist.  However, if the maximum stable Pb concentration does occur in the mid-

1970s then the age dating model was appropriate.  Only core sections containing excess 

210
Pb can be dated, therefore core sections without excess 

210
Pb were dated by assuming 

that sedimentation rates remained constant below this depth.  For the CF:CS, SCF:CS and 

RSSM model the sedimentation rate for the lowest excess 
210

Pb-containing sections was 

used.  For the CRS model the average of the last five excess 
210

Pb-containing core sections 

was used.   

Focusing factors were calculated for all lakes.  When 
210

Pb was present in all core sections 

inventories of 
210

Pb were estimated by extrapolating the regression equation of excess 

210
Pb vs. accumulated dry mass (g/cm

2
).  For lakes dated with the CF:CS model the entire 

core section was used.  Only the bottom core sections were used to determine the equation 
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when the SCF:CS was applied.  Dry mass was estimated as the average dry mass for the 

bottom two to twelve core sections.  The final focusing factor was deemed appropriate when 

additional core sections did not result in an appreciable change. 

 

Dating in Littlefield Lake was difficult due to a disturbed 
210

Pb profile; however, stable Pb 

concentrations appeared to reach background concentrations when compared to other study 

lakes.  In order to date this sediment core, the core section containing the greatest stable Pb 

concentration was assigned a median year of deposition of 1972.  The total mass of sediment 

was determined for core sections above the greatest stable Pb concentration and divided by 

28 y (2000-1972) to determine the sedimentation rate, 693 g/m
2
/yr.  However, applying this 

sedimentation rate to the entire core placed background concentrations of Pb much earlier 

than other lakes.  Therefore, a SCF:CS model was used to date this core with a 

sedimentation rate of 693 g/m
2
/y for core sections younger than 1972 and a sedimentation 

rate of 252 g/m
2
/y in core sections older than 1972.  The focusing factor for Littlefield Lake 

was determined as the average of Elk, Gull, Crystal M, and Higgins lakes.
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Table S1: 
210

Pb data for 26 Michigan lakes 

 

Lake Model 

137
Cs 

Date 

Stable  

Pb Date 

Excess 
210

Pb 

Range 

(Bq/g) 

Sedimentation Rate Range
e
 

(g/m
2
/y) 

Avalon CRS 1957 1974 0.0152-0.461 100-637 

Birch CRS 1969 1982 0.00162-1.10 235-1871 

Cadillac CRS Disturb
a
 1973 0.00357-0.764 76-398 

Cass CF:CS NM
b
 1981 0.128-0.309 3480 

Crystal B CRS 1966 1966 0.0213-0.636 421-796 

Crystal M CRS 1977 1977 0.00382-0.536 351-548 

Elk SCF:CS 1966 1972 0.000489-0.637 450, 980, 220 

George CF:CS 1968 1971 0.101-0.931 417 

Gratiot CF:CS NM
b
 1968 0.000612-1.27 255 

Gull SCF:CS NM
b
 1977 0.00147-0.372 190,535 

Hackert CRS 1966 1988 0.0133-3.12 87-1116 

Higgins CF:CS NM
b
 1984 0.00368-0.988 232 

Houghton SCF:CS 1971 1969 0.000489-0.795 59,490,152 

Imp CRS 1978 1974 0.00201-2.52 51-431 

Littlefield Pb NM
b
 assigned 0.199-0.250

d
 252,693 

Mullett SCF:CS 1965 1973 0.000893-0.426 980, 1550, 420 

Muskegon CF:CS Unclear
c
 1968 0.0911-0.329 1711 

Otter CF:CS 1963 1961 0.0768-1.02 933 

Paw Paw CF:CS 1963 1974 0.0741-0.581 828 

Round CRS 1971 1971 0.00486-1.01 154-442 

Round D CRS 1968 1937 0.00280-1.20 137-1439 

Sand CRS Disturb
a
 1997 0.00834-0.905 110-2173 

Shupac CRS 1961 1983 0.00296-3.38 99-1134 

Torch SCF:CS 1969 1983 0.000149-0.922 390, 1108, 329, 1280, 1504 

Whitmore SCF:CS 1967 1976 0.0198-0.822 552, 2188, 202 

Witch CRS 1961 1961 0.0822-1.18 44-590 
a
Indicates that the 

137
Cs profile was disturbed and a clear peak in activity was not identified. 

b137
Cs was not measured in these lakes. 

c
The 

137
Cs was not disturbed but a peak was not readily identifiable. 

d
Excess 

210
Pb values for Littlefield Lake were estimated 

e
In the case of the CF:CS model the sedimentation rate applies to the entire core.  The range 

of sedimentation rates are provided for the CRS model.  Sedimentation rates for cores dated 

with the SCF:CS model are read from left to right representing sedimentation rates from the 

top to the bottom of the core. 
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APPENDIX C. METHODS FOR ACQUISITION OF WATERSHED 

CHARACTERISTICS DATA 

 

The following methods supplement those prepared by Sharon S. Yohn and were used in the 

acquisition of the watershed characteristics used in Chapter 3.  ArcGIS run on a Windows 

platform was used for all GIS work. 

 

Calculating Land Use in Watershed and Buffers 

 

First, reclassifying the land use makes the process a bit easier.  A reclass file has been saved 

to the C:\Workspace file for both the IFMAP (C:\Workspace\ifmap_class) and 1978 MIRIS 

(C:\Workspace\78_class) land use databases.  To reclassify the data follow the steps below. 

 

IFMAP 

1. Add the buffer polygon file and the watershed land use raster to the active layer 

2. In the ArcToolbox→Spatial Analyst→Reclass→Reclassify toolbox 

3. Input Raster: The watershed land use raster 

4. Reclass Field: Use the Value field 

5. Press the Load.. button and find the proper reclassification table (IFMAP or MIRIS) 

6. Run the Tool 

7. Now you have a reclassified landuse raster.  The table below defines how the raster 

was reclassified. 

 

Table C1. IFMAP Reclassification Scheme 

Land Use Type Old Classification New Classification 

Urban 1-4 100 

Agriculture 5,6,7,9 200 

Upland Openland 10,12,13 300 

Forest 14-22,24-26 400 

Water 23 500 

Wetland 27-30 600 

Barren 31,32,35 700 

 

a. *Note the Forest classification includes lowland forest which by IFMAP 

classifcations is defined as wetland.  Following the methods of Yohn S. S. 

2004 it will be defined as forest here. 

 

8. Now that the land use has been reclassified we need to clip the watershed land use 

raster with the buffer polygon.  For this we shall set the analysis mask of the spatial 



 

194 

 

analyst.  Setting the mask in spatial analyst will force all operations to be constrained 

to the mask and thus must be reset or turned off in order to complete new mask 

operations. 

 

9. In the Spatial Analyst Toolbar choose Options 

 

10. In the General Tab: 

a. Working directory: Set this to the directory in which to save the files 

b. Analysis Mask: Set this to the buffer polygon in the drop down menu 

c. Analysis Coordinate System: Set this to the coordinate system of the active 

data layer (Be sure to change the active data layer to the Michigan GEOREF 

projection) 

 

11. In the Extent Tab: 

a. Analysis Extent: In the pulldown menu specify the buffer polygon 

 

12. In the Cell Size Tab: 

a. Analysis cell size: In the pulldown menu specify the reclassified watershed 

landuse raster 

b. Specify the cell size, generally you want to use the lowest cell size possible to 

capture all of the detail, 1m is generally works well.  1m will not work well 

with large watersheds due to restrictions in space and computing time. 

 

13. Press Ok to exit the Options Window. 

 

14. In the Spatial Analyst toolbar click on the Raster Calculator and double-click on the 

reclassified watershed landuse raster and press Evaluate 

 

15. Now a temporary file called “Calculation” has been created.  To create a permanent 

file right click on the Calculation file and press Make Permanent.  This does not have 

to be done in able to calculate areas but may be convienent if you want to revisit the 

data.  Instead of making the raster “Calculation” permanent you can join the results 

of the Calculation to the watershed land use raster. 

a. Create a file name and save it in the directory 

 

16. Add the file you created when you made the Calculation data file permanent.  Right 

click on the file and open the attribute table. 
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a. The Value represents the land use classification scheme described above and 

the count is the number of cells making up the land use.  Multiplying the 

count times the square of the cell size will result in the area in square meters 

of land use.  The attribute file can be exported to Excel for ease of 

calculation. 

 

17. With the attribute table open, click on the Options.. menu and click on Export. 

a. Export: All records 

b. Output Table: Specify the directory and name. 

c. Click on the folder button to browse and change the file type to text. 

d. Click Save 

 

18. Open the new land cover file in Excel and multiply the count column times the 

square of the cell size specified above (generally 30^2).  These are the areas of land 

use in the buffer around the lake. 



 

196 

 

 

MIRIS Land Use 

 

The method for calculating 1978 MIRIS land use is different because the values assigned to the 

land use classifications change from lake to lake. 

 

1. Add the 1978 land use shapefile clipped to the watershed to the active layer 

2. Convert the shapefile to a raster dataset in the ArcToolbox→Conversion Tools→To 

Raster→Feature to Raster 

a. Input Features: Select the 1978 land use shapefile 

b. Field: Select the LABEL1 field 

c. Output Raster: Specify the file name and location 

d. Output Cell Size: Specify the cell size (1m generally works well for our 

watersheds and simplifies the calculation of land use) 

 

3. Follow step 9-14 from the IFMAP area calculations to create a raster of the land use in 

the buffer. 

4. Right click on the newly created raster and open the attribute table. 

a. You will notice that the counts and label name are not preserved in the buffer 

raster attribute file we need to join the fields in the buffer raster with the fields in 

the 1978 land use watershed raster 

5. A join can be made between the 1978 watershed land use file and the buffer file to 

preserve the labels 

a. Right click on the 1978 land use buffer raster and click on Joins and 

Relates→Join… 

i. You want to join attributes from a table 

ii. Choose the Value Field in the 1. Drop down box 

iii. Choose the 1978 watershed land use raster from the 2. drop down box 

iv. Choose the Value Field in the 3. drop down box 

v. Click OK 

 

 

6. Now right click on the buffer raster file and the labels are now included in the file. 

a. Export the attribute file to a text file 

7. Open the newly created text file in Excel and multiply the counts times the square of the 

cell size you specified when creating the raster. 

8. These are the areas of 1978 land use categorized by the most general level of detail 

a. Urban, Agriculture, Nonforested, Forested, Water, Wetlands, and Barren 

*Note: Barren in the MIRIS database has a different meaning than Barren in the IFMAP.  Barren 

in MIRIS is defined as beaches and riverbanks or sand covered beaches. 
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Calculating Land Use/Land Cover Using the Inland Lakes Toolbox in ArcGIS 9.2 

 

This method requires that the Proj_Fill_Fdir_Facc and Watershed_No_Lake_Polygon models 

have been run. 

 

Make sure that the ArcINFO license is installed and that the Spatial Analyst Extension is 

activated 

 Details for installing the ArcINFO license can be found at: 

http://support.esri.com/index.cfm?fa=knowledgebase.techarticles.articleShow&d=24741, it 

requires changes to the registry, so be sure that you understand the implications of this and make 

a backup of the current registry if necessary. 

 

This methodology will 

1. Calculate the LULC attributes of a watershed based on the 1978 MIRIS database and the 

2001 IFMAP 

2. Calculate the LULC attributes within a 100m buffer of the lake based on the 1978 MIRIS 

database and the 2001 IFMAP 

3. Calculate the Flow weighted LULC attributes of a watershed based on the 1978 MIRIS 

database and the 2001 IFMAP 

4. Calculate the Flow weighted LULC attributes within a 100m buffer of the lake based on 

the 1978 MIRIS database and the 2001 IFMAP 

  

 Land Use/Land Cover delineated are: 

  Urban 

  Agriculture 

  Forest 

  Barren 

  Rangeland/Upland 

  Water 

  Wetlands 

 

1978 MIRIS Land Use/ Land Cover 
 

Open up the 1978_Landuse model in the Inland Lakes Toolbox 

 

A dialog box similar to the one below will appear. 

 

The following datasets will be needed: 

 

1. County Land Use 

a. These files are available from the MiDL website for each county.  If the 

watershed spans multiple counties the individual county landuse files will need to 

be merged.  

i. The merge tool can be found in ArcToolbox→Data 

Management→General→Merge 
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2. No Lake Polygon 

 

a. This is the watershed no lake polygon that was created using the 

WS_NL_Polygon model, e.g., lakeshed_nl 

 

3. Lake Shapefile 

a. This is the lake shapefile created using the Proj_Fill_Fdir_Facc model, e.g., 

lakes_rivers_select. 

 

4. Field 

a. Select Level 1.  This is the top level Anderson LULC codes for the MIRIS 

database 

 

5. Flow Length Raster 

a. This is the flow length raster calculated using the WS_NL_Polygon model, e.g., 

lakeshed_fl 

 

6. Extent 

a. Browse to the lake_elev file in the NED geodatabase. 

 

7. Environments 

a. Click on the Environments button and open up the General Settings drop-down 

box. 

i. Change the current workspace to the lu1978 geodatabase. 

 

2001 Land Use / Land Cover 

 
Open the 2001_Landuse model in the Inland Lakes Toolbox 

 

A dialog box will appear similar to the one above. 

 

Four datasets will be required 

 

1. Flow length Raster 

a. The flow length raster calculated using the WS_NL_Polygon model, e.g., 

lakeshed_fl 

 

2. WS_NL_Polygon 

a. The watershed no lake polygon calculated using the WS_NL_Polygon model, 

e.g., lakeshed_nl 

 

3. Lake Shapefile 

a. The lake shapefile calculated using the Proj_Fill_Fdir_Facc model, e.g., 

lakes_rivers_select.  It will be located in the Scratch folder. 

 

4. Lakename 
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a. The name of the lake, an abbreviation of the lake works best, e.g., cad for 

Cadillac. 

 

5. Environments 

a. Change the current workspace to the lu2001 geodatabase. 
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Creating buffers around lake: 

 

1. Open lake only file – polygon or shape in the lake layer 

2. In ArcToolbox open Analysis Tools→Proximity→Buffer 

3. Input Features: Select lake only file from drop down menu or browse 

4. Output Features: New file name 

5. Select Distance: Be sure that a coordinate system is specified 

6. Dissolve Type: Select All (This will force the new file to only contain one polygon) 

7. Run the Tool 

 

This creates a buffer extending to the specified distance around the lake but also includes the 

lake itself.  The lake now needs to be removed, accomplished by creating the union of the lake 

and buffer file just created. 

 

8. In ArcToolbox→Analysis Tools→Overlay→Union 

9. Input Features: Select the lake only file and the buffer file created above 

10. Output Features: The new file name 

11. Run the Tool 
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Creating the Watershed No Lake Shapefile Using the Inland Lakes Toolbox in ArcGIS 9.2 

 

***The watershed no lake file is required to calculate the land use/land 

cover within the watershed, it erases the lake from the watershed.*** 
 

Make sure that the ArcINFO license is installed and that the Spatial Analyst Extension is 

activated 

 Details for installing the ArcINFO license can be found at: 

http://support.esri.com/index.cfm?fa=knowledgebase.techarticles.articleShow&d=24741, it 

requires changes to the registry, so be sure that you understand the implications of this and make 

a backup of the current registry if necessary. 

 

This methodology will: 

1. Create a watershed with the lake removed 

2. Calculate the flow length clipped to the watershed 

 

Open the Watershed_No_Lake_Polygon model in the Inland Lakes Toolbox 

 

A dialog box will appear similar to the one shown above. 

 

The following datasets will be needed 

1. Watershed raster 

a. The watershed calculated by the Proj_Fill_Facc_FDir model, e.g., lake_shed 

2. FDIR Raster 

a. The flow direction raster calculated by the Proj_Fill_Facc_FDir model, e.g., 

FlowDir_Fill1 

3. Lake Shapefile 

a. The lake shapefile, found in the scratch geodatabase, that was created using the 

Proj_Fill_Facc_FDir model, e.g., lakes_rivers_select 

4. Directory 

a. Browse to the NED geodatabase, this is where all of the output will be stored.   

i. Two files are created: 

1. Lakeshed_nl – the watershed with the lake removed 

2. Lakeshed_fl – the calculated flow length clipped to the watershed 

5. Extent 

a. Browse the the lake_elev file, this is the original file that was projected, e.g., 

lake_elev.  
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Creating the watershed_nl file in ArcMap 9.2 

 

For many of the analyses it is desirable to have a coverage or shape file of the watershed without 

the lake present (e.g., soils in the watershed, land cover, or slope).  The watershed_nl file will 

also be used to clip grids for flow weighted land cover and average slope calculations. 

 

This method will do the following: 

Create a lake_shapefile from the county TIGER lakes dataset 

Convert the lake_shapefile to a raster dataset to use for clipping grids 

 

Open up the county TIGER shapefile dataset, these can be downloaded from the MiGDL website 

(http://www.mcgi.state.mi.us/mgdl/) making sure that the projection has been defined for the 

lakes file, this may be necessary using Data Management Tools Toolbox→Define Projection 

Open the watershed file 

Open the attribute table of the TIGER lakes file and record the FID for the lake of interest 

From the ArcToolbox navigate to Analysis Tools→Extract→Select 

 Input Features: TIGER lakes file 

 Output Features: create a name and location for the new lake file (e.g., white_lake) 

 Expression: click on the SQL box to the right 

  Double click on “FID” 

  Click the “=” button 

  Type in the expression for the FID for the lake, recorded above 

From the ArcToolbox navigate to Conversion Tools→From Raster→Raster to Polygon 

 Input Raster: watershed raster (e.g., white_shed) 

 Field: ID 

 Output polygon features: Create a name and location for the new file (e.g., white_shedp) 

From the ArcToolbox navigate to Analysis Tools→Overlay→Union 

 Input Features: watershed polygon file (e.g., white_shedp from above) and the lake file 

(e.g., white_lake from above) 

 Output Feature Class: Create a name and location for the new union file (e.g., 

whiteshed_nl) 

 Keep the defaults for the remaining selections 

Right click on the watershed_nl file (e.g., whiteshed_nl from above) and open the attribute table 

 In the Editor Toolbar select Start Editing 

 Select the rows in the watershed_nl file and press delete 

 In the Editor Toolbar select Stop Editing and save changes 

From the ArcToolbox navigate to Conversion Tools→To Raster→Feature to Raster 

 Input Features: select the watershed_nl file (e.g., whiteshed_nl from above) 

 Field: ID 

 Output Raster: create a name and location for the output (e.g., whiteshed_nl) 

 Output cell size: navigate to the flowaccumulation file for the lake of interest (e.g., 

white_facc) 
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Delineating Watershed (Long Method) in ArcMap 9.2 

 

This method uses NED elevation data available from the US Geological Survey.  It compliments 

the ArcINFO method but benefits in its GUI interface which is more easily used by traditionally 

non-GIS users. 

 

This method will 

1. Project the NED elevation data set from the WGS_1983 standard to Michigan GeoRef 

1983 (meters) 

2. Fill any sinks in the data set 

3. Calculate flow direction 

4. Calculate flow accumulation 

5. Create “pour-points” for watershed delineation 

6. Delineate a watershed 

 

Methodology 

 

1. Obtain 1 arc second NED elevation data from USGS website http://seamless.usgs.gov 

2. Open ArcMap and add the NED elevation data 

3. Open the ArcToolbox if not already open 

4. Navigate to the Data Management Toolbox → Projections and Transformation → 

Raster → Project Raster 
a. Input Raster: Select the NED elevation data set 

b. Output Raster: Create a name (e.g., white_elev) and location for your new 

projected elevation data set 

c. Output coordinate system: click on the box to the right 

i. In the new Spatial Reference Properties dialog box click Select 

1. Choose the 1983 Michigan GeoRef (meters) projection from: 

Projected Coordinate Systems→State Systems 
d. Geographic Transformation: NAD 1983 to WGS 1984_5 (if necessary) 

e. Resampling Technique: Cubic 

f. Output cell size: 30.86 for 1 arc second DEM data 

5. Navigate to Spatial Analyst Toolbox→Hydrology→Fill 

a. Provide the input raster (e.g., white_elev from above) 

b. Create a name and location for your new filled elevation data set (e.g., 

white_elevf) 

c. Provide a Z-limit if appropriate (usually no Z-limit is required) 

6. Navigate to Spatial Analyst Toolbox→Hydrology→Flow Direction 

a. Select the filled elevation dataset (e.g., white_elevf from above) 

b. Create a name and location for the flow direction raster data set (e.g., white_fdir) 

7. Navigate to Spatial Analyst Toolbox→Hydrology→Flow Accumulation 

a. Select the flow direction raster data set (e.g., white_facc from above) 

b. Create a name and location for the flow accumulation raster data set (e.g., 

white_facc) 

8. Double-click on the newly created flow accumulation raster data set 

a. Click on the Symbology tab 



 

204 

 

b. In the Show: frame at left click on classified 

c. Click on the classify button at the right 

d. Change the classification to the standard deviation and change the Interval Size to 

¼ Std Dev 

e. Apply the changes (you may need to invert the colors or choose an appropriate 

color ramp to see the output) 

f. You should now see several lines of flow accumulation in the data frame, zoom 

into the lake of interest and find the output (i.e., where flow accumulation is the 

highest, can be found using the identity tool) 

9. Open ArcCatalog and navigate to the folder where the raster files are saved. 

a. Right click in the right most open pane 

b. Click on New 

i. Click on Shapefile 

1. In the Create New Shapefile dialog box 

a. Create a name for the shapefile (e.g., whiteout) 

b. Make sure Feature Type: is point 

c. Click EDIT and select the Michigan GeoRef 1983 (meters) 

projection 

10. Change the Spatial Analyst and Environment Settings to reflect the extent and cell size of 

the flow accumulation raster data set 

a. Click on the Spatial Analyst Toolbar→Options  

i. click on the Extent Tab 

1. Change the Analysis Extent: to the flow accumulation raster (e.g., 

white_facc) 

ii. Click on the Cell Size tab 

1. Change the Analysis cell size: to the flow accumulation raster 

(e.g., white_facc) 

b. In the Tools menu navigate to Options and click on the Geoprocessing tab, open 

Environments… 

i. In the General Settings drop down specify the Extent: to the flow 

accumulation raster (e.g., white_facc) 

ii. In the Raster Analysis Settings drop down box specify the Cell Size: to the 

flow accumulation raster (e.g., white_facc) 

c. Record the cell size, you will need this number in Step 11 below. 

11. In ArcMap add the newly created shapefile (e.g., whiteout from above) 

a. In the Tools Menu click on the Editor Menu if not already open 

b. In the Editor Tools click start editing 

i. In the dialog box select the file that contains the newly created shapefile 

(e.g., whiteout from above) 

c. Using the sketch tool place the newly created shapefile in the flow accumulation 

line where it exits the lake 

d. In the Editor Tools click stop editing and save the changes 

e. Navigate to the Conversion Tools Toolbox→To Raster→Feature to Raster 

f. Select the newly created and positioned shapefile 

g. Create a new name for the raster (e.g., white_out) 
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h. Make sure the output cell size is the same size as the flow accumulation raster 

data set, recorded in step 10 above 

12. Navigate to the Spatial Analyst Tools Toolbox→Hydrology→Watershed 

a. Select the flow direction raster (e.g., white_fdir) 

b. Select the raster pour point (e.g., white_out) 

c. Pour point field should be Value 

d. Create a name for the output (e.g., white_shed) 
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Delineating Watersheds using the Inland Lake Toolbox in ArcGIS 9.2 

 

Make sure that the ArcINFO license is installed and that the Spatial Analyst Extension is 

activated 

 Details for installing the ArcINFO license can be found at: 

http://support.esri.com/index.cfm?fa=knowledgebase.techarticles.articleShow&d=24741, it 

requires changes to the registry, so be sure that you understand the implications of this and make 

a backup of the current registry if necessary. 

 

This methodology will: 

7. Project the NED elevation data set from the WGS_1983 standard to Michigan GeoRef 

1983 (meters) 

8. Fill any sinks in the data set 

9. Calculate flow direction 

10. Calculate flow accumulation 

11. Convert the lake shapefile to a raster dataset 

12. Calculate the watershed using the lake as the pour point 

 

In ArcCatalog create a new lake folder in the lakes_ned file folder found in the C:\Workspace 

directory 

 

In the new lake folder create four new file geodatabases 

1. ned  - for all of the elevation, filled elevation, flow direction, flow accumulation, lake 

rasters, and watershed files 

2. scratch – necessary for future landuse toolboxes 

3. lu2001 – will contain all of the output from the 2001 landuse toolbox 

4. lu1978 – will contain all of the output from the 1978 landuse toolbox 

 

Methodology 
 

Obtaining and projecting the NED data from USGS 
 

13. Obtain 1 arc second NED elevation data from USGS website http://seamless.usgs.gov 

14. Open ArcMap and add the NED elevation data 

15. Open the ArcToolbox if not already open 

16. Navigate to the Data Management Toolbox → Projections and Transformation → 

Raster → Project Raster 
a. Input Raster: Select the NED elevation data set 

b. Output Raster: Create a name (e.g., white_elev) and location for your new 

projected elevation data set (i.e., the ned geodatabase in the lake folder created 

above) 

c. Output coordinate system: click on the box to the right 

i. In the new Spatial Reference Properties dialog box click Select 

1. Choose the 1983 Michigan GeoRef (meters) projection from: 

Projected Coordinate Systems→State Systems 
d. Geographic Transformation: NAD 1983 to WGS 1984_5 (if necessary) 
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e. Resampling Technique: Cubic 

f. Output cell size: 30 for 1 arc second DEM data 

 

Using the Proj_Fill_Fdir_Facc toolbox 
 

 

 

1. Double-click on the Proj_Fill_Fdir_Facc model in the Inland_Lakes toolbox and a dialog box 

will appear. 

 

a. Input the necessary features 

i. Projected NED Raster is the raster downloaded and projected above 

ii. Input Features is the county lakes_rivers TIGER95 shapefile, this may be a 

problem since it appears that MiGDL has discontinued the use of the TIGER95 

files 

iii. Expression – this input relates to the lakes_rivers input that you selected in the 

Input Features input line 

iv. Click on the SQL button to the right 

v. In the new dialog box 

a. Scroll to “Name” in the menu to the left and double click on it 

b. Press the equals sign 

c. Scroll to the Lake Name in the menu to the left and double click on 

it 

d. Press OK 

b. In the Field input, scroll down to AREA 

c. In the Extent input, browse to the projected lake_elev file you created in the steps above 

d. In the Directory input, browse to the NED geodatabase that was created in the steps 

above 

e. This steps insures that all data created are put into the NED folder 

1. The lake_shapefile that is created is put into the scratch folder 

2. All other datasets are put into the NED folder 

f. Click OK 

 

Depending upon the size of the elevation dataset, the tool may take up to ½ hour before 

completing. 
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Determining Land Use in Watershed (ArcMap 9.2) 

 

Land use for Michigan comes from two sources the IFMAP (Landsat 2001) and the MRBIS 

1978 land use data.  The ifmap data should be available on the local machine in 

C:\Workspace\ifmap.  There are two IFMAP rasters, lp and up, for the Lower Peninsula and 

Upper Peninsula, respectively.  The 1978 land use must be obtained from MiGDL by county at 

the following website http://www.mcgi.state.mi.us/mgdl/ .  This method assumes that you have 

already created the watershed_nl file. 

 

This method will: 

1. Clip the land use data file to the watershed 

2. Reclassify data to the highest level, needed to compare land use among datasets. 

3. Create tables for export into Excel for data analysis 

 

2001 land use IFMAP 

 

1. In the ArcToolbox navigate to Spatial Analyst Tools→Extraction→Extract by Mask 

a. Input Raster: IFMAP raster 

b. Input Raster or feature mask data: watershed_nl raster 

c. Output Raster: Create a name and location for the file (e.g., white_2001) 

2. In the ArcToolbox navigate to Spatial Analyst Tools→Reclass→Reclassify 

a. Input Raster the watershed landuse file (e.g., white_2001 from above) 

b. Reclass field: Value 

c. Reclassification: follow the reclassification scheme in the table below.  The 

reclassification can be saved and used for other lakes 

 

Table C2. Landuse reclassification scheme 

Land Use Type Old Classification New Classification 

Urban 1-4 100 

Agriculture 5,6,7,9 200 

Upland Openland 10,12,13 300 

Forest 14-22,24-26 400 

Water 23 500 

Wetland 27-30 600 

Barren 31,32,35 700 

 

d. Output raster: create a name and location for the new file (e.g., white_2001rc) 

3. Right click in the newly created reclassified watershed land use file and open the attribute 

table 

a. The VALUE corresponds to the reclassified land use in the table above 

b. The COUNT column is the number of cells in the watershed with a specific land 

use 

i. The product of COUNT and area of the cell is the total land use in the 

watershed 

c. Click Options: in the lower right hand corner of the attribute table and select 

Export… 



 

209 

 

i. Export: All records 

ii. Output Table: create a name and location for the file (e.g., white_2001) 

the file can be saved as “.dbf” or “.txt” 

4. Right click in the newly created reclassified watershed land use file and open 

Properties… 

a. Click on the Source tab 

b. Note the cell size, this value squared will be the area of one raster cell 

5. Open the exported table in Excel 

a. Multiply the COUNT column by the area of the raster cell 

b. Sum all of the areas 

c. Compare the calculated land use to the area of watershed_nl file by calculating 

the product of COUNT and the cell area for the watershed_nl file.  COUNT can 

be found in the attribute table of the watershed_nl file. 

d. Area of the total land use in the watershed and the watershed should be 

comparable 

e. Save the file as an Excel worksheet 

 

1978 MIRIS Land use 

1. Download the 1978 MIRIS land use data from MiGDL 

a. If multiple the watershed spans several counties it will require the individual 

county files to be merged 

2. From the ArcToolbox navigate to Data Management Tools→General→Merge 

a. Input Datasets: select all of the county 1978 land use files 

b. Output Dataset: create a name and location for the output (e.g., 1978 lulc) 

3. From the ArcToolbox navigate to the Analysis Tools→Overlay→Intersect 

a. Input Features: select the watershed_nl (e.g., whiteshed_nl) and merged land use 

files (e.g., 1978 lulc from above) 

b. Output Feature Class: create a name and location for the output (e.g., white_1978) 

c. keep all of remaining selection at default values 

4. From the ArcToolbox navigate to the Conversion Tools→To Raster→Feature to Raster 

a. Input features: select the watershed landuse file (e.g., white_1978 from above) 

b. Field: Select Level 1 

c. Output Raster: create a name and location for the file (e.g., white_1978) 

d. Output cell size: either enter the cell size desired (usually the same as the original 

DEM) or navigate to the original projected DEM 

5. Right click on the newly created watershed land use raster (e.g., white_1978 from step 4) 

and open the attribute table 

a. Export the data to a text file following step 3 from the IFMAP watershed land use 

methodology above 

6. Open the exported table in Excel 

a. Multiply the COUNT column by the area of the raster cell 

b. Sum all of the areas 

c. Compare the calculated land use to the area of watershed_nl file by calculating 

the product of COUNT and the cell area for the watershed_nl file.  COUNT can 

be found in the attribute table of the watershed_nl file. 
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d. Area of the total land use in the watershed and the watershed should be 

comparable 

e. Land use codes for 1978 land use 

 

Table C3. Land use classifcations for the 1978 MIRIS dataset 

Land Use Level 1 Code 

Urban 1 

Agriculture 2 

Rangeland 3 

Forest 4 

Water 5 

Wetlands 6 

Barren 7 

 

f. Save the file as an Excel worksheet 
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APPENDIX D.  Error Analysis 

 

 

Absolute error in analytical methods can be derived from both random and systematic 

sources.  Sources of random errors are operationally unknown.  They appear as spread in the data 

during the analysis of a known analyte concentration and can often be described using Gaussian 

statistics.  Sources of systematic error are known and include: instrumental, personal and 

method.  Instrumental error occurs due to the wear, corrosion, or drift in electrical circuits over 

time; it is usually overcome by the calibration of instruments prior to analysis.  Personal error 

can include such things as number bias and prejudice.  Method errors occur due to non-ideal 

chemical and physical behavior of reactants during analysis.   Analysis of NIST standards, of 

similar matrix to the samples of interest, can aid in determining method error.  This report shall 

outline the error in sediment mercury analysis from six sampling seasons (1999-2004) and 

sediment major and trace element analysis from two sampling seasons (2003-2004). 

 

Systematic errors will be assumed to instrumental in this analysis.  Personal errors are 

limited due to computer interfaces but still exist due to pipeting or weighing errors.  Pipeting and 

weighing errors generally considered gross errors and can be eliminated utilizing outlier analysis.  

Outliers will be defined, by box plots, as .  Method errors are generally minimized by calibration 

curves which are run during each set of analyses. 

 

Descriptive Statistics 

 

The definitions and equations described below shall be utilized in the examination of error in 

both mercury and major and trace element analysis.  Equations presented below can be found in 
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any instrumental analysis chemistry textbook such as Skoog and Leary (1992).  Absolute error,

aE , is defined as the deviation of the sample mean, x  from the known analyte value, tx ,  

 txxaE −=  (1) 

 

where the right hand side of the equation includes both random and systematic components.  

Random error, rE , for a small set of data can be estimated using 

 µ−= xrE  (2) 

 

where µ is the population mean.  In general the population mean is determined, and assumed to 

be free of random error, by replicating the measurement 20 to 30 times and is calculated by 
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where xi is the value for the  i
th

 measurement and N is the number of measurements.  The 

standard deviation, σ, of the population is calculated 
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The standard deviation of a set of samples differs from the population standard deviation by 

replacing σ with s, µ with x , and N by N-1.   
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The arithmetic mean, x , will be used for sample means.  The value of the population and sample 

mean may differ.  The sample mean usually represents a subset of the population or a smaller set 
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of measurements intended for comparison to the population.   Standard errors shall also be 

calculated to demonstrate the fluctuation in the standard deviation based upon the number of 

samples 

 
N

s
ms = . (6) 

 

 

The coefficient of variation, CV, 

 

 %100×=
x

s
CV  (7) 

 

provides information on the magnitude of the standard deviation as a percentage of the mean and 

is generally more useful than the standard deviation alone.   

 

95% confidence limits are quantified using a t-statistic as 

 
N

ts
xCL ±=%95  (8) 

 

where t is obtained using a widely available statistical t-distribution table.  Confidence limits can 

also be calculated using the z-distribution table where z replaces t, σ  replaces s and µ replaces 

.x  

 

Systematic Error (Bias) 

 

Bias in analytical methods is developed due to systematic errors and can be demonstrated using 

the t-statistic.  The experimental difference between the sample mean and population mean is 

calculated as 

 

 µ−x  (9) 
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and compared to the calculated difference at a predetermined confidence level as 

 
N

ts
± . (10) 

Bias is demonstrated if the experimental bias is greater than the calculated bias at a given 

confidence interval.  A similar method can determine bias in a population where 

  µ−tx  (11)  

and 
N

zs
±  (12) 

replace Equations 9 and 10 respectively. 

Limit of Detection 

The detection limit (LOD) of an analytical method, determined here as the minimum 

distinguishable signal, Sm, is a function of average signal of the blank, blS , and a multiple, k, of 

the blank signal, bls  

 blksblSmS += . (13) 

 

Where blank data are available totaling a minimum of 20 to 30 measurements Equation 13 will 

result in the detection limit, cm, as 

 
m

blSmS
mc

−
= . (14) 

where m is the slope of the calibration line at the concentration of interest.  In the absence of 

reliable blank measurements the detection limit will be determined by linear regressions of 

calibration standard concentrations versus instrument response.  In these cases the slope, 

intercept, and standard error of the estimate will be used to estimate the LOD. 
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Mercury 

Mercury analysis was carried out on a Lumex Zeeman Corrected Atomic Absorption 

Spectrophotometer with Thermal Decomposition attachment (TD-AA).  Calibration of the 

instrument was performed using either SRM 1633b (coal fly ash, Hg = 143.1 ng/g) or SRM 1515 

(apple leaves, Hg = 44 ng/g) and the protocol outlined in Environmental Protection Agency 

(EPA) method 7473 was followed.  EPA Method 7473 dictates that a SRM be run every 10 

samples; descriptive statistics will be derived based upon these measurements. 

Descriptive Statistics and Bias 

Table D1 and Table D2 show the population means and standard deviation of SRM 1515 and 

SRM 1633b respectively.  Based on the number of measurements for each SRM it is assumed 

that the standard deviation and means of these measurements represent the population.  Bias for 

the population was determined using the z-distribution and was calculated using Equations 11 

and 12; at 95% CL z is equal to 1.96. 
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Table D1 SRM 1515 Population Statistics 

Population mean (ng/g) 43.9 

Population standard deviation (ng/g) 2.13 

CV (%) 4.85 

sm 0.23 

N 87 

NIST accepted value (ng/g) 44 

Bias No bias demonstrated at 95% CL 

 

 

Table D2 SRM 1633b Population Statistics 

Population mean (ng/g) 146.8 

Population standard deviation (ng/g) 6.644 

CV (%) 4.52 

sm 0.83 

N 64 

NIST accepted value (ng/g) 143.1 

Bias Presence of bias suggested at 95% CL 

 

The presence of positive bias in SRM 1633b suggests that systematic errors influence the 

measurement.   

 

Table D3 shows the descriptive statistics for each lake.  Sample means and standard deviations 

are provided for each lake and are subsets of the population determined as subsets of the 

population.  The SRM used during analysis of the lake sediment mercury is noted in column 2.  

Bias was calculated using Equations 9 and 10; the population mean was used to evaluate 

Equation 9.  It is evident from this analysis that only three lakes exhibited bias at the 95% CL, 

Houghton, Littlefield, and Torch. 
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Table D3 Descriptive Sample Statistics and Bias 

Lake SRM N df 

Average 

(ng/g) 

Std. dev 

(ng/g) 

CV 

(%) sm Bias 

Houghton 1633b 4 3 141.0 3.16 2.24 1.58 Bias 

Round 1633b 6 5 142.0 5.90 4.15 2.41 - 

Avalon 1633b 7 6 144.0 3.92 2.72 1.48 - 

Birch 1633b 7 6 144.9 3.85 2.66 1.45 - 

Muskegon 1633b 8 7 151.6 9.74 6.42 3.44 - 

Sand 1633b 5 4 149.4 2.30 1.54 1.03 - 

Crystal-M04 1633b 5 4 144.2 4.60 3.19 2.06 - 

George 1633b 5 4 144.7 4.32 2.99 1.93 - 

Hackert 1633b 6 5 148.0 5.33 3.60 2.18 - 

Otter 1633b 4 3 154.0 10.8 7.01 5.40 - 

Round_D 1633b 6 5 150.3 5.57 3.71 2.28 - 

Gull 1515 3 2 47.0 1.66 3.54 0.96 - 

Higgins 1515 11 10 43.5 1.86 4.29 0.56 - 

Cass 1515 4 3 43.3 1.50 3.47 0.75 - 

Crystal-M 1515 5 4 44.0 1.87 4.25 0.84 - 

Littlefield 1515 9 8 46.6 2.55 5.49 0.85 Bias 

Cadillac 1515 5 4 43.2 2.05 4.74 0.92 - 

Crystal-B 1515 5 4 43.6 1.67 3.84 0.75 - 

Hubbard 1515 5 4 43.8 1.30 2.98 0.58 - 

Mullett 1515 6 5 44.3 1.75 3.95 0.71 - 

Whitmore 1515 6 5 43.5 2.17 4.98 0.89 - 

Houghton 1515 2 1 44.0 1.41 3.21 1.00 - 

Imp 1515 7 6 42.4 1.62 3.81 0.61 - 

Paw Paw 1515 7 6 43.0 2.08 4.84 0.79 - 

Torch 1515 6 5 42.3 0.82 1.93 0.33 Bias 

Witch 1515 6 5 44.3 2.07 4.66 0.84 - 

 

Detection Limits 

Detection limits, outlined in Table D4 and Table D5, were calculated using Equations 13 and 14 

using the average blank signal obtained during sample runs.  Slope was determined from plots of 

mass Hg vs. Area.  In Equation 13, k was assigned a value of three (REF).  Differences in the 

detection limit differed only slightly between the two SRMs.  Detection limit concentrations are 

calculated using the population average (e.g. if 250 mg of sediment are used the LOD is 0.687 

ng/g).
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Table D4 SRM 1515 LOD 

 Mass Hg (pg) Hg (fmoles)  

Mean 141.8 706.9  

Standard Deviation 20.3 101.2  

    

 250 mg 125 mg 10 mg 

Detection Limit (ng/g) 0.687 1.37 17.2 

 

Table D5 SRM 1633b LOD 

 Mass Hg (pg) Hg (fmoles)  

Mean 133.5 665.5  

Standard Deviation 6.06 30.2  

    

 250 mg 125 mg 10 mg 

Detection Limit (ng/g) 0.577 1.15 14.4 

 

Discussion 

Results of the mercury analysis indicate that, run to run, very little systematic error has been 

demonstrated and that detection limits are low.  Population mean of SRM 1515 agreed well with 

the accepted value and did not demonstrate bias.  Conversely SRM 1633b did demonstrate bias 

at a 95% CL.  This may be an effect of improperly cleaned glassware.  It is evident that during 

the analysis of high organic carbon sediments that lenses encasing the reaction cell can become 

contaminated.  This reduces the amount of light penetrating the reaction cell which reduces 

signal and increases the amount of Zeeman correction (Lumex, personal communication).  Otter, 

Sand, Muskegon, and Round_D lakes all visually appeared to contain high amounts of organic 

carbon and these lakes have higher average values.  It may be necessary to implement a protocol 

for periodic lens cleaning during analysis of high organic carbon sediments.  Individual runs 

indicate that only three lakes demonstrate bias and that none of the lakes demonstrating bias 

would be considered to have high organic carbon values.  The test for bias by lake suffers from 

using t-statistics versus the z-statistic for the population.  Detection limits are lower than those 

estimated by the manufacturer for this method (WWW.OHIOLUMEX.COM). 
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